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Welcome to the instrument embedded Help

Welcome to the instrument embedded Help

This Help supports the 4 Series MSO (MS0O44, MSO46), 4 Series B MSO (MSO44B, MS0O46B), 5 Series MSO (MSO54, MSO56, MSO58,
MSO58LP), 5 Series B MSO (MS0O54B, MSO56B, MSO58B), 6 Series MSO (MSO64), 6 Series B MSO (MS064B, MSO66B, MSO68B),
and the 6 Series Low Profile Digitizer (LPD64) instruments. See the following lists for information on the key features of each instrument.
Use the tabs on the left to go to specific topics or search for a topic of interest.

MS044B, MS046B, MS044, and MS046 Key features and benefits
+  Bandwidths from 200 MHz to 1.5 GHz
*  4-and 6-channel models with FlexChannel ® inputs

+  Each FlexChannel input is dual-purpose, letting you connect either an analog probe (TekVPI® or BNC) or an eight-channel digital
probe (the TLP058 FlexChannel Logic Probe)

+ Each FlexChannel can display 8 digital channels (with TLP058), an analog waveform, a spectrum trace, or both an analog and spectral
view of the same channel at the same time with independent controls for each view

+ Large 13.3" HD (1920 x 1080 pixel) capacitive touch-screen display

+ User interface optimized for touch screen use

«  Maximum 6.25 GS/s sample rate

+ 31.25 M points record length on all channels (optional 62.5 M record length available)

+ 500,000 waveforms/second capture rate

+  Cursors analysis: Waveform, V Bars, H Bars, V&H Bars, Multi source cursor (readouts)

+  Spectrum View enables simple, intuitive frequency domain analysis, independent of time domain controls, to show a spectral trace for
each channel

+  FastFrame™ segmented memory acquisition uses multiple trigger events to capture widely spaced events of interest at high sample
rates while conserving acquisition memory

+ No set limit on the number of math, reference, and bus waveforms you can display (the number of waveforms depends on available
system memory)

+ Integrated options include a 50 MHz arbitrary/function generator (AFG), and a Digital Voltmeter (DVM) and trigger frequency counter

+ Advanced serial bus triggering and analysis options let you decode and trigger on industry standard buses. See the Serial bus and
trigger options Help topic

+ Power and 3-Phase options provide additional measurement and analysis functions. See the Advanced Power Analysis option Help
topics. 3-Phase is available only on MSO46.

MS054, MS056, MS058 Key features and benefits
+  Bandwidths from 350 MHz to 2 GHz
*  4-,6-, and 8-channel models with FlexChannel® inputs

+  Each FlexChannel input is dual-purpose, letting you connect either an analog probe (TekVPI® or BNC) or an eight-channel digital probe
(the TLP058 FlexChannel Logic Probe)

+ Each FlexChannel can display 8 digital channels (with TLP058), an analog waveform, a spectrum trace, or both an analog and spectral
view of the same channel at the same time with independent controls for each view

+ Large 15.6” HD (1920 x 1080 pixel) capacitive touch-screen display

+  User interface optimized for touch screen use

«  Maximum 6.25 GS/s sample rate

+  62.5 M points record length on all channels (optional 125, 250, 500 M record length available)
+ 500,000 waveforms/second maximum waveform capture rate

+  Cursors analysis: Waveform, V Bars, H Bars, V&H Bars, Multi source cursor (readouts)
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Spectrum View enables simple, intuitive frequency domain analysis, independent of time domain controls, to show a spectral trace for
each channel

FastFrame™ segmented memory acquisition uses multiple trigger events to capture widely spaced events of interest at high sample
rates while conserving acquisition memory

No set limit on the number of math, reference, and bus waveforms you can display (the number of waveforms depends on available
system memory)

Integrated options include a 50 MHz arbitrary/function generator (AFG), and a Digital Voltmeter (DVM) and trigger frequency counter
Automated compliance testing solutions add compliance measurement features. ' See the Compliance Testing options Help topic
Advanced serial bus triggering and analysis options let you decode and trigger on industry standard buses. See the Serial bus and
trigger options Help topic

Power, WBG-DPT, Spectrum measurements, DPM, IMDA, and Jitter options provide additional measurement and analysis functions.

See the Advanced Power Analysis, DPM Analysis, and Advanced Jitter Analysis Help topics. IMDA application is available on MSO56
and MSO58 only.

MS054B, MS056B, and MS058B Key features and benefits

Bandwidths from 350 MHz to 2 GHz
4, 6, or 8 channels with FlexChannel® inputs

Each FlexChannel input is dual-purpose, letting you connect either an analog probe (TekVPI® or BNC) or an eight-channel digital
probe (the TLP058 FlexChannel Logic Probe)

Each FlexChannel can display 8 digital channels (with TLP058), an analog waveform, a spectrum view, or both an analog and spectral
view of the same channel at the same time with independent controls for each view

FlexChannel inputs are compatible with TekVPI® probes
Large 15.6” HD (1920 x 1080 pixel) capacitive touch-screen display
User interface designed to optimize touch screen use and quickly access key settings

Stacked mode places each channel or waveform in its own horizontal 'slice’ on the screen, allowing for cleaner signal viewing and
measuring

Maximum 6.25 GS/s sample rate

62.5 M points record length on all channels (optional 125 M, 250 M, and 500 M record lengths available)
>500,000 waveforms/second maximum waveform capture rate

Cursors analysis: Waveform, V Bars, H Bars, V&H Bars, Multi source cursor (readouts)

Spectrum View enables simple, intuitive frequency domain analysis, independent of time domain controls, to show a spectral trace for
each channel

No set limit on the number of math, reference, and bus waveforms you can display (the number of waveforms depends on available
system memory)

Integrated optional features include a 100 MHz arbitrary function generator (AFG), and a DVM and trigger frequency counter

Optional serial triggering features enable you to isolate protocol-level events of interest in common aerospace, audio, automotive,

computer, and embedded serial buses. See the Serial bus and trigger options topic in the instrument Help, or the Serial Triggering and
Analysis Applications Datasheet (Tektronix part number 48W-61353-X) for more information.

Power, DPM, Spectrum measurements, IMDA, and Jitter options provide additional measurement and analysis functions. See the
Advanced Power Analysis, DPM Analysis, and Advanced Jitter Analysis Help topics. IMDA application is available on MSO56B and
MSO58B only.

MSO058LP Key features and benefits

Low profile instrument with no display, comes ready to install in a 2U rack mount space

4/5/6 Series MSO MSO4X, MSO4XB, MSO5X, MSO5XB, MSO64, MSO6XB, MSO58LP, and LPD64 Help

1 Compliance testing options require the optional Microsoft Windows 10 operating system.
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500 MHz (upgradeable) and 1 GHz bandwidths
8 channels with FlexChannel® inputs

Each FlexChannel input is dual-purpose, letting you connect either an analog probe (TekVPI® or BNC) or an eight-channel digital probe
(the TLP058 FlexChannel Logic Probe)

Each FlexChannel can display 8 digital channels (with TLP058), an analog waveform, a spectrum trace, or both an analog and spectral
view of the same channel at the same time with independent controls for each view

Maximum 6.25 GS/s sample rate

125 M points record length on all channels (optional 250, 500 M record length available)

500,000 waveforms/second maximum waveform capture rate

Cursors analysis: Waveform, V Bars, H Bars, V&H Bars, Multi source cursor (readouts)

Spectrum View enables simple, intuitive frequency domain analysis, independent of time domain controls, to show a spectral trace for
each channel

FastFrame™ segmented memory acquisition uses multiple trigger events to capture widely spaced events of interest at high sample
rates while conserving acquisition memory

No set limit on the number of math, reference, and bus waveforms you can acquire (the number of waveforms depends on available
system memory)

Integrated options include a 50 MHz arbitrary/function generator (AFG), and a Digital Voltmeter (DVM) and trigger frequency counter

Advanced serial bus triggering and analysis options let you decode and trigger on industry standard buses. See the Serial bus and
trigger options Help topic

Power, WBG-DPT, Spectrum measurements, DPM, IMDA, and Jitter options provide additional measurement and analysis functions.
See the Advanced Power Analysis, DPM Analysis, and Advanced Jitter Analysis Help topics.

MS064 Key features and benefits
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4 channels with FlexChannel® inputs
Bandwidths from 1 GHz to 8 GHz

Each FlexChannel input is dual-purpose, letting you connect either an analog probe (TekVPI® or BNC) or an eight-channel digital probe
(the TLP058 FlexChannel Logic Probe)

Each FlexChannel can display 8 digital channels (with TLP058), an analog waveform, a spectrum trace, or both an analog and spectral
view of the same channel at the same time with independent controls for each view

Large 15.6” HD (1920 x 1080 pixel) capacitive touch-screen display

User interface optimized for touch screen use

Maximum 25 GS/s sample rate

62.5 M points record length on all channels (optional 125 M, 250 M, 500 M, and 1 G record lengths available)

500,000 waveforms/second maximum waveform capture rate

Cursors analysis: Waveform, V Bars, H Bars, V&H Bars, Multi source cursor (readouts)

Spectrum View enables simple, intuitive frequency domain analysis, independent of time domain controls, to show a spectral trace for
each channel

FastFrame™ segmented memory acquisition uses multiple trigger events to capture widely spaced events of interest at high sample
rates while conserving acquisition memory

No set limit on the number of math, reference, and bus waveforms you can display (the number of waveforms depends on available
system memory)

Integrated options include a 50 MHz arbitrary/function generator (AFG), and a Digital Voltmeter (DVM) and trigger frequency counter

Advanced serial bus triggering and analysis options let you decode and trigger on industry standard buses. See the Serial bus and
trigger options Help topic
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Power, DPM, Spectrum measurements, and Jitter options provide additional measurement and analysis functions. See the Advanced
Power Analysis, DPM Analysis, and Advanced Jitter Analysis Help topics.

MS064B, MS066B, and MS068B Key features and benefits

Bandwidths from 1 GHz to 10 GHz
4, 6, or 8 channels with FlexChannel® inputs

Each FlexChannel input is dual-purpose, letting you connect either an analog probe (TekVPI® or BNC) or an eight-channel digital probe
(the TLP058 FlexChannel Logic Probe)

Each FlexChannel can display 8 digital channels (with TLP058), an analog waveform, a spectrum view, or both an analog and spectral
view of the same channel at the same time with independent controls for each view

FlexChannel inputs are compatible with TekVPI® probes
Large 15.6” HD (1920 x 1080 pixel) capacitive touch-screen display
User interface designed to optimize touch screen use and quickly access key settings

Stacked mode places each channel or waveform in its own horizontal 'slice’ on the screen, allowing for cleaner signal viewing and
measuring

Maximum 50 GS/s sample rate

62.5 M points record length on all channels (optional 125 M, 250 M, 500 M, and 1 G record lengths available)
>500,000 waveforms/second maximum waveform capture rate

Cursors analysis: Waveform, V Bars, H Bars, V&H Bars, Multi source cursor (readouts)

Spectrum View enables simple, intuitive frequency domain analysis, independent of time domain controls, to show a spectral trace for
each channel

No set limit on the number of math, reference, and bus waveforms you can display (the number of waveforms depends on available
system memory)

Integrated optional features include a 50 MHz arbitrary function generator (AFG), and a DVM and trigger frequency counter
Optional serial triggering features enable you to isolate protocol-level events of interest in common aerospace, audio, automotive,

computer, and embedded serial buses. See the Serial bus and trigger options topic in the instrument embedded Help, or the 6 Series
MSO Serial Triggering and Analysis Applications Datasheet (Tektronix part number 48W-61353-x) for more information

Power, DPM, WBG-DPT, Spectrum measurements, IMDA, and Jitter options provide additional measurement and analysis functions.

See the Advanced Power Analysis, DPM Analysis, and Advanced Jitter Analysis Help topics. IMDA application is available on
MSO66B and MSO68B only.

LPD64 Key features and benefits

Low profile instrument with no display, comes ready to install in a 2U rack mount space

4 channels with 50 Q SMA inputs

1,2.5, 4, 6, and 8 GHz bandwidths on all channels

Maximum 25 GS/s sample rate on all channels

125 M points record length on all channels (optional 250 M points, 500 M points, 1 G points)
12 bits A/D resolution

Lowest-in-class noise

Highest-in-class ENOB (8.2 bits at 1 GHz)

500,000 waveforms/second maximum waveform capture rate

Cursors analysis: Waveform, V Bars, H Bars, V&H Bars, Multi source cursor (readouts)

No set limit on the number of math, reference, and bus waveforms you can create (the number of waveforms depends on available
system memory)

4/5/6 Series MSO MSO4X, MSO4XB, MSO5X, MSO5XB, MSO64, MSO6XB, MSO58LP, and LPD64 Help 25
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+  Spectrum View enables simple, intuitive frequency domain analysis, independent of time domain controls, to show a spectral trace for
each channel

+ Real-Time 2 GHz DDC for RF bandwidth

+  FastFrame™ segmented memory acquisition uses multiple trigger events to capture widely spaced events of interest at high sample
rates while conserving acquisition memory

+ Integrated options include a 50 MHz arbitrary/function generator (AFG), and a Digital Voltmeter (DVM) and trigger frequency counter

+ Advanced serial bus triggering and analysis options let you decode and trigger on industry standard buses. See the Serial bus and
trigger options Help topic

+  Power, WBG-DPT, Spectrum measurements, DPM, and Jitter options provide additional measurement and analysis functions. See the
Advanced Power Analysis, DPM Analysis, and Advanced Jitter Analysis Help topics

4/5/6 Series MSO Help, version 20241024-10:00 for Firmware v2.12 and above.

TEKTRONIX END USER LICENSE AGREEMENT

Go to www.tek.com/en/eula to read the Tektronix End User License Agreement.

Open Source GPL License Notice

For programs licensed under the "GNU General Public License (GPL) or Lesser GNU General Public License (LGPL)" the complete
corresponding sources are available. You can order a CD containing the sources from us for a period of three years after download of the
software, by sending a written request to:

Chief Intellectual Property Counsel, Tektronix, Inc.
MS 50/LAW

14150 SW Karl Braun Dr.

Beaverton OR, 97077

This offer is valid to anyone in receipt of this information.

Your request should include: (i) the name of the product, (i) your (company) name, and (iii) your return mailing and email address (if
available).
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Please note that we may charge you a fee to cover the cost of performing this distribution.

Product support and feedback

Tektronix values your feedback on our products. To help us serve you better, please send us your suggestions, ideas, or comments on
your instrument, application, or product documentation.

Contact through mail, telephone, or tek.com.

When you contact Tektronix Technical Support, please include the following information (be as specific as possible):

General information

+  All instrument model numbers

+ Hardware options, if any

+ Probes used

* Your name, company, mailing address, phone number, and FAX number

+ Please indicate if you would like to be contacted by Tektronix about your suggestion or comments.

Application specific information

+  Software version number

+  Description of the problem such that technical support can duplicate the problem

+ If possible, save and send the setup files for all the instruments used and the application

+ If possible, save and send status messages text files

+ If possible, save and send the waveform on which you are performing the measurement as a .wfm file

Documentation

Review the following user documents before installing and using your instrument. These documents provide important operating
information.

Product documentation

The following table lists the primary product specific documentation available for your product. These and other user documents are
available for download from tek.com. Other information, such as demonstration guides, technical briefs, and application notes, can also be
found at tek.com.

Document Content

Installation and Safety Instructions Safety, compliance, and basic introductory information for hardware products.

Help In-depth operating information for the product. Available from the Help button in the
product Ul and as a PDF on tek.com.

Quick Start User Manual Introduction to product hardware and software, installation instructions, turn on, and
basic operating information.

Specifications and Performance Verification Instrument specifications and performance verification instructions for testing

Technical Reference instrument performance.

Programmer Manual Commands for remotely controlling the instrument.

Table continued...

4/5/6 Series MSO MSO4X, MSO4XB, MSO5X, MSO5XB, MSO64, MSO6XB, MSO58LP, and LPD64 Help 27


http://tek.com
HTTP://www.tek.com
HTTP://www.tek.com
http://www.tek.com/downloads

Welcome to the instrument embedded Help

Document

Content

Declassification and Security Instructions

Information about the location of memory in the instrument. Instructions for
declassifying and sanitizing the instrument.

Service Manual

Replaceable parts list, theory of operations, and repair and replace procedures for
servicing an instrument.

Upgrade Instructions

Product upgrade installation information.

Rackmount Kit Instructions

Installation information for assembling and mounting an instrument using a specific
rackmount.

How to find your product documentation

1. Go to tek.com.

2. Click Download in the green sidebar on the right side of the screen.
3. Select Manuals as the Download Type, enter your product model, and click Search.
4. View and download your product manuals. You can also click the Product Support Center and Learning Center links on the page for

more documentation.
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Options

Some features described in this Help system are not supported by all product families, models, or configurations. Please refer to the
datasheet for your specific product at tek.com to see which features it supports.

Install option upgrade licenses

Option license upgrades are field-installable licenses that you can purchase after receiving your instrument, to add features to your
oscilloscope. You install option upgrades by installing license files on the oscilloscope. Each option requires a separate license file.

Before you begin
These instructions do not pertain to options that were purchased and pre-installed on your instrument when ordered.

A node-locked license is valid only for the specific model number and serial number of the instrument for which it was purchased; it will not
work on any other instrument. The single license file does not affect options that were factory installed or any other upgrades that you may
have already purchased and installed.

A floating license enables you to install an upgrade options on any equivalent instrument, but only one instrument at a time can use the
license. You must uninstall a floating license from one instrument, and log it back into the Tektronix AMS, before checking it out for use on
another instrument. Access the Tektronix AMS at www.tek.com/products/product-license.

To access the user interface on a Low Profile instrument, connect a monitor to a video port on the rear of the instrument, and connect a
mouse to any USB Host port. You do not need to connect a mouse if your remote monitor is touch-capable. You can also remotely access
the user interface of a network-connected instrument by entering the instrument's IP address in a web browser.

About this task

Note: You can only install a Node Locked option license one time. If you need to reinstall an uninstalled Node Locked license,
contact Tektronix Customer Support.

These instructions only support options that are enabled by installing a software license. Some product upgrades, such as the
5/6 Series MSO SSD upgrades (Embedded OS or Microsoft Windows 10) and 5 Series MSO bandwidth upgrades to 2 GHz,
are not supported by this document. These upgrades either have their own installation instructions, or require that you send the
instrument to a Tektronix support center for new hardware and calibration.

Procedure

Follow the instructions you received to download the upgrade license file (<filename>.lic).
Copy the license file or files to a USB memory device.

Insert the USB drive into the powered-on oscilloscope for which the upgrade was purchased.
Select Help > About.

Select Install License to open the Browse License Files dialog box.

Find and select the upgrade license file to install.

Select Open. The oscilloscope installs the license and returns to the About screen. Verify that the installed license was added to the
Installed Options list.

Repeat steps 5 through 7 for each upgrade license file that you purchased and downloaded.
9.  Power cycle the oscilloscope to enable the installed upgrades.

10. If you installed a bandwidth upgrade, rerun signal path compensation (SPC). Then carefully remove the model/bandwidth label from
the lower-left corner of the front panel and install the new model/bandwidth label that was sent through normal mail channels as part
of the upgrade purchase.

N o ok~ ooDbd =

L

4/5/6 Series MSO MSO4X, MSO4XB, MSO5X, MSO5XB, MSO64, MSO6XB, MSO58LP, and LPD64 Help 29


HTTP://www.tek.com
http://www.tek.com/products/product-license

Options

Uninstall (return) an option license

Use this process to uninstall (return) a Node Locked or Floating option license.

Before you begin

To access the user interface on a Low Profile instrument, connect a monitor to a video port on the rear of the instrument, and connect a
mouse to any USB Host port. You do not need to connect a mouse if your remote monitor is touch-capable. You can also remotely access
the user interface of a network-connected instrument by entering the instrument's IP address in a web browser.

Floating licenses can be used on any compatible instrument, but can only be checked out to use on one instrument at a time. This process
removes the option license from the instrument so that you can check (return) it back into the Tektronix TekAMS system.

When you check out an option Floating license from your TekAMS account, you stipulate a time period for which the option license can be
used. When the license expiration time is close, the instrument shows warning messages at 72 hours, 24 hours, and 1 hour prior to the
expiration date.

At the expiration time, the TekAMS account automatically sets the license as available. The instrument gives you a four-hour grace period.

If you do nothing, the instrument automatically deactivates the license after the grace period expires and restarts the TekScope application
(on instruments with Windows OS installed) or performs a warm reboot (base instrument). You should uninstall (return) the license key file
before the expiration date to prevent a power cycle and possible disruption of measurements.

About this task

Note: If you uninstall a Node Locked option license, you cannot reinstall the license using the same file used to install it. If you
need to reinstall an uninstalled Node Locked option, contact Tektronix Customer Support to obtain a new option license file.

Procedure

1. Insert a USB memory stick or device in an available USB port.
Select Help > About.
Tap the option license in the list that you want to uninstall (return to your Tektronix AMS account).

Tap the Return License button.
The oscilloscope opens the Location to Save the Exit Key menu.

5. Navigate to and select the location at which to save the license key uninstall file.

el

+ Foran instrument not connected to the internet, or installed in a secure environment, save the license file to a USB memory device
connected to the instrument. See the table at the end of this procedure for USB port names.

+ For an instrument with the Microsoft Windows 10 OS option that is connected to the internet, you can save the uninstall key file to a
location on the instrument SSD drive or to a network drive.

6. Tap Create. The oscilloscope saves the license key file to the specified location and removes the license from the Installed Options list.
7. Power cycle the oscilloscope before taking any measurements.

8. From a PC with the license file USB memory device attached, or from a browser on an instrument connected to the internet, access the
Tektronix AMS Web site. The site path was provided when you purchased the license and created a Tektronix AMS account.

9. Use the Tektronix AMS site to select and return the license key file to your Tektronix AMS account.

Drive names for system and USB memory devices

Use the following table to determine which drive to select when navigating to and/or selecting a file on system memory or a connected
USB memory device.
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Drive name Drive letter | Drive or physical USB port location
MS044B and MS046B
Root drive c User-accessible memory on the oscilloscope.
Front panel E USB 2.0 (top)

F USB 2.0 (middle)

G USB 2.0 (bottom)
Rear panel H USB 3.0 (left)

| USB 3.0 (right)
Drive name Drive letter | Drive or physical USB port location
MS044 and MS046
Root drive c User-accessible memory on the oscilloscope.
Front panel E USB 2.0 (top)

F USB 2.0 (middle)

G USB 2.0 (bottom)
Rear panel H USB 2.0 (left)

| USB 2.0 (right)
Drive name Drive letter | Drive or physical USB port location

MS054, MSO56, MSO58, MSO54B, MSO56B, MSO58B, MSO64, LPD64, MSO64B, MSO66B, and MSO68B without Windows OS

Root drive c User-accessible memory on the oscilloscope.
Front panel E USB 3.0 (left)

F USB 2.0 (center)

G USB 2.0 (right)
Rear panel H USB 2.0 (top)

| USB 2.0 (bottom)

J USB 3.0 (top)

K USB 3.0 (bottom)

Instruments with Windows OS

Root drive c User-accessible memory on the oscilloscope.
USB ports Dynamic port letter If Windows operating system is installed, the Windows operating system assigns
assignment the first available drive letter (typically E:) to the first USB device attached to the

oscilloscope, regardless of which port the USB device is plugged into. The next
plugged-in USB device is assigned the next available drive letter (such as F:) and
so on for other installed devices.
Use standard Windows procedures to mount and access network drives.

Drive name Drive letter Drive or physical USB port location

MSO58LP without Windows OS

Table continued...

4/5/6 Series MSO MSO4X, MSO4XB, MSO5X, MSO5XB, MSO64, MSO6XB, MSO58LP, and LPD64 Help 31




Options

Drive name Drive letter Drive or physical USB port location
Root drive c User-accessible memory on the oscilloscope.
Front panel E USB 3.0 (left)
F USB 2.0 (right)
Rear panel G USB 2.0 (top)
H USB 2.0 (bottom)
| USB 3.0 (top)
J USB 3.0 (bottom)

Instruments with Windows OS

Root drive c User-accessible memory on the oscilloscope.
USB ports Dynamic port letter If Windows operating system is installed, the Windows operating system assigns
assignment the first available drive letter (typically E:) to the first USB device attached to the
oscilloscope, regardless of which port the USB device is plugged into. The next
plugged-in USB device is assigned the next available drive letter (such as F:) and
so on for other installed devices.
Use standard Windows procedures to mount and access network drives.
Drive name Drive letter | Drive or physical USB port location
LPD64 without Windows OS
Root drive c User-accessible memory on the oscilloscope.
Front panel F USB 3.0 (left)
E USB 2.0 (center)
G USB 2.0 (right)
Rear panel H USB 2.0 (top)
| USB 2.0 (bottom)
J USB 3.0 (top)
K USB 3.0 (bottom)
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Getting acquainted with your instrument

The following content provides a high-level description of the instrument controls and user interface.

Installing and activating Windows 10 operating system

Use the following instructions to install the embedded operating system solid state drive or to install and activate Windows 10 on the
instrument.

A Note: The Windows option is not available for the 4 Series MSO or MSO58LP instruments.

Install the SSD

The optional SSD assembly installs in the bottom of the instrument. To remove a previously installed SSD, reverse these steps. Contact
your nearest Tektronix, Inc., Service Center or Tektronix Factory Service if you need any installation assistance.

Prerequisite: Wear an anti-static wrist strap connected to the instrument chassis while installing this drive.

1. Remove all cables from the front and rear of the instrument, including the power cable.
2. Position the instrument on its back, with the bottom facing you.
3. Remove the SSD cover from the bottom of the oscilloscope as shown.

= S T

4. Slide the connector end of the SSD into the drive connector bracket. Push firmly to seat the drive in the connector.
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5. Push down on and tighten the thumb screw to attach the SSD to the chassis.
6. Reinstall the SSD cover on the bottom of the instrument.
7. Restore the instrument to its normal operating position.

Note: After installing a Windows SSD, go to the Powering on Windows for the first time on page 34 and Activating
Windows on page 34 procedures. These procedures do not apply when installing the SUPx-LNX options.

Powering on Windows for the first time

The instrument goes through a series of configuration boot-ups that require manual intervention when first powering up a new (never-
installed) Windows drive in an instrument. Once the drive is configured, the instrument boots into Windows and starts the oscilloscope
application from then on.

1. Power on the instrument. The oscilloscope powers up to initialize some settings, then shuts down.

2. Power on the instrument again. The instrument powers up into the application start-up screen, then displays a message at the bottom
of the screen:

Updating System Files... This will take a few minutes.
The oscilloscope will shut down when the update is complete.

After a few minutes, the instrument powers down.
3. Power on the instrument again. The instrument boots-up into Windows and starts the oscilloscope application.

The instrument attempts to activate the Windows license as part of the initial power-on process (See Activating Windows on page 34).

Activating Windows

The Windows operating system shipped from Tektronix is in a "deferred activation" state. The first time you power on an instrument with a
newly installed Windows drive, the operating system may attempt to activate itself, depending on whether the instrument is connected to a
network.

« The instrument is connected to a network with access to the Microsoft web site:

+ The Windows activation occurs silently in the background, and does not display any messages. No other action is required.
+  See Verifying Windows activation on page 35 to check the activation status of the instrument.
+ The instrument is connected to a network without access to the Microsoft web site:
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+ The instrument may attempt to activate and fail. You may see a screen message saying that Windows is not activated and the
Windows user settings may be disabled.

+  See Verifying Windows activation on page 35 to check the activation status of the instrument.

* You can activate Windows by either connecting the instrument to a network with access to Microsoft or by contacting Microsoft to
obtain activation instructions:
+ Go to https://support.microsoft.com/en-us and select Windows.
+  Go to https:/Isupport.microsoft.com/en-us/contactus/ and follow the instructions to select your preferred contact method.

A Note: Please contact Microsoft to resolve Windows activation issues.

+ The instrument is not connected to any network:

+ The instrument stays in the "deferred activation" state. No error message appears. Windows, and the oscilloscope application, can
operate indefinitely in the deferred activation state without error messages.
«  See Verifying Windows activation on page 35 to check the activation status of the instrument.

+  Once you connect the instrument to a network with access to Microsoft, Windows will activate automatically (no interaction
required).
+  Moving an activated Windows SSD from one instrument to another:

+  Windows should remain activated. To verify activation, see Verifying Windows activation on page 35. If Windows lost activation
when installed on the current instrument, follow the above instructions to re-activate.

Verifying Windows activation
To check that Windows is activated:

1. Tap Start on the Windows taskbar.

2. Scroll down and tap Settings.

3. Tap Update & Security.
4, Tap Activation (left side list) to display the activation status.

Recovering Windows System Image

This procedure is outlined in the section labeled “Restoring a Windows SSD” in the “Opt. SUP5-WIN, SUP6-WIN, SUP6B-WIN,
SUPGB-LNX Upgrade Kit Installation Instructions” which can be found at download.tek.com/manual/5-6-MSO-Option-WIN_LNX-Install-
Instructions-071352402.pdf

Windows update

Automatic Windows update is disabled by default.

Differences between Windows and base instrument user interfaces

The Windows-based oscilloscope application interface appearance and behavior is exactly the same as the base instruments, with some
exceptions:
*You can change the size of the Windows-based oscilloscope application, or minimize it, just like any other Windows application.

+ The File Utilities choice in the File menu opens a standard Windows Explorer instance instead of the custom dialog found in the base
instrument.

* You can use the standard Windows network tools to mount and access network drives.
* You can use the standard Windows tools to create a login password to access the instrument, if required by your organization.
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You can use the Application menu to access installed applications.

Updating the Windows TekScope application software

The Windows TekScope application does not automatically update when newer versions are released. You will need to manually download
and install the newer software. The oscilloscope application cannot be running when installing the software.

To update the Windows version of the oscilloscope application software:

Instrument is connected to a network:

1.
2
3.
4
5
6.

1.
8.

Display the Windows desktop and open a browser.

. Go to www.tek.com/product-support.

Enter your model number in the Enter Product or Product Series Name: field and click Go.

. Click the Software tab (left side of table).
. Click the link in the description that pertains to your instrument model or series, and select the software that applies for Windows

instruments.

Check that the listed software is newer than your current installed software before downloading and installing.
Follow instructions to download the application file.

Click on the install instructions link to open the installation instructions.

Instrument is not connected to a network:

Follow the above instructions on a network-connected PC,

1.

Ll o

Open a browser on a network-connected PC or laptop.

Do steps 2 on page 36 through 7 on page 36 above.

Download the installation file to a USB memory device and insert the USB memory device in any USB Host port on the instrument.
Open the USB drive location.

Double-tap on the installation file to update the application software; follow any on-screen instructions.

Secure (lock) the instrument

Lock an instrument to a test bench or equipment rack to prevent property loss.

To secure the instrument to a workbench, rack, or other location, attach a standard laptop security lock to the rear panel of the instrument.
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Connecting probes or signals to the instrument

Probes connect the instrument to your device under test (DUT). Use a probe or cable that best matches your signal measurement needs.

Figure 3: Connecting probes to the MSO58LP

4/5/6 Series MSO MSO4X, MSO4XB, MSO5X, MSO5XB, MSO64, MSO6XB, MSO58LP, and LPD64 Help 37



Getting acquainted with your instrument

Figure 4: Connecting probes to the 6 Series MSO

Figure 5: Connecting SMA cables to the LPD64

Connecting Probes (all instruments except LPD64)

Connect TPP Series, TekVPI+, TekVPI, or other supported Tektronix analog probes by pushing them into a FlexChannel connector. The
probe base latch locks with a 'click’ when the probe is fully seated.

TekVPI probes automatically set the channel input parameters for that probe (bandwidth, attenuation, termination, and so on). If a probe
has a Menu button, push that button to open an on-screen configuration menu. Follow instructions provided with active probes to set their
parameters (auto zero, degauss, and so on).

To connect a TLP058 FlexChannel Logic Probe or a TDP7700 Series TriMode™ Probe:

1. Move the locking lever to the unlocked position, then let go to reset locking lever to the center position.

2. Insert the probe into a FlexChannel connector until fully seated and the lock mechanism clicks.

3. Move the locking lever to the locked position. The status light should be a solid green.

4. To disconnect the TLP058 probe, move and hold the locking lever at the unlocked position and pull out the probe. Do not pull on the
ribbon cable while removing the probe.

Connect a BNC probe or cable by pushing it onto a channel BNC bayonet connector and turn the lock mechanism clockwise until it locks.
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Note: Connecting a probe does not automatically enable that channel (make it active). Use the instrument controls or
programmatic interface to turn on a channel and open its configuration menu to verify or change probe or cable settings
(bandwidth, attenuation, termination and so on).

Connecting SMA cables (LPD64)

Connect SMA cables to the instrument. Hand tighten, then torque the cable connectors to 56 N-cm (5 in-Ib).

Rackmount option information
An optional rackmount kit lets you install the oscilloscope in standard equipment racks.

Please refer to the product datasheet at tek.com for information on rackmount options.

Bench conversion kit information for Low Profile instruments

The Low Profile instruments (MSO58LP and LPD64) come equipped with rackmount hardware installed so that you can immediately add
then to a rack. You can also order a kit to convert them for bench use.

To use a Low Profile instrument on a bench, purchase and install the 5 Series MSO MSO58LP/6 Series Low Profile Digitizer LPD64
Benchtop Conversion kit (Tektronix part number 020-3180-xx). The kit includes chassis feet and a handle, and lets you stack Low Profile
instruments on a bench.

Front panel controls and connectors

The front panel controls provide direct access to key instrument settings such as vertical, horizontal, trigger, cursors, and zoom. The
connectors are where you input signals with probes or cables, or insert USB devices.

Figure 6: 4 Series B MSO Controls
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Figure 7: 5 Series B MSO controls
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Figure 8: 6 Series B MSO controls

1. Acquisition and Cursors controls:

Run / Stop Single / Seq
T ]

3514.011
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Run/Stop starts and stops waveform acquisition. The button color indicates the acquisition status (green = running and
acquiring; red = stopped). When stopped, the oscilloscope shows waveforms from the last completed acquisition. The Run/Stop
button on the screen also shows the acquisition status.

Cursors button turns screen cursors on or off. Use the Multipurpose knobs to move the cursors. Double-tap the cursor readouts,
or on a cursor bar (line), to open the configuration menu to set cursor types and functionality. See Display and configure
cursors on page 109.

Fast Acq™ enables or disables the fast acquisition mode. FastAcq provides high-speed waveform capture that reduces the dead
time between waveform acquisitions, enabling the capture and display of transient events such as glitches and runt pulses. It

is helpful in finding elusive signal anomalies. Fast acquisition mode can also display waveform phenomena at an intensity that
reflects their rate of occurrence.

Single/Seq enables making a single waveform acquisition, or a specified number of acquisitions (as set in the Acquisition
configuration menu). Pushing Single/Seq turns off Run/Stop mode and takes a single acquisition. The button color indicates the
acquisition status (quick green flash = single acquisition acquired; solid green = waiting for trigger event). Pushing Single/Seq
again takes another single acquisition.

High Res applies unique finite impulse response (FIR) filters based on the current sample rate. This FIR filter maintains

the maximum bandwidth possible for that sample rate while rejecting aliasing. The filter removes noise from the oscilloscope
amplifiers and ADC above the usable bandwidth for the selected sample rate. Implementation of the filter in hardware, ahead of
the trigger and storage, reduces trigger jitter and enables using Fast Acq mode while in High Res mode.

High Res mode also guarantees at least 12 bits of vertical resolution. The number of bits of resolution is displayed in the
Acquisition badge at the bottom of the screen. The Horizontal badge also updates to show the sample rate and record length
settings while in High Res mode.

Clear deletes the current acquisitions and measurement values from memory.

2. Multipurpose knobs: The Multipurpose knobs A and B move cursors and set parameter values in configuration menu input fields.
Selecting an menu field that can use a Multipurpose knob assigns the indicated knob to change the value in that input field. The ring
around each knob lights when you can use that knob to do an action. Push a Multipurpose knob to enable the Fine mode for making
smaller increment changes. Push the knob again to exit Fine mode.

(4]

Push JZU

D Fine

3514-010

3. Trigger controls:
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Force forces a trigger event at a random point in the waveform and captures the acquisition.

Level sets the amplitude level that the signal must pass through to be considered a valid transition. The color of the Level knob
LED indicates the trigger source except for dual-level triggers.

The Level knob is disabled when the trigger type requires two level settings or other trigger qualifiers (set from the Trigger
configuration menu). Push the knob to set the threshold level to 50% of the peak-to-peak amplitude range of the signal.

Slope sets the signal transition direction to detect for a trigger (low to high, high to low, or either direction). Push the button to
cycle through the selections. The Slope button is disabled when the trigger type requires other slope qualifiers (set from the
Trigger configuration menu).

Mode sets how the instrument behaves in the absence or presence of a trigger event:

+ Auto trigger mode enables the instrument to acquire and display a waveform whether or not a trigger event occurs. If a
trigger event occurs, the instrument displays a stable waveform. If a trigger event does not occur, the instrument forces a
trigger event and acquisition and displays an unstable waveform.

+ Normal trigger mode sets the instrument to acquire and display a waveform only when there is a valid trigger event. If
no trigger occurs, the last waveform record acquired remains on the display. If no last waveform exists, no waveform is
displayed.

Vertical controls:
VERTICAL

Position
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+ Position moves the selected waveform (Channel, Math, Reference, Bus) and its graticule up or down on the screen. The color
of the Position knob indicates which waveform the knob is controlling. Push the knob to set the threshold level to 50% of the
peak-to-peak amplitude range of the signal.

+ Scale sets the amplitude units per vertical graticule division of the selected waveform. The scale values are shown on the right
edge of the horizontal graticule lines, and are specific to the selected waveform in both Stacked or Overlay modes (in other
words, each waveform has its own unique vertical graticule settings regardless of display mode). The color of the Scale knob
indicates which waveform the knob is controlling.

+ Channel buttons turn on (display), select, or turn off Channel, Math, Reference, or Bus waveforms. The number of channel
buttons depends on the instrument model. The buttons operate as follows:
+ Ifthe channel is not displayed, pushing a Channel button turns on that channel to the Waveform view.
+ If the channel is on the screen and is not selected, pushing that channel's button selects that channel.

+ Ifthe channel is on the screen and is also selected, pushing that channel's button turns that channel off (removes it from
Waveform view).

+ Math button adds or selects a Math waveform on the Waveform view.
+ If no Math waveform exists, pushing the Math button adds a Math waveform to the Waveform view and opens the Math
configuration menu.

+ If only one Math waveform is displayed, pushing the button turns off the Math waveform (removes it from Waveform view).
Push the button again to display the waveform.

+ If two or more Math waveforms are displayed, pushing the button cycles through selecting each math waveform.
+ Ref button adds or selects a Reference (saved) waveform on the Waveform view.
+ If no Reference waveform exists, pushing the Ref button opens the Browse Waveform Files configuration menu. Navigate
to and select a waveform file (*.wfm) and tap Recall to load and display the reference waveform.

+ If only one Reference waveform is displayed, pushing the button turns off the Reference waveform (removes it from the
Waveform View). Push the button again to display the waveform.

+ If two or more Reference waveforms are displayed, pushing the button cycles through selecting each Reference waveform.
+ Bus button adds or selects a bus waveform on the Waveform view.
+ If no Bus waveform exists, pushing the Bus button adds a Bus waveform to the Waveform view and opens the Bus
configuration menu.
+ Ifonly one Bus waveform is displayed, pushing the button turns off the Bus waveform (removes it from Waveform view).
+ If two or more Bus waveforms are displayed, pushing the button cycles through selecting each Bus waveform.

5.  Horizontal controls:
HORIZONTAL

Position o Zoom D
an

Scale @

Navigate

]

3514014

@

i @

+ Position moves the waveform and graticule side to side on the screen (changing the trigger point position in the waveform
record). Push the knob to center the trigger event to the center graticule on the Waveform view.

+ Scale sets the time per major horizontal graticule division and samples/second parameters for the oscilloscope. Scale applies to
all waveforms. Push the knob to enable the Fine mode for making smaller increment changes. Push the knob again to exit Fine
mode.

+  Zoom opens the Zoom mode. Push Zoom again to close zoom mode. See Zoom user interface on page 68.
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Zoom knob (center knob) increases or decreases the area of the zoom box in the Zoom Waveform Overview, which in turn
controls the zoom amount of the waveforms shown in the main Zoom view.

Pan knob (outer knob) moves the Zoom box left or right in the Zoom Waveform Overview, which in turn controls the part of the
waveform shown in the main Zoom view.

Navigate (left and right arrow) buttons puts the oscilloscope in Zoom mode and positions the previous or next search point in the
waveform record to the center graticule of the Waveform view. There must be a Search badge present in the Results bar before
the Navigate function will operate. Press and hold a front panel navigate button to continue moving to the next search point in
that direction. See Badges on page 55.

The front panel Navigate buttons can also be used for the Previous and Next button functions on measurement badges.

Miscellaneous controls:

| aor J oo

3514-015

Touch Off turns touch screen capability off. The Touch Off button is lighted when the touch screen is turned off.

Save is a one-push save operation that uses the current File > Save As settings to save screen shots (including open menus

and dialog boxes), waveform files, instrument settings, and so on.

+ IfaFile > Save or File > Save As operation has occurred since the last instrument startup, pushing Save saves the file types
to the location last set in the Save As configuration menu.

+ If no file save operation has occurred since the last instrument startup, pushing Save opens the Save As configuration menu.
Select a tab to select the type of file to save (Screen Capture, Waveform, and so on), set any associated parameters, and
where to save it, and select OK. The specified file or files are saved. The next time you push Save, the same type files are
saved.

+ Screen Captures capture the entire screen, including most displayed configuration menus and dialog boxes.
Default Setup restores the oscilloscope settings (horizontal, vertical, scale, position, and so on) to the factory default settings.
Autoset automatically displays a stable waveform. See Autoset to quickly display a waveform on page 86.

Ground and Probe Compensation connectors: The Ground and Probe Compensation connectors are located at the lower right side
of the instrument, near the front panel. The Ground connector (the small hole in the case) provides an electrically grounded (through
a resistor) connection point to attach an anti-static wrist strap, to reduce electrostatic damage (ESD) while you handle or probe the
DUT.

The Probe Compensation connections provide a ground connector (upper tab) and 1 kHz square wave source (lower tab) for
adjusting the high-frequency response of a passive probe (probe compensation). The oscilloscope uses this signal to automatically
compensate supported probes, including the ones that ship with the product. See Compensate the TPP Series probes on page 74.
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8. USB Host ports (USB 3.0 and 2.0): USB ports are located at the lower right corner of the front panel, and on the rear panel.
Connect USB flash drives to which you can save or recall data (such as instrument software updates, waveforms, settings, and
screen captures), or connect peripheral devices such as a mouse or keyboard.

9. FlexChannel probe connectors: FlexChannel connectors support all TekVPI+ and TekVPI measurement probes, BNC passive
probes, the TPL058 FlexChannel Logic Probe, and BNC cables. You connect most probes simply by pushing them into the connector
until the probe seats with a click.

Figure 9: 4 Series MSO
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Figure 10: 5 Series MSO

10. Aux In auxiliary trigger input connector. A connector to which you can connect an external trigger input signal. Use the Aux In trigger
signal with the Edge trigger mode.

The MSO58LP front panel

Tektroni MsO LOW PR(fAILE
2 5 6

LB EEEEEEE
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1. FlexChannel probe connectors: FlexChannel® connectors support all TekVPI+ and TekVP| measurement probes, BNC passive
probes, the TLP058 FlexChannel® Logic Probe, and BNC cables. You connect most probes simply by pushing them into the connector
until the probe seats with a click. See

2. LAN Status LED: Shows the network connection and activity status:

A

s|seRies
LN
Acq

Aux Trig
(0]

e A

+  Off - No power to instrument

+  Green - Network connection is good

+ Red - Network connection has fault or is not connected
3. Probe Compensation connectors:
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The Probe Compensation connections provide a ground connector and 1 kHz square wave source for adjusting the high-frequency
response of a passive probe (probe compensation). The oscilloscope uses this signal to automatically compensate supported probes.
See Compensate the TPP Series probes on page 74.

You can also use the ground connector to attach an anti-static wrist strap, to reduce the chance of electrostatic damage (ESD) while
you handle or probe the DUT.

4. USB Host ports: USB ports are located at the lower right corner of the front panel. Connect USB flash drives to which you can save or
recall data (such as instrument firmware updates, waveforms, settings, and screen captures), or connect peripheral devices such as a
mouse or keyboard.

5. Aux Trig trigger input connector: An SMA connector to which you can connect an external trigger input signal. Use the AUX In
trigger signal with the Edge trigger mode.

6. Acq status LED: Shows the instrument trigger/acquisition status:

+  Green - Triggered
* Yellow - Armed but not yet triggered
* Red - Acquisition stopped
7. Power On/Standby button: Powers the instrument on and off. The power button color indicates instrument power states:
+ Nolight - No AC power applied
+  Yellow - Standby mode
+ Blue - Powered on
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The LPD64 front panel
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Shows the instrument trigger/acquisition status:

13569-001

Acq status LED;

+ Green - Triggered

+  Yellow - Armed but not yet triggered

+ Red - Acquisition stopped

LAN Status LED: Shows the network connection and activity status:
+  Off - No power to instrument

+ Green - Network connection is good

* Red - Network connection has fault or is not connected

LAN Reset button (to the right of the LAN status LEDs): Lets you manually reset the LAN settings.

. USB Host ports (One USB 3.0; two USB 2.0): Lets you save or recall data (such as instrument firmware updates, waveforms, settings,
and screen captures) to a USB memory device, or connect peripheral devices such as a mouse or keyboard.

Aux Trig trigger input connector: An SMA connector to which you can connect an external trigger input signal. Use the AUX In

trigger signal with the Edge trigger mode.
SMA connectors: SMA connectors support high bandwidth and frequency cables.

. Power On/Standby button: Powers the instrument on and off. The power button color indicates instrument power states:

+ No light - No AC power applied
*  Yellow - Standby mode
¢+ Blue - Powered on

Rear panel connections

The rear panel connections supply power to the instrument and provide connectors for network, USB devices, video, reference signals,

and the AFG output.
4 Series B MSO

48



Getting acquainted with your instrument

® © 660 6000

USB20Device =~ ——— USB 3.0 Host HOmI LAN 10/100/1000

oy AUX Out

AFG Out

RefIn
10 MHz | 7V p-p Max

®
sfia) ©

3801-001

1. USB 2.0 Device port lets you connect to a PC to remotely control the instrument using USBTMC protocol.
2. USB 3.0 Host ports let you connect a USB memory device, keyboard, or mouse.
3. HDMI video output lets you connect an external monitor or projector to show the instrument's graphical user interface.

A Note: You must connect an external monitor before powering on the instrument.

LAN connector (RJ-45) connects the instrument to a 10/100/1000 Base-T local area network.

AUX Out generates a signal transition on a trigger event, outputs a 10 MHz reference signal, or outputs a synchronization signal from
the AFG.

Ref In lets you connect a high-precision 10 MHz reference signal to the oscilloscope for more accurate measurements.

AFG Out is the signal output for the optional Arbitrary Function Generator (AFG) feature.

Security lock connector lets you use a standard PC/laptop lock cable to secure the instrument to a work bench or other location.
Power cord connector. Use only the power cord specified for this product and certified for the country of use.

Series MSO:

0 ®© © 000
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LAN 10/100/10000 USB 2.0 Device — USB 2.0 Host
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LAN connector (RJ-45) connects the instrument to a 10/100/1000 Base-T local area network.

USB 2.0 Device port lets you connect to a PC to remotely control the instrument using USBTMC protocol.

USB 2.0 Host ports let you connect a USB memory device, keyboard, or mouse.

HDMI video output lets you connect an external monitor or projector to show the instrument's graphical user interface.

oo Db~
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A Note: You must connect an external monitor before powering on the instrument.

5. AUX Out generates a signal transition on a trigger event, outputs a 10 MHz reference signal, or outputs a synchronization signal from
the AFG.

Ref In lets you connect a high-precision 10 MHz reference signal to the oscilloscope for more accurate measurements.

AFG Out is the signal output for the optional Arbitrary Function Generator (AFG) feature.

Security lock connector lets you use a standard PC/laptop lock cable to secure the instrument to a work bench or other location.
Power cord connector. Use only the power cord specified for this product and certified for the country of use.

Series MSO (including MSO58LP) and 6 Series MSO (including LPD64):
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. Power cord connector. Use only the power cord specified for this product and certified for the country of use.
2. Refln lets you connect a high-precision 10 MHz reference signal to the oscilloscope for more accurate measurements.

3. AUX Out generates a signal transition on a trigger event, outputs a 10 MHz reference signal, or outputs a synchronization signal from
the AFG.

4. AFG Out is the signal output for the optional Arbitrary Function Generator (AFG) feature.

5. Video outputs (Display Port, VGA, and DVI-D) let you connect an external monitor or projector to show the instrument's graphical user
interface.

6. USB 3.0 Device port lets you connect to a PC to remotely control the instrument using USBTMC protocol.
7. USB Host ports let you connect a USB memory device, keyboard, or mouse.
8. LAN connector (RJ-45) connects the instrument to a 10/100/1000 Base-T local area network. The LAN is LXI 1.5 compliant.

3749001
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9. Security lock connector lets you use a standard PC/laptop lock cable to secure the instrument to a work bench or other location.

User interface screen

The touch screen user interface contains waveforms and plots, measurement readouts, and touch-based controls to access all

oscilloscope functions.
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1. The Menu bar provides menus for typical operations including:

+ Saving, loading, and accessing files
+ Undoing or redoing an action
+  Setting oscilloscope display and measurement preferences
+  Configuring network access
*  Running self tests
+ Erasing measurement and settings memory (TekSecure™)
+ Loading option licenses
+  Opening a Help viewer
2. The Waveform View area displays analog, digital, math, reference, bus, and trend waveforms. The waveforms include waveform
handles (identifiers), individual vertical graticule scale labels, and trigger position and level(s) indicators. You can set the Waveform

View to stack each waveform vertically in separate graticules, called 'slices' (the default mode, as shown in the previous image), or
overlay all the waveforms on the screen (traditional waveform view). See User interface elements on page 53.

You can also add Histogram, Spectral, Eye, and Measurement Results views (plots) for individual measurements. These plot views are
separate view windows that you can move on the screen by dragging their title bar to a new position.

3. The Results Bar contains controls for displaying cursors, adding callout, plots, and result tables to the screen, and add measurements
to the Results bar. To remove a measurement, search or other badge from the Results Bar simply flick it off screen. The controls are:

+ The Cursors button displays on-screen cursors in the selected view. Touch and drag, or use the Multipurpose knobs, to move the
cursors. Double-tap on a cursor, or on the cursor readouts, to open a configuration menu to set cursor types and related functions.
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The Measure button opens a configuration menu from which to select and add measurements to the Results bar. Each
measurement you add has a separate badge. Double-tap a measurement badge to open its configuration menu.

The Results Table button adds a Measurement or Bus Results table to the screen. The Measurement Results table displays all
measurements present in the Results bar. The Bus Results table displays bus decode information for displayed bus waveforms.
Each table is contained within its own view window, which can be moved within the display area.

To remove a measurement, search or other badge from the Results Bar simply flick it off screen.

The Callout button adds a Callout object to the selected view. Double-tap the Callout text to open a configuration menu to change
the type of callout, text and font characteristics. Drag any callout other than bookmark to any location on the oscilloscope screen
view. Bookmarks callout can only be added to waveviews and spectrum views.

The Search button lets you detect and mark a waveform where specified events occur. Tap Search to open a Search configuration
menu and set the search conditions for analog and digital channels. You can add any number of searches to the same waveform or
to different waveforms. Search badges are added to the Results Bar.

The Plot button adds an XY, XYZ, or Eye Diagram plot to the display. These plots are contained within their own window and can
be moved within the overall display area.

The Measurement and Search badges show measurement and search results, and are displayed in the Results Bar. See
Badges on page 55. See Add a measurement on page 96. See Add a Search on page 107.

The Zoom icon button at the up right of the Results Bar lets you to draw a box on the screen to zoom in on an area of interest,
drawing segments for mask testing, or drawing areas to define visual trigger conditions.

The More... button at the up right of the Results Bar allows you to select Zoom, Visual trigger, Mask, or Waveform Histogram.

The Settings Bar contains System badges for setting Horizontal, Trigger, Acquisition, and Date/Time parameters; Inactive Channel
buttons to turn on channels; Add New Waveform buttons to add math, reference, and bus waveforms to the display; and Channel and
Waveform badges that let you configure the individual waveform parameters. Tap a channel or waveform button to add it to the screen
and display a badge. Double-tap a badge to open its configuration menu. See Badges on page 55.

Configuration Menus let you quickly change the parameters of the selected user interface item. You can open configuration menus by
double-tapping on badges, screen objects, or screen areas. See Configuration menus on page 67.
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User interface elements

Each area of the user interface has a specific function that helps manage information or controls. This topic shows and describes the key
user interface elements.

Horizontal Trigger Acquisition
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SR:12.5GSk 80 ps/pt R
RL25kpts ¥ 50% U: 2,02V L:920 mV_f| 7.457 kAcgs

©

The Waveform Record View is a graphical high-level view of the overall waveform record length, how much of the record is on the
screen (shown in brackets), the location of key time events including the trigger event, and the current position of waveforms cursors.

L ]

If you are displaying a Reference waveform that is shorter than the current acquisition record length, or you are changing the
horizontal time scale while the oscilloscope acquisition is stopped, the brackets change position to show the part of the waveform
record that is being viewed relative to the current acquisition total record length.

H————Y¥———

If cursors are active on a waveform, the Waveform Record View shows the relative cursor positions as small vertical dashed lines.

[———WHi———H ]

When in Zoom mode, the Waveform Record View is replaced with the Zoom Overview. See Zoom user interface on page 68.

The Expansion Point icon on the waveform view shows the center point around which the waveform expands and compresses when
changing horizontal settings.

The Trigger Position Indicator shows where the trigger event occurred in the waveform record. The trigger icon is displayed in the
waveform slice that is the trigger source.
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10.

1.
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The Zoom icon (in upper right corner of Waveform and Plot views) toggles zoom on and off. The front panel Zoom button and knobs
also turn on zoom mode and change the position and horizontal size of the Zoom Box.

The Trigger Level Indicator icon(s) shows the trigger level on the trigger source waveform. Some trigger types require two trigger
levels.

Measurement and Search badges show measurement and search results. See Badges on page 55. See Add a
measurement on page 96.

The Results Bar Handle opens or closes the Results bar, to maximize waveform screen viewing when needed. To reopen the
Results bar, either tap the handle icon or swipe left from the right side of the display.

The System badges show global instrument settings (Horizontal, Trigger, Acquisition, Run/Stop status, and Date/Time). See
Badges on page 55.

The Inactive Channel buttons add channel waveforms to the Waveform view and add an associated Channel badge to the Settings
bar.

The Add New Math, Add New Ref, and Add New Bus buttons add the corresponding signal to the Waveform view, and add an
associated Waveform badge to the Settings bar. You can add any number of Math, Reference, and Bus waveforms, limited only by
system memory.

The optional AFG button opens the AFG configuration menu to set and enable the AFG output. This button is only present if the AFG
option is installed.

The optional DVM button lets you use an analog probe to take DC, AC RMS, or DC+AC RMS voltage measurements on your DUT.
Tap the button to add a DVM badge to the Results Bar and open a configuration menu. The DVM option also enables a trigger
frequency counter, accessible from the Mode & Holdoff panel in the Trigger badge menu. This button is only present if the DVM
option is installed.

Double-tap a badge to open its associated configuration menu. See Badges on page 55. See Configuration menus on page 67.
If you add more Channel or Waveform badges than can fit in the waveform badge display area, tap the scroll buttons at each end of
the waveform badge area to scroll and display hidden badges.

The Waveform Handles on each waveform identify the source of that waveform (Cx for channels, Mx for Math waveforms, Rx for
Reference waveforms, Bx for bus waveforms). The waveform handles are at the zero-volt level of the waveform by default. The
currently selected waveform handle is a solid color; unselected waveform handles are outlined.

Double-tapping a waveform handle opens the configuration menu for that waveform.

For digital channels, the waveform handle shows the channel number, each individual digital signal labeled DO-D7 and displayed
with a different color.

Double-tapping a digital waveform handle opens the digital channel configuration menu.
Dragging a digital signal handle over another handle swaps those two signals on the waveform.

The probe Dynamic Range Limit Markers are displayed just within the left-hand graticule edge, based at the channel vertical trace
handle position and extending up and down to the dynamic range limits of the probe. The markers are only displayed if compatible
probes are used. Signals must be within the probe dynamic range for the oscilloscope to correctly display and measure the signals.
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The markers are displayed, for about three seconds, after any Offset, Position, or Scale control change that leaves the channel
dynamic range limits within the acquisition window. After about three seconds the markers become short lines at the left edge of the
graticule. If the dynamic range is too small to display the arrows, the arrows are omitted. Examples of all three marker versions are
shown.

Badges

Badges are rectangular icons that show waveform, measurement, and instrument settings or readouts. Badges also provide fast access to
configuration menus. The badge types are Channel, Waveform, Measurement, Search, and System.

Channel and Waveform badges

Channel and Waveform (Math, Ref, Bus, Trend) badges are shown in the settings bar, located along the bottom left of the screen. Each
waveform has its own badge. The badges show high-level settings for each displayed channel or waveform. Double-tap a badge to open
its configuration menu.

Trend 1

1 Vidiv

1 Vidiv 1 Vidiv Meas 9
i) % 1 MQ 731.3963...
1GHz B ) 1GHz B 500 MHz B Frequency

Most Channel and Waveform badges also have Scale buttons, shown by single-tapping the badge. Use the Scale buttons to increase or
decrease the vertical scale setting for that waveform.

1 Vidiv

%
1GHz &

You can drag Channel and Waveform badges to change their position in the Settings bar and open the badge right-click menu to access a
quick-action menu.

There are two ways to delete Channel and Waveform badges.

+ Right-click the badge and turn it off.

+  Flick the badge off the bottom edge of the display to remove it from the Settings bar. Flicking upwards from the bottom edge of the
Settings bar recovers the badge. Badge recovery is only possible within 10 seconds of removal.

Channel badges are listed in the channel order unless you have moved them. Channel badges may also display short error or warning
messages. For more information double-tap the badge to open its configuration menu, or search the instrument Help.

Waveform badges (Math, Ref, Bus, Trend) are listed in the order created (unless they have been moved), and are grouped together by
type. Deleting a Waveform badge does not change the order or names of the remaining badges.
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Measurement badges

Measurement badges are located in the Results bar. They show measurements or search results. The badge title also shows the
measurement source or sources. To add a Measurement badge, tap the Add New Measurement button and select a measurement.

Peak-to-Peak

1" 6.840 V

Double-tap a Measurement badge to open its configuration menu to change or refine settings. The default measurement badge readout
shows the measurement's mean () value.

Some measurements and their badges are only available as options. For example, Power measurements are only listed in the Add New
Measurement menu if the required power option is installed.

Power 2  GIEED
IMagnetic Property’
BPEAK:. FO5F mT
Br: =

He o -

Huax: 2.494 ATdm
laipie: 546 A

AB: 1046 ml
AH:  1.828 AT/m
Perm: 1,205 kHimn
Fene: 3955 W
Clipe: B852.3 MV
Tl 4807 W

Wizard badge

The wizard badge is available only for Control Loop Response, Power Supply Rejection Ratio (PSRR) and Impedance power
measurements. If the required power option is installed, the power measurements are listed in the Add New Measurement menu.

Wizard badge helps to go through a multiple step process for the measurements. Wizard badges have multiple badge states.

Configuration badge:

Control Loop Resp. ..

Double Click this
badge to configure,
and then begin this
measurement.

Execution badge:

Acquiring data to
build the desired
plots, please wait.

Cancel
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Click Cancel to change the current badge state to the previous badge state.

Results badge:

Control Loop Resp. ..

Bl 0 dB

@148.2 kHz

[ PR

@323.6 kHz

Wide badge

The wide badge displays all the phases results in a separate column. All sub-measurements are listed in the results badge in the first
column. The common result such as Frequency is applicable to all the (3) phases and displayed as single value. The configured sources
for each phase are displayed in channel colors. The Wide Badge applies to IMDA measurements only.

IMDA Meas 1: Cy Juality'
VaMila  WbNib  WeN:lc
2 arso

VinaslV: 14.74 14.74 14.48
ViV 8.197 8,383 8.423
IR (A 8794 m 9994 m 975.0m
[[YPELEY, 4537 m 5743 m 5629m
W CFE 2.953 2931 3.053
I CF: 3.196 3.407 3.575

TrPwr(W) 4.795 5914 4.546
RePwr(vAR): -12.04  -13.49  -13.36
ApPwrVAk 1296 14.73 14.12
PF: 593.2m 659.6m 511.6m

Phase -53.61° -48.73° -h9.23°
Freq: 287 .6 Hz

2 TrPwr: 15.25W

% RePwr: -38.90 VAR

Z ApPwr: A1.82 VA

To add statistical readouts to individual measurement badges, double-tap a measurement badge to open its configuration menu and select
Show Statistics in Badge. The measurement badge displays the standard deviation (o) value. The standard deviation is zero, when the
population is one.
Meas 1
Positive Overshoot
': 2.489 %

0': 0.000 % (N'=1)
M: 4.442 %

m: 1.858 %

N: 754

Some Measurement badges also have Navigation buttons, shown by single-tapping the badge.

Fall Time
KU 10.74 ns

Value: 10.2762 n

(<2

The < (Previous) and > (Next) buttons center the waveform in the display at the position of the previous or next measurement point in the
record (for measurements that take more than one measurement per acquisition).

The Min' and Max' navigation buttons center the waveform in the display at the minimum or maximum value for that measurement in the
current acquisition.
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The prime symbol (') shown on measurement readings and Min/Max buttons indicates that the value shown (or moved to in the case of
Min/Max buttons and waveforms) is from the current acquisition. Lack of a prime symbol means the value is from all acquisitions.

The Measurement badge displays Status and Failures information when pass/fail testing is enabled through the configuration menu. The
Status line shows Pass (green) or Fail (red) according to the conditions defined in the Pass/Fail Testing panel. The number of Failures
are displayed when statistics are shown in the badge. The Pass/Fail status, number of Failures, and the Limit(s) set in the Pass/Fail
Testing panel are available in the Measurement Results table.

Frequency

p' 134.7 MHz
o' 0.000Hz

fl: 230.1 MHz
m; 103.5 MHz
M: 1029
Failures: 0
Status: Pass
Low amplitude

Meas 1
Frequency

Wu': 97.74 MHz

0" 269.1 kHz

M: 100.2 MHz

m: 96.66 MHz

N: 263125

Failures: 1

Status: Fail

Measurement badges are listed in the order created, starting at the top of the Results bar. Deleting a Measurement badge does not
change the order or names of the remaining badges.

You can drag Measurement badges to change their position in the Results bar and open the badge right-click menu to access a
quick-action menu.

There are two ways to delete Channel and Waveform badges.

+ Right-click the badge and turn it off.

+  Flick the badge off the right edge of the display to remove it from the Results bar. Flicking left from the right edge of the Results bar
recovers the badge. Badge recovery is only possible within 10 seconds of removal.

Mask Test badge

The mask test results and measurement statistics are displayed in the Mask Test badge in the Results bar. The badge is created when the
first segment of a mask is defined.

Mask Test 1
Test 1

Tested: 1017
Passed: 2632

Failed: 754

Cons: 642
Status: Failing
Seg1: 744
Seq2: 754

Badge readout Description

Label (optional readout) A label defined in the badge configuration menu.

Tested The total number of waveforms tested against the mask.

Table continued...
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Badge readout Description

Passed The number of waveforms that contained no samples that violated the mask.

Failed The number of waveforms that contained one or more samples that violated the mask.
Displays in red if greater than or equal to the total failures threshold.

Cons The highest number of consecutively failed waveforms in the test run. Displays in red if
greater than or equal to the consecutive failures threshold.

Status The status of the mask test. It can be On, Off, Passed/Passing (green) or Failed/Failing
(red).

Seg n (optional readout) The number of waveforms that contained one or more samples that violated mask segment
n.

Double-tap a Mask Test badge to open its configuration menu to change or refine settings.
You can drag the badge to change its position in the Results bar and open the badge right-click menu to access a quick-action menu.
There are two ways to delete Channel and Waveform badges.

+ Right-click the badge and turn it off.

+  Flick the badge off the right edge of the display to remove it from the Results bar. Flicking left from the right edge of the Results bar
recovers the badge. Badge recovery is only possible within 10 seconds of removal.

See for the mask test configuration settings Create a Mask on page 158 for more information masks and Mask Test badge configuration
menu on page 471

Waveform Histogram badges
The Waveform Histogram badges are located in the Results bar. The badge title shows the histogram source.

To add the Waveform Histogram badge to Results bar, set the Display to On from the Result Badge menu. Double-tap a Waveform
Histogram badge to open its configuration menu to change settings.

Std Dev:  24.86ns

The histogram badge displays the measurements which are checked in the Result Badge menu. To add more histogram measurements to
the badge refer Waveform Histogram Result Badge menu on page 634.

You can drag the badge to change its position in the Results bar and open the badge right-click menu to access a quick-action menu.
There are two ways to delete Waveform Histogram badges.

*+ Right-click the badge and select Delete Histogram.

+ Flick the badge off the right edge of the display to remove it from the Results bar. Flicking left from the right edge of the Results bar
recovers the badge. Badge recovery is only possible within 10 seconds of removal.

See also

+  Create a waveform histogram on page 164
+  Waveform Histogram configuration menu on page 633

Cursor badges
You can display the cursor readouts in a Cursors badge in the Results bar. The badge contents depend on the cursor in use.
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(A) t: 26.800 ms O t 26800 ms Q v 4802V
v: 4.802V © t 31500ms @ v 2936V

© b 31500ms | At: 4700 ms | ‘ Av: 1.866 V |
v: 2936V 1/At: 212.76 Hz 1/Av: 5359 mV/s
At: 4700 ms

1/At: 212.76 Hz
Av: 1.866 V

1/Av: 535.9 mV/s

To create a cursor readouts badge, turn on Cursors, double-tap a cursor readout to open its configuration menu, and set the Readouts
mode to Badge.

Note: You can only view cursor readouts in one location at a time; either on the waveform or in a Cursors badge. You cannot
move cursor readouts to a badge for Spectrum View cursors.

You can drag the badge to change its position in the Results bar and open the badge right-click menu to access a quick-action menu.
There are two ways to delete Channel and Waveform badges.

+ Right-click the badge and turn it off.

+  Flick the badge off the right edge of the display to remove it from the Results bar. Flicking left from the right edge of the Results bar
recovers the badge. Badge recovery is only possible within 10 seconds of removal.

Search badges

Search badges are also shown in the Results bar, below the Measurement badges. A search badge lists the search source, search type,
and the number of search event occurrences in the current acquisition. The instrument marks the waveform where those events occur with
small down-pointing triangles along the top of the waveform graticule. Double-tap a search badge to open its configuration menu to change
or refine search settings.

Search 1 )

Search: Edge

Events: 4

Search badges are created by tapping the Add New... Search button. Use the displayed configuration menu to set the search criteria.

Search badges have < (Previous) and > (Next) Navigation buttons that open the Zoom mode and center the waveform in the display
at the position of the previous or next search mark in the waveform record. Search badge Navigation buttons are only usable when the
oscilloscope is in single acquisition mode. Single-tap a badge to close the Navigation buttons.

Search: Pulse ...
Events: 2

(3

Some searches also provide Min and Max navigation buttons that open the Zoom mode and center the waveform in the display at the
minimum or maximum value for that search event in the current acquisition.

Search badges are listed in the order created. Deleting a Search badge does not change the order or names of the remaining badges.

You can drag Search badges to change their position in the Results bar and open the badge right-click menu to access a quick-action
menu.

There are two ways to delete Channel and Waveform badges.

+ Right-click the badge and turn it off.

+  Flick the badge off the right edge of the display to remove it from the Results bar. Flicking left from the right edge of the Results bar
recovers the badge. Badge recovery is only possible within 10 seconds of removal.

60



Getting acquainted with your instrument

Deleting mass Measurements/Searches badges at once
This badge helps you to delete/remove many number measurements or searches, which are in the Results bar.

1. Select and right click on the Measurement/Search badge in the Results bar, which displays the dialog box as shown:

Configure Meas 4...

Delete Meas 4

Delete All Measurements

Controls Description

Configure Measurement/Search Configure Measurement or Search badges

Delete Measurement/Search/Histogram |Deletes the selected Measurement (standard, power, jitter, DDR, etc.)/Search/Histogram
badge in the Results bar.

Delete All Measurement/Search/ Deletes all the Measurement (standard, power, jitter, DDR, etc.)/Search/Histogram
Histogram badges in the Results bar.

2. When Delete All Measurements is selected, the oscilloscope asks for the confirmation to delete all the measurements/search at a
time.

INFORMATION

3. The dialog box provides you a checkbox that gives the choice to bypass remaining information dialogs.

+ Don’t ask for remaining items: Default is unchecked. If you leave it unchecked and clear the information dialog, then the dialog
will appear again for the next measurement deletion.

+ Ifthe box is checked, it proceeds with deleting the rest of the items without bringing up the dialog box again. The dialog box
appears for each set of measurements you want to delete.

Signal Clipping and Badges

WARNING: Clipping is caused by excessive or dangerous voltage at the probe tip, and/or a vertical scale setting that is not
adequate to display the entire vertical range of the waveform. Excessive voltage at the probe tip can injure the operator and cause
damage to the probe and/or instrument.

This instrument shows a warning triangle symbol and the words Clipping in a Channel badge when a vertical clipping condition exists. Any
measurement badges associated with that channel also indicate a clipping condition by turning the measurement text red and listing the
type of clipping (positive or negative).

Ch2
i Clippi :
iv Amplitude Frequency
o P> 1.824V ' > 3.475 MHz
Pos clipping Pos dipping

1GHz

To close the clipping message, change the vertical scale to show the entire waveform, disconnect the probe tip from the excessive voltage
source, and check that you are probing the correct signal using the correct probe.

Clipping causes inaccurate amplitude-related measurement results. Clipping also causes inaccurate amplitude values in saved waveform
files. If a math waveform is clipped, it will not affect amplitude measurements on that math waveform.
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Error Messages and Badges
This instrument shows a warning triangle symbol and an error message abbreviation in a Channel badge when an error occurs.

Ch1

5 mV/div
=

250 MHz B

lcha i
ANoTip
100 mV/idiv

500
5GHz %

To remove the message from the badge, clear the error as indicated in the table.

Table 1: Probe errors

Error message Description

Prb Comm Accessory communication timed out. Please re-attach the accessory.

Prb ROM Unable to read probe ROM. Please re-attach the accessory.

Unsup Accessory is unsupported.

Prb Fault Critical accessory fault. Please re-attach the accessory. If the problem persists, contact
Tektronix service.

Over Rng The signal voltage or current is over range. Please reduce the signal amplitude.

Temp The probe has experienced an over temperature condition. Please remove the probe from
the high temperature area.

No Tip No probe tip detected. Please install a compatible probe tip.

Tip Fault The probe tip has a fault. Please remove and replace the probe tip.

S-param Error during S-parameter transfer. Please reattach the probe. If the problem persists,

contact Tektronix Service.

History badge
The History badge is shown in the Results bar. Navigate the history acquisitions by using the Previous/Next or Play/Pause buttons.

Timestamp shows the time difference between the previous acquisition and the selected acquisition.

59 Acquisitions 59 Acquisitions
MAcq: 5 DAcq: 5
0.805 479992 320s || 0.805 479 992 320s

EIEN) (ESE.5

Badge readout Function Description

@ Previous The previous button takes you to the previous acquisition.

Table continued...

62




Getting acquainted with your instrument

Badge readout Function Description
Next The next button takes you to the next acquisition.
Play/Pause Acquisitions are played at the specified playback speed and begin from the
‘E currently selected acquisition. The Play button changes to a Pause button when

playback is active. Acquisitions are played until playback reaches the end of the
history. At this point, playback stops, and the Play button is grayed out.

@ Rewind The Rewind button takes you back to the acquisitions where you pressed the Play
button.

E Reset The Reset button takes you back to the first acquisition in the history. When you
are at the beginning of the history the button is grayed out.

The waveforms can be viewed in the graticule for the selected acquisitions from history badge. You can navigate the total number of
acquisitions in history. Double-tap a badge to open its configuration menu.

When Include Reference Acquisition in Badge is selected from the right click menu of the History badge, the badge displays the

following information:

59 Acquisitions 59 Acquisitions
Selected Acg Selected Acg
(NAcg: 5 DAca: 5
0.805 479992 320s || 0.805 479 992 320s
Reference Acq Reference Acq
(DAca: 1 DA 1
0.000 000 000 000s || 0.000 000 000 000s
Delta Delta
0.805 479 992 320s || 0.805 479 992 320s

- d heeee——

The Reference acquisition readout shows the timestamp when the acquisition occurred in time in history. It also displays the delta between
the Selected acquisition and the Reference acquisition timestamps.

There are two ways to delete the History badge.

+ Right-click the badge and select Disable Acquisition History.

+  Flick the badge off the right edge of the display to remove it from the Results bar. Flicking left from the right edge of the Results bar
recovers the badge. Badge recovery is only possible within 10 seconds of removal.

System badges

System badges (in the settings bar) display the main Horizontal, Acquisition, and Trigger settings. You cannot delete System badges.

Horizontal

1 ps/div 10 ps

RL: 31.25 kpts ¥ 50%

Trigger

(2 Runt
SR: 3.125 GS/s 320 psipt W s

U:2.28 L:800m

Acquisition
Auto, Analyze
High Res: 12 bits
10.379 kAcqs

Double-tap a System badge to open its configuration menu.

The Horizontal badge also has Scale buttons, shown by single-tapping the badge. Use the Horizontal Scale buttons to increase or
decrease the horizontal time setting.
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Common badge actions

Action Result Example
Single tap Immediate access controls (Scale,
Navigation).
Double tap Configuration menu with access to all |[FERAEE @

settings for the badge.
! EEXDDD

Set set
BEID A

PROBE SETUP. >

OTHER >

Turn Ch 3 Off

Touch and hold  |Right-click menu with single tap
access to common actions. Typical

Configure Ch 3.

actions include turning off a channel i >
and deleting a measurement or v :“Iw'd'h >
search badge. | P

Flick Flick the badge off the bottom edge of the display to remove it from the Settings bar.

Flick the badge off the right edge of the display to remove it from the Results bar.

Flick from the right or bottom edge to recover a removed badge. This action is only possible within 10 seconds of
badge removal.

Badge selection status

The appearance of a badge indicates its selection status (selected or unselected), or if a measurement needs to be deleted to close a
channel or waveform badge.

Badge type Selected Unselected Turned off or in use
Channel or
Waveform 1 Vidiv

1%

1GHz B

Table continued...

64




Getting acquainted with your instrument

Badge type Selected Unselected Turned off or in use
Measurement NA

Fall Ti

e ml_r;: ns Peak-to-Peak

U’ 6.840 V

Value: 10.2762 n

(<))

A dimmed Channel badge means the screen waveform is turned off (but not deleted). A dimmed Waveform badge means that the
waveform display is turned off, or it is being used as a source by a measurement and cannot be deleted until the measurement is deleted.

Moving waveform and measurement badges

You can move waveform and measurement badges within their display bars to meet your measurement needs. Simply touch and drag the
badge to a new position.

Moving waveform badges in the Settings Bar

A waveform badge can only be moved within the Settings Bar.
Dragging a waveform badge to a new location selects that waveform.

Dragging a badge to a new location causes the non-selected badges to move slightly to create the position at which to insert the
badge.

To move a badge to a position that is off screen of the displayed bar badges (scroll buttons are present), drag the badge that you're
moving onto one of the scroll buttons. The badges that are off screen shift onscreen one at a time until you move the badge off of the
scroll button and position it in the displayed badges.

Changing the order of waveform badges or badge groups also changes the order of displayed waveforms in the Waveform view. The
order of badges or badge groups (left to right) in the Settings bar determines the order of slices in the display (top to bottom).

Once you have moved any waveform badge (Channel, Math, Ref, Bus, Trend) on the Settings bar to a new position, adding a new
badge adds that badge to the right of the existing badges. This differs from the default badge addition action, which listed badges
together by category (Channels, Math, Ref, Bus) and arranged the badges in numerical order within each badge category. To restore
the default badge addition method, tap File > Default Setup and add the waveform badges back onto the Settings bar.

Changing the order of bus waveform badges changes the order of the tabs in a bus decode Results table.

Moving badges in the measurement Results Bar

A Measurement or Search badge can only be moved within the Results Bar.
Dragging a badge to a new location causes the non-selected badges to move to create the position at which to insert the badge.

Once you have moved any Results badge to a new position, adding a new Measurement or Search badge adds that badge to the
bottom of the Results bar badges.

To move a badge to a position that is off screen of the displayed bar badges (scroll buttons are present), drag the badge that you're
moving onto one of the scroll buttons. The badges that are off screen shift onscreen one at a time until you move the badge off of the
scroll button and position it in the displayed badges.

Changing the order of Measurement badges in the Results bar changes the order of measurements shown in a Results table.
Changing the order of Search badges in the Results Bar changes the order of the tabs shown in a Search Results table.
Changing the order of harmonics badges in the Results bar changes the order of the tabs shown in a Harmonics Results table.
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Badge grouping

You can group signal badges in the Settings bar to display multiple waveforms in a single slice. See Group signal badges in the Settings
bar on page 66 for more information. See the Group signal badges in the Settings bar topic.

Group signal badges in the Settings bar

You can group signal badges in any combination of channel, waveform, math, reference and bus badges to display related waveforms in
the same display slice. Use this feature to group related signals for easier visual comparisons.

200nsdiv 2
SR:6.25GS/s 160 ps/pt

RL 125kpts % 50%

To group one or more signal badges, drag a badge onto another badge until the background badge turns red, then release. Repeat to add
other badges to a group. Each group is shown in its own slice as a set of overlaid waveforms.
I H

Badge group characteristics

+ Badges in a group are listed left to right in the order they were added to the group.

+ The badge group color is the color of the last selected badge in the group.

+ Use standard touch and menu interactions to select and change individual badge settings.

+ You can drag and move badge groups the same way as individual badges.

+ The order of badges or badge groups (left to right) determines the order of slices in the display (top to bottom).

+ To ungroup a single badge, drag it vertically and release. You can also ungroup a single badge by touching and holding a badge in the
group to open its right-click menu, and select Ungroup Badge(x) to ungroup the selected badge.

+ To ungroup the entire group, touch and hold any badge in the group to open its right-click menu. Select to ungroup the selected badge
or ungroup all of the badges.

Badge group caveats

* You cannot drag badges within a group to change their order.
+ You cannot add one badge group to another.
* You cannot drag a badge group onto an individual badge to group those badges.
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+ You cannot drag a badge group onto the Trash icon to ungroup or delete those badges.

Configuration menus

Configuration menus let you quickly set the parameters for channels, system settings (Horizontal, Trigger, Acquisition), measurements,
cursor readouts, Waveform and Plot views, callout text, and so on.

Double-tap an item (badge, Waveform View or Plot View, cursor readouts, callout text, and so on) to open its configuration menu. For
example, double-tap a Channel badge in the Settings Bar to open its configuration menu.

CHANNEL 1 @

3578011

Selections or values that you enter take effect immediately. Menu contents are dynamic, and can change depending on your selections,
instrument options, or attached probes.

Related settings are grouped into 'panels'. Tap the panel name to show those settings. Changes to panel settings can change the values
and/or fields shown in that panel and other panels.

VERTICAL SETTINGS >

Compensate Probe

OTHER >

Tap anywhere outside a configuration menu to close it.

To open Help content for a configuration menu, tap the question mark icon in the upper right corner of the menu.
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Zoom user interface

Use the zoom tools to magnify waveforms to view signal details.

©® ®

3579-006

. The Zoom Overview shows the entire waveform record. All waveforms are shown in Overlay mode in the Zoom Overview area. Using

pinch and expand gestures on the Zoom Overview waveforms changes the horizontal time base settings.

The Zoom Box shows the area of the Zoom Overview to display in the Zoom View (see 5). You can touch and drag the box to move
the area to view. Moving the Zoom Box, or changing its position, does not change the horizontal time base settings. You can also use
the zoom Pan knob to move the Zoom Box left or right.

3. The Zoom icon (in the upper right corner of the Waveform View) switches zoom mode on and off.
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The DRAW-A-BOX button toggles between drawing a zoom box (default mode), drawing areas for the Visual Trigger function,
drawing segments for Mask testing, and drawing the Waveform Histogram for waveform analysis. The button is located at the bottom
of the Results Bar.

A zoom box lets you quickly draw a box around an area of interest in the Waveform or Zoom Overview. Drawing a box immediately
puts the oscilloscope into zoom mode. To draw a zoom box, tap the DRAW-A-BOX button (while in Zoom mode), then touch and drag
on the waveform to draw a box waveform. You can continue to draw zoom boxes until you single tap anywhere on the screen or open a
menul.

To toggle between Zoom mode, Visual Trigger mode, and Mask mode, double-tap the DRAW-A-BOX button and select one of the
options. Search for the Visual Trigger and Mask Testing topics in the oscilloscope Help for more information.

The Zoom View shows the zoomed waveforms, as marked by the Zoom Box, in the Zoom Waveform Record View. Use pinch and/or
drag options in the zoom view to change the zoomed area of interest. Pinch, expand, and drag gestures in the Zoom View only change
zoom magnification settings and Zoom Box position.

Use the Zoom Title Bar controls to adjust the vertical and horizontal size of the zoom area. Click or tap the + or - buttons or use the A
and B multipurpose knobs.
zoitial 2ot el B3 () (6.33x z00m)  Vertical Zoor

In a waveform view, if both Cursor and Zoom are turned on, use the Zoom Box and Cursors button to change the multipurpose knob
functionality. Tap the Zoom Title Bar to assign the knobs to adjust the zoom or tap the Cursors button to assign knobs to adjust the
Cursors.

Double tap the Horizontal Zoom Position or Horizontal Zoom Scale fields to enter a value using a numerical keypad.
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To exit the zoom display mode, tap the Zoom icon in the corner of display or tap the X in the Zoom Title Bar.

Using the touch screen interface for common tasks

Use standard touch screen actions, similar to those found on smart phones and tablets, to interact with most screen objects. You can also
use a mouse to interact with the Ul. The equivalent mouse operation is shown for each touch operation.

The oscilloscope has a user interface tutorial. Tap Help > User Interface Tutorial to quickly learn the fundamental touch operations.

Table 2: Common touchscreen Ul tasks with mouse equivalents

Task

Touchscreen Ul action

Mouse action

Add a channel, math, reference, or
bus waveform to the screen.

Tap an inactive channel button, Add New Math,
Add New Reference, or Add New Bus button.

Click an inactive channel button, Add New Math,
Add New Reference, or Add New Bus button.

Select a channel, math, reference,
or bus waveform to make it active

Stacked or Overlay mode: Tap the Channel or
Waveform badge.

Stacked or Overlay mode: Left-click the Channel
or Waveform badge.

Stacked mode: Tap the channel, math,
reference, or bus waveform slice or handle.

Stacked mode: Left-click the channel, math,
reference, or bus waveform slice or handle.

Overlay mode: Tap the channel or waveform
handle.

Overlay mode: Left-click the channel or
waveform handle.

Display scale or navigation
buttons on a badge (waveform,
measurement, search, horizontal).
Not all measurement or search
badges display navigation buttons.

Tap the badge.

Click the badge.

Open a configuration menu on
any item (all badges, views, cursor
readouts, labels, and so on).

Double-tap the badge, view, or other object.

Double-click the badge, view, or other object.

Open a right-click menu (badges,
views).

Touch and hold on the badge, Waveform View,
Plot view, or other screen item until a menu
opens.

Right-click the object.

Close a configuration menu. Some
dialog boxes will not close until you
click an OK, Close, or other button
in the dialog.

Tap anywhere outside the menu or dialog.

Click anywhere outside the menu or dialog.

Move a menu.

Touch and hold the menu title bar or a blank area
in the menu, then drag the menu to new position.

Click and hold the right mouse button on title or
blank area, drag to new position.

Move a callout. Callouts are screen
objects and are not associated with
any particular waveform channel or
slice.

Touch and hold on a callout and quickly start to
drag, then move to new position. Start to move
the callout as soon as selected (highlighted),
otherwise the Ul opens the right-click menu.

Click and hold the right mouse button on the
callout and quickly start to drag, then move to the
new position.

Change horizontal or vertical
settings directly on a waveform.
Vertical changes only apply to

the selected channel or waveform;
horizontal changes apply to all
channels and waveforms.

Tap a badge and use the Scale buttons.

Touch and hold two fingertips on the waveform
view, move them together or apart vertically or
horizontally, lift from screen; repeat.

Left-click a channel, waveform, or Horizontal
badge and click on the Scale buttons.

Table continued...
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Task Touchscreen Ul action Mouse action

Increase or decrease the zoom area | Touch and hold two fingertips on the waveform | Click the + or - buttons on the Zoom Title bar.

while in Zoom mode. view, move them together or apart vertically or

' X Click the Draw-a-Box button, draw a box around
horizontally, lift from screen; repeat.

the waveform area of interest.

Quickly scroll or pan a waveform or | Touch and drag in the waveform or list. Click and drag in the waveform or list.
list.
Close or open the Results Bar to | Tap on the Results Bar Handle (three vertical | Click the Results Bar Handle (three vertical dots
increase the Waveform View area. |dots in border) or anywhere in the border in border) or anywhere in the border between the
between the Waveform View and the Results ~ |Waveform View and the Results Bar.
Bar.

Click and drag the Results Bar divider.

Change the position of badges in | Touch and drag the badge to a new position in | Click and drag the badge to a new position in the
the Settings Bar or Results Bar.  |the same bar. same bar.

Accessing application help

Use the instrument online help to quickly get information about a function or assistance in performing a task.

Using context-sensitive help

To access the user interface on a Low Profile instrument, connect a monitor to a video port on the rear of the instrument, and connect a
mouse to any USB Host port. You do not need to connect a mouse if your remote monitor is touch-capable. You can also remotely access
the user interface of a network-connected instrument by entering the instrument's IP address in a web browser.

To open help on a particular menu or item, tap the Help button (question mark symbol) in the title bar. The browser opens with content
relevant to the menu or item.

Navigating the online help
Select Help > Help. The Help Browser is similar in look and feel to PC-based Help tools.

Note: The Help tool does not have a virtual keyboard. Connect a keyboard to your instrument to enter text in the search fields of
the Search or Index tabs.

From the help browser, select one of the following tabs:

+ Contents Tab. Click any entry to display information on the subject.

+ Search Tab. Type in the keyword you are looking for; then click List Topics. Every topic that contains the keyword will be displayed.
Select a topic, and then click Display to open the topic.

Other help features

Zoom on help text. Use the magnifying glass icons to zoom in or out of the help text.

ESD Prevention Guidelines

Electrostatic discharge (ESD) can damage oscilloscope and some probe inputs. This topic discusses how to avoid this type of damage.

Electrostatic discharge (ESD) is a concern when handling any electronic equipment. The instrument is designed with robust ESD
protection, however it is still possible that large discharges of static electricity directly into the signal input may damage the instrument. Use
the following techniques to prevent electrostatic discharge from damaging the instrument.
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+ Discharge the static voltage from your body by wearing a grounded antistatic wrist strap while connecting and disconnecting cables,
probes, and adapters. The instrument provides a ground connection to which to attach a wrist strap (on the Probe Comp ground
connector).

« Acable that is left unconnected on a bench can develop a large static charge. Discharge the static voltage from all cables before
connecting them to the instrument or device under test by momentarily grounding the center conductor of the cable, or by connecting a
50 Q termination to one end, before attaching the cable to the instrument.

+ Before you apply power, connect the instrument to an electrically-neutral reference point, such as earth ground. To do this, plug the
three-pronged power cord into an outlet grounded to earth ground. Grounding the oscilloscope is necessary to ensure safety and to
take accurate measurements.

+ If you are working with static sensitive components, ground yourself. Static electricity that builds up on your body can damage
static-sensitive components. Wear a wrist strap to safely send static charges on your body to earth ground.

+ The oscilloscope must share the same ground as any circuits that you plan to test.
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Configure the instrument

Configurations to help operate your instrument efficiently.

Set the time zone and clock readout format

Set the time zone to your region so that saved files are marked with the correct date and time information. You can also set the time format
(12 or 24 hour clock).

About this task

To access the user interface on a Low Profile instrument, connect a monitor to a video port on the rear of the instrument, and connect a
mouse to any USB Host port. You do not need to connect a mouse if your remote monitor is touch-capable. You can also remotely access
the user interface of a network-connected instrument by entering the instrument's IP address in a web browser.

To remotely set a control or run this task on a Low Profile instrument, see the instrument Programmer Manual (Tektronix part number
077-1305-xx) for the correct command or commands to use.

Procedure

DATE AND TIME

o
Hour  Hour

Pacific Standard Time v

L

1. Double-tap the Date/Time badge (bottom-right of screen) to open the configuration menu.

2. To turn off showing the date and time on the screen, tap Display button to Off.
To turn on date/time display again, double-tap in the blank area where the date/time badge was displayed to open the configuration
menu, and set the Display button to On.

3. Select a time format (12 Hour or 24 Hour).
4. Tap the Time Zone field and select the time zone that applies to your location.
5. Tap anywhere outside of the menu to close it.

Functional check
Use this procedure to quickly verify that the oscilloscope can display a waveform and take a measurement.

To access the user interface on a Low Profile instrument, connect a monitor to a video port on the rear of the instrument, and connect a
mouse to any USB Host port. You do not need to connect a mouse if your remote monitor is touch-capable. You can also remotely access
the user interface of a network-connected instrument by entering the instrument's IP address in a web browser.

To remotely set a control or run this task on a Low Profile instrument, see the instrument Programmer Manual (Tektronix part number
077-1305-xx) for the correct command or commands to use.

1. Power on the oscilloscope.

2. Tap Utility > Self test. Check that all tests listed show Pass.

3. Connect an analog probe to the Channel 1 connector.

4.  Connect the oscilloscope tip and ground lead to the probe compensation connectors.

5.  Push the Autoset button. You should see a square wave in the display (approximately 5V p.p).
6. Tapthe Add New...Measure button.
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Tap the Timing Measurements panel in the Add Measurements configuration menu.
Double-tap the Frequency button to add the frequency measurement to the Results bar.
Check that the Frequency measurement reads 1 kHz.

10. Repeat these steps to check the other channels on the oscilloscope. Make sure that you set the source in the Add Measurement
configuration menu to use the correct channel before adding the Frequency measurement.

Download and install the latest instrument firmware

Installing the latest firmware helps ensure that your instrument has the latest features and is taking the most accurate measurements.

Before you begin

Save any important on-instrument files (waveforms, screen captures, setups, and so on) to a USB drive or network. The installation
process does not remove user-created files, but it is a good idea to back up important files before an update.

To access the user interface on a Low Profile instrument, connect a monitor to a video port on the rear of the instrument, and connect a
mouse to any USB Host port. You do not need to connect a mouse if your remote monitor is touch-capable. You can also remotely access
the user interface of a network-connected instrument by entering the instrument's IP address in a web browser.

Procedure

1. Power on the oscilloscope.
2. Determine the current version of firmware installed on the instrument in the About window under the Help menu

3. Check the version of the latest available firmware at the tek.com/software. Enter the model number of your oscilloscope in the search
box and search for the firmware.
If the firmware version on the web is newer than what is currently installed, update your instrument firmware.

4. Install the firmware on embedded OS instruments.
a) Download the latest firmware and unzip the files on your PC.

For the MSO44 and MS046 (non-B version), follow the installation instructions that came with the downloaded firmware to create
the firmware install file or files.

b) Copy the designated firmware file into the root folder of a USB flash drive.

c) Insertthe USB flash drive into a USB port on your oscilloscope. The instrument automatically recognizes the firmware install file
and starts the installation process.

For the MSO44 and MS046 (non-B version), follow the instructions that came with the downloaded firmware to install the firmware.
d) Follow any on-screen instructions. The oscilloscope take about 10 minutes to install the new firmware.

Do not remove the USB flash drive or power off the instrument during this time.
e) After the oscilloscope displays a message that it has completed the upgrade, the scope will reboot automatically.

For the MSO44 and MS046 (non-B version), you must manually power off the instrument after installation. Remove the USB from
the MS044 and MS046 while the instrument is powered off.

5. Install firmware on instruments with the Windows option.
a) Close TekScope before updating the firmware.
Insert the USB drive into an instrument USB Host port.
Open the Windows desktop File Explorer and select the install file.
Run the firmware update file from the USB drive, or copy the firmware update file to the desktop and run the file from there.
Follow the on-screen instructions to install the firmware.
Do not remove the USB flash drive or power off the instrument during this time.
f)  When the firmware install is finished, remove the USB drive and restart the instrument.
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What to do next

To confirm the firmware update, locate the version number found in the About window under the Help menu. Confirm that the instrument
firmware version number matches the firmware version number that you just installed.

Run Signal Path Compensation (SPC)

Run SPC when you first receive an instrument, and at regular intervals, for best measurement accuracy. You should run SPC whenever
the ambient (room) temperature has changed by more than 5 °C (9 °F), or once a week if you use vertical scale settings of 5 mV per
division or less.

About this task

To access the user interface on a Low Profile instrument, connect a monitor to a video port on the rear of the instrument, and connect a
mouse to any USB Host port. You do not need to connect a mouse if your remote monitor is touch-capable. You can also remotely access
the user interface of a network-connected instrument by entering the instrument's IP address in a web browser.

Signal Path Compensation (SPC) corrects for DC level inaccuracies in the internal signal path, caused by temperature variations and/or
long-term signal path drift. Failure to run SPC on a regular basis may result in the instrument not meeting warranted performance levels at
low volts per division settings.

Before you begin

Disconnect all probes and cables from the front-panel channel inputs and rear-panel signal connectors.

Note: You do not need to disconnect input signal cables from an LPD64 to run SPC. The LPD64 has a new unique input isolation
capability that lets you keep signal cables connected during SPC.

Procedure

1. Power on and warm up the instrument for at least 20 minutes.

2. Tap Utility > Calibration.

3. Tap Run SPC. The SPC Status readout shows Running while SPC is running. SPC can take three minutes approximately per channel
to run, so wait until the SPC Status message changes to Pass before reconnecting probes or cables and using the instrument.

CAUTION: You can abort the SPC calibration by tapping Abort SPC. This may leave some channels uncompensated,
resulting in possible inaccurate measurements. If you do abort the SPC, make sure to run the SPC procedure completely
before using the instrument to take measurements.

4. Close the Calibration configuration dialog when SPC has completed.

If the SPC fails, write down any error message text. Make sure that all probes and cables are disconnected (except for the LPD64) and
run the SPC again. If the SPC still fails, contact Tektronix Customer Support.

Compensate the TPP Series probes
Probe compensation adjusts the high frequency response of a probe for best waveform capture and measurement accuracy. The
oscilloscope can automatically test and store compensation values for an unlimited number of probe/channel combinations.

About this task

To access the user interface on a Low Profile instrument, connect a monitor to a video port on the rear of the instrument, and connect a
mouse to any USB Host port. You do not need to connect a mouse if your remote monitor is touch-capable. You can also remotely access
the user interface of a network-connected instrument by entering the instrument's IP address in a web browser.
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To remotely set a control or run this task on a Low Profile instrument, see the instrument Programmer Manual (Tektronix part number
077-1305-xx) for the correct command or commands to use.

A Note: Probe compensation does not apply to the LPD64 instrument.

The oscilloscope stores the compensation values for each probe/channel combination, and automatically recalls the compensation values
when you plug in the probe. Probe compensation status is shown in the Probe Setup panel of the Channel configuration menu.
+ Ifthe Probe Compensation Status field displays Pass, the probe is compensated and ready for use.

+ If the Probe Compensation Status field displays Default, the attached probe has not been compensated and needs to have this probe
compensation procedure run.

+ Ifthe Probe Compensation Status field displays Fail, the attached probe has failed the probe compensation procedure. Reconnect the
probe and run probe compensation again.

+ Ifthere is no probe compensation status field shown in the panel, the oscilloscope cannot store compensation values for that probe.
See the oscilloscope Help for how to manually compensate passive probes not supported by the probe compensation function.

Before you begin

The oscilloscope must be powered on for at least 20 minutes before compensating a probe.

Procedure
Use this procedure to compensate supported TPP-family probes that show a Default status when connected to the oscilloscope.

Note: Doing a Default Setup does not delete probe compensation values. A factory calibration does delete all stored probe
compensation values.

3644-010
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. Connect a supported probe to an input channel.
2. Connect the probe tip and ground lead of the probe to the PROBE COMP terminals.

A Note: Connect only one probe at a time to the PROBE COMP terminals.

3. Turn off all channels.
Turn on the channel to which the probe is connected.

Push the front-panel Autoset button. On the MSOS58LP, select File > Autoset from the menu bar. The screen displays a square
wave.

Double-tap the badge of the channel that you want to compensate.

Tap the Probe Setup panel.

If the Probe Compensation Status says Pass, the probe is already compensated for this channel. You can move the probe to another
channel and start again from step 1, or connect a different probe to this channel and start from step 1. If the Probe Compensation
Status says Default, continue with this procedure.

Tap Compensate Probe to open the Probe Compensation dialog.
9. Tap Compensate Probe to run the probe compensation.

10. The probe compensation is finished when the Probe Compensation Status displays Pass. Disconnect the probe tip and ground from
the PROBE COMP terminals.

11.  Repeat these steps for each supported passive probe that you want to compensate for this channel.
12. Repeat these steps to compensate supported probes on other channels of the oscilloscope.

Note: For most accurate measurements, open the Probe Setup panel and verify the Probe Compensation Status is Pass
whenever you attach a probe to a channel.

Compensate passive probes

Probe compensation adjusts the high frequency response of a probe for best waveform capture and measurement accuracy. Use this
procedure to adjust probe compensation for probes with a manual adjustment.

To access the user interface on a Low Profile instrument, connect a monitor to a video port on the rear of the instrument, and connect a
mouse to any USB Host port. You do not need to connect a mouse if your remote monitor is touch-capable. You can also remotely access
the user interface of a network-connected instrument by entering the instrument's IP address in a web browser.

To remotely set a control or run this task on a Low Profile instrument, see the instrument Programmer Manual (Tektronix part number
077-1305-xx) for the correct command or commands to use.

A Note: Probe compensation does not apply to the LPD64 instrument.

A passive probe is only adjusted for one channel at a time. If you move a passive probe to another channel, you must compensate that
probe to that channel.

Connect the probe to the channel where you want to use it to take measurements. Remove all other probes.

Turn on the channel to which the probe is connected. Turn off all other channels.

Attach the probe tip and reference lead to the probe compensation connectors.

Push the Autoset button to display a square wave.

Adjust the vertical Scale and Position knobs to display as large a waveform as possible.

Use the adjustment tool provided with the probe to adjust the probe until the square wave has as flat a top as possible. See your probe
manual for adjustment location and instructions.

L S
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Connect to a network (LAN)

Connecting to a network allows you to remotely access the instrument.

To access the user interface on a Low Profile instrument, connect a monitor to a video port on the rear of the instrument, and connect a
mouse to any USB Host port. You do not need to connect a mouse if your remote monitor is touch-capable. You can also remotely access
the user interface of a network-connected instrument by entering the instrument's IP address in a web browser.

Work with your network administrator to obtain the required information to connect to your network (IP address, Gateway IP address,
Subnet Mask, DNS IP address, and so on).
1. Connect a CAT5 cable from the instrument LAN connector to your network.
2. Select Utility > 1/0 on the menu bar to open the 1/O configuration menu.
3. Obtain or enter the network address information:
+  If your network is DHCP-enabled, and the IP address field does not already show an address, tap Auto to obtain the IP address
information from the network. DHCP mode is the default mode.

+ If your network is not DHCP-enabled, or you need a permanent (non-changing) IP address for this instrument, tap Manual and
enter the IP address and other values provided by your IT or system administrator resource.

4, Tap Test Connection to verify that the network connection is working. The LAN Status icon turns green when the instrument
successfully connects to your network. If you have problems connecting to your network, contact your system administration resource
for help.

The front panel LAN status LED colors display the network connection status:
+  Off: No power to the instrument

+  Green: Network connection is good
+ Red: Network connection has a fault or is not connected

Mount a network drive from a standard instrument

Use this procedure to mount (map) a network Linux mount point or Windows shared directory on a standard (non Windows OS)
instrument.

Prerequisites: The oscilloscope must be connected to a network that has access to the directories to mount or unmount. See Connect to
a network (LAN) on page 77.

To mount a Linux network drive on the oscilloscope, the network Linux mount point (drive, host) that you want to mount must be exported.
If the mount point is not exported, work with your organization's IT resource to get that location exported and accessible to your network.

To mount a Windows network drive on the oscilloscope, the network Windows directory location that you want to mount must be set to
shared. If the Windows directory is not shared, work with your organization's IT resource to get that location shared and accessible to your
network.

To mount a network drive on your standard oscilloscope:
1. Tap File > File Utilities.
. Tap Mount to open the Mount Drive menu.

2
3. Select Network in the Drive Type.
4. Select the drive letter to assign to the network drive from the Drive Letter list.
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5. Tap Name or IP to specify how you will enter the host name (server) of the network mount location or PC.

6. Enter the network host name or IP address of the Linux mount point or Windows PC or server in the Server Name or Server IP
Address field. Example: ACME-PC0205

7. Enter the path to the location of the mount point or shared directory of the server in the Path field.

Linux example: /opt/testing/batch1 (Linux requires forward slashes in path definitions. Linux assumes that the path starts at the root
directory.

+ Linux example: /opt/testing/batch1 (Linux requires forward slashes in path definitions. Linux assumes that the path starts at the root
directory.)

+  Windows example: \Users\adamt\Desktop\testing\batch1 (Windows requires back slashes in path definitions. The double back
slashes (\\) denotes the root directory as the starting point for locating the specified directory.)

8. Ifaccess to this network location is controlled, enter the required information in the User Name, Password, and Domain/Workgroup
fields.

9. Tap OK. The oscilloscope mounts the drive and adds the specified drive letter to the Drive column in the File Utilities menu.

The oscilloscope displays an error message if it cannot mount the drive. Work with your organization's IT resource to verify that the
access information is correct and to resolve the network access problems.

A CAUTION: The Linux ScopeApp does not support SMB version 1.0 for CIFS network mounts.

Mount a network drive on the Windows 10 instrument

Use this procedure to mount (map) a network Linux mount point or Windows shared directory on a Windows OS instrument. Use the
network drive to store or access files from the oscilloscope.

Prerequisites: The oscilloscope must be connected to a network that has access to the directories to mount or unmount.
See Connect to a network (LAN) on page 77.

The oscilloscope must be added to your organization's network domain to mount network drives and be set to enable network discovery.
Work with your organization's IT resource to configure the instrument.

To mount a Linux network drive on the oscilloscope, the network Linux mount point (drive, host) that you want to mount must be exported.
If the mount point is not exported, work with your organization's IT resource to get that location exported and accessible to your network.

To mount a Windows network drive/folder on the oscilloscope, the network Windows folder location that you want to mount must be set
to shared. If the Windows folder is not shared, work with your organization's IT resource to get that folder shared and accessible to your
network.

To mount a network folder on your Windows OS oscilloscope:

Tap File > File Utilities to open the file utilities window.

Select Network in the Drive Type.

Click on Open File Explorer to open the windows explorer window.

Tap This PC in the path field to move to the This PC directory.

Tap and hold the This PC text on the left side of the pane to open the context menu.
Tap Map Network Drive to open the Map Network Drive menu.

Use standard Windows practices to set the drive letter and specify the path to the network folder. If access to the specified folder has
security settings, you must enter the correct user and password information when requested.

8. The network folder is added to This PC > Devices and Drives listing.

N o gk~ ooDbd =

If you have problems accessing a network folder, work with your organization's IT resource to verify that the folder is shared and that
you are using the correct user name and password.

78



Configure the instrument

Mount TekDrive

TekDrive is a collaborative T&M data workspace provided with the purchase a supported Tektronix product.

Before you begin

This mounting procedure is applicable for both Windows and LINUX platforms. You must have internet connectivity access to perform this
procedure.

Browse to drive.tekcloud.com, register, and create a new account.

+ The TekDrive mount feature is supported on 4/5/6 Series MSO instruments.
+  The maximum upload file size limit to TekDrive is restricted to 25 GB.
+  When the TekDrive is enabled, you cannot copy and paste for files and folders in the TekDrive.

+ In some scenarios, recalling the files from the TekDrive is not supported and you will not see it listed in the file browser, but you can
continue recalling the file through USB/Network or Local drives. For example, Math Filter files cannot be recalled/applied from the Math
advanced menu if it is stored in the TekDrive.

+  When a TekDrive is unmounted or auto-disconnected, the waveform files activated from it would continue to work until you recall the
defaults, run TekSecure®, or change the reference waveform file.

About this task

Use TekDrive to upload, store, organize, search, download, and share arbitrary files from any connected device. Use the following
procedure to mount (map) a TekDrive.

Procedure

Tap File > File Utilities.

Tap Mount to open the Mount Drive menu.

Select the TekDrive button under Drive Type

Enter the Drive Name.

Select the required Auto Disconnect option.

Tap Connect to TekDrive to display the window with the QR and numeric code for TekDrive activation.

Browse to drive.tekcloud.com/activate to login using your credentials and enter the numeric code displayed in the Mount Drive window.
Register and create a new account if you are a new user.

A message is displayed when activation is successful.

8. After activation, click OK, mount Tekdrive to complete the mounting process.
The connected TekDrive is available in all file browsing windows.
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Unmount a network drive from a standard instrument
Use this procedure to unmount (remove, disconnect) a network Linux mount point from a standard (non-Windows 10) instrument.
To unmount a network drive from your instrument;

1. Tap File > File Utilities.
2. Select the drive to unmount in the Drive column.
3. Tap Unmount. The instrument immediately unmounts the drive and removes it from the Drive column.
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Unmount a network drive from the Windows 10 instrument
Use this procedure to unmount (remove, disconnect) a network drive from a Windows 10 instrument.
To unmount a network drive from your Windows 10 instrument:

1. Open Windows Explorer window.

Tap This PC in the list to move to the This PC directory.

Select the network drive/folder to unmount.

Tap and hold, or right/click, the selected drive to open a context menu.

Tap Disconnect to unmount the drive. the drive is immediately removed from the list.

o oD

Unmount a TekDrive

Use this procedure to unmount (remove, disconnect) a TekDrive.

Procedure
1. Tap File > File Utilities.
2. Select the TekDrive to unmount in the Drive column.

3. Tap Unmount.
The drive is unmounted and it is removed from the Drive column.

Connect the oscilloscope to a PC using a USB cable
Use a USB cable to connect the oscilloscope directly to a PC for remote instrument control.

1. On the oscilloscope, select Utility > 1/O from the menu bar.

2. Tap USB Device Port Settings.

3. Confirm that the USB Device Port control is On (default setting).

4. Connect a USB cable from the PC to the USB Device port on the instrument.
5

. If using the USB connection to remotely control the oscilloscope using GPIB commands, set the GPIB Talk/Listen Address for your
configuration (0 - 30).

Remote access from a Web browser

You can remotely access your network-connected standard instrument (not running Windows) from a Web browser to display the
instrument user interface on a PC.

This procedure describes how to remotely access the Ul controls and screen for standard (non Windows 10) instruments. To remotely
access the Ul controls and screen for Windows 10 instruments, see the Remote access to a Windows 10 instrument topic in the Help.

Prerequisites:

+ The instrument must be connected to, and accessible from, the network to which the PC is connected. See Connect to a network
(LAN) on page 77

+ The IP address of the instrument that you want to access. To determine the instrument's IP address, select Utility > 10 in the
instrument menu bar and view the network settings in the LAN panel.

+ You are accessing a standard (instrument that does not have the Windows OS option installed).

80



Configure the instrument

Use below procedure to remotely access the Ul controls and screen for standard (non Windows 10) instruments using e*Scope®
functionality.

1.
2.

A An internal error has occurred within the Tek e*Scope server, and

Open a Web browser on a PC connected to the same network as the instrument.

Enter just the instrument IP address on the URL line of the browser and press Enter. For example: 135.62.88.157. The browser
searches for and opens the Web page for the instrument.

Select Instrument Control (e*Scope). The browser displays the instrument screen. If a password is set for the e*Scope, an Enter
Password window will popup. Enter the password and tap Submit. If the password is input incorrectly five times, it will block the
e*Scope for five minutes.

Use a mouse to select and interact with the instrument controls shown in the Web browser. If your remote PC or laptop has a touch
screen monitor, you can use the remote touchscreen monitor to access the instrument controls.

Close the browser to logout the session.

Note: If connection error occurs, refresh the page in the web browser or restart the web browser for seamless interaction with the
instrument remotely.

CONNECTION ERROR

the connection has been terminated. If the problem persists,
please notify your system administrator, or check your system logs.

When you access the instrument from an e*Scope browser, you cannot directly paste text (such as path, IP address information, and so
on) from the PC to an instrument menu field. You must use an intermediate clipboard function that is available in the e*Scope application.
Use the following steps to copy text from an e*Scope-connected PC to the instrument:

1.

~N

Open a connection to the instrument using e*Scope.

2. Select and copy the text on your PC.

3. Ine*Scope, press Ctrl-Alt-Shift to open the Clipboard menu.
4,
5
6

Paste the text into the Clipboard field.

. Press Ctrl-Alt-Shift to close the browser Clipboard menu.
. Use e*Scope to open the instrument menu to which to paste content, and position the cursor in the field where you want to paste the

text.
Press Ctrl-V (on real keyboard or from virtual keyboard) to paste the text from the e*Scope browser clipboard to the menu field.
Repeat steps 2 on page 81 through 7 on page 81 to copy and paste other text from the PC to the instrument.

Remote access to a Windows 10 instrument

Access to the graphical interface of a Windows 10 instrument requires installing software called TightVNC on both the PC and the
oscilloscope. This procedure describes how to use TightVNC to access the instrument Ul, and has links to the procedures to install
TightVNC on the PC and the instrument.

A Note: This procedure does not apply to 4 Series MSO instruments.

Prerequisites:
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The oscilloscope must be connected to, and accessible from, the network to which the PC is connected. See Connect to a network
(LAN) on page 77

The IP address or hostname of the oscilloscope that you want to access. Select Utility > 10 in the oscilloscope menu bar and view the
network settings in the LAN panel.

TightVNC software must be installed on both the Windows 10 oscilloscope and the PC used to remotely access the oscilloscope. See
Install TightVNC on the Windows 10 instrument on page 82 and Install TightVNC on a PC on page 83.

On the PC, run the TightVNC Viewer application. If it is not on the Task Bar or the Startup menu, use the search window in the Start
menu to locate the TightVNC Viewer application.

A Note: Make sure that you select the TightVNC Viewer application. Do not select the TightVNC Server application.

2. Enter either the oscilloscope IP address or hostname in the New TightVNC Connection dialog and click Connect.
3. Ifan access password was set in the oscilloscope TightVNC Server, enter that password and click OK. The TightVNC Viewer opens

and displays the oscilloscope screen.
To close the TightVNC viewer, click the X button in the upper right corner of the application.

Install TightVNC on the Windows 10 instrument

The TightVNC Server application enables a PC to connect to and display the Windows 10 oscilloscope Ul on the PC. You must install the
TightVNC software on both the PC and the Windows 10 oscilloscope. This procedure describes how to install the software on the Windows
10 oscilloscope.

1.
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10.
1.

12.
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Download the TightVNC software:

a. Open a web browser and navigate to www.tightvnc.com.

b. Under the Download TightVNC for Windows (Version 2.8.8) heading, click Installer for Windows (64 bit).
c. Click Save File in the dialog box to save the .MSl file to your PC.

d. Close the browser.

Navigate to where you saved the TightVNC installation file.

Copy the .MSl file to a USB memory device.

Attach the USB memory device to the Windows 10 oscilloscope.

Minimize the oscilloscope screen to display the desktop.

Use the Windows Explorer to navigate to and select the .MSl installation file on the USB device.

Right-click on the installation file and select Install.

Follow the on-screen instructions. Select Typical for the installation, leave all other settings at their default settings. Click Next when
prompted.

Click Install.
Click Yes to allow software changes to the PC.

For best security, create user and administrator passwords for accessing the TightVNC Server from the TightVNC Viewer. The User
password will be required whenever logging into the oscilloscope with the TightVNC Viewer.

Click Finish. The oscilloscope is now ready to enable connection from the TightVNC Viewer. See Remote access to a Windows 10
instrument on page 81.
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Install TightVNC ona PC

The TightVNC Viewer application connects the PC to the Windows 10 oscilloscope to display the oscilloscope Ul on the PC. You must
install the TightVNC software on both the PC and the Windows 10 oscilloscope. This procedure describes how to install the software on
the PC.

1. Download the TightVNC software:

a. Open a web browser and navigate to www.tightvnc.com.
b. Under the Download TightVNC for Windows (Version 2.8.8) heading, click Installer for Windows (64 bit).
c. Click Save File in the dialog box to save the .MSl file to your PC.
d. Close the browser.
2. Navigate to where you saved the TightVNC installation file.
. Right-click on the installation file and select Install.

Follow the on-screen instructions. Select Typical for the installation, leave all other settings at their default settings. Click Next when
prompted.

Click Install.
Click Yes to allow software changes to the PC.
Select Do Not Change for both password fields in the Set Passwords dialog box.

Click Finish. The PC is now ready to connect to a Windows 10 oscilloscope that has TightVNC software installed on it. See Remote
access to a Windows 10 instrument on page 81.
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Deskew analog input channels

Critical Timing measurements on multiple channels require that all probes be adjusted, or deskewed, to compensate for signal timing
differences between probes.

To access the user interface on a Low Profile instrument, connect a monitor to a video port on the rear of the instrument, and connect a
mouse to any USB Host port. You do not need to connect a mouse if your remote monitor is touch-capable. You can also remotely access
the user interface of a network-connected instrument by entering the instrument's IP address in a web browser.To remotely set a control
or run this task on a Low Profile instrument, see the instrument Programmer Manual (Tektronix part number 077-1305-xx) for the correct
command or commands to use.

Note: Once probes have been deskewed for a particular channel, you should only use the probes on the channels for which they
were deskewed, when taking critical Timing measurements.

Measurement method
Use the following procedure to more accurately minimize timing differences between probes.

1. Connect all probes that you want to deskew to the oscilloscope.

Connect up to four probe tips and ground leads to the Probe Compensation connector (maximum of four channels at a time).
Turn on all the channels of the first four channels that you want to deskew.

Push the Autoset button.

Change the vertical Scale of all active channels to 500 mV/div and adjust the vertical Position so that the waveforms are centered in
their respective slices.

Determine the channel you want to use as your reference.
Tap the Add New...Measure button and tap the Timing Measurements panel.

8.  Select the Delay measurement and set your chosen reference channel as Source 1 and your channel being deskewed as Source 2,
then tap the Add button.

2
3.
4.
5

N o
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9.  Double-tap the Channel badge of the channel being deskewed (Source 2) and tap the Other panel.

10. Tap the Deskew field and use the multipurpose knob to align this channel with the reference waveform such that the measured delay

between channels becomes a minimum. For fine adjust, double-tap the Deskew field to open a number pad.
11.  Double-tap the Delay measurement badge and set the Source 2 channel to the next channel to deskew.
12. Repeat steps 9 through 11 for each additional channel you want to deskew in the first set of four.
13. To deskew additional channels:

a. Disconnect all probe tips except the reference probe from the Probe Compensation connections.
b. Connect up to three probe tips and ground leads to the Probe Compensation connector (maximum of four channels at a time).
c. Repeat steps 3 through 13 for the additional channels to deskew.

Quick visual method
Use the following procedure to visually align waveform edges to compensate for timing differences between probes.

Connect all probes that you want to deskew.

Connect up to four probe tips and ground leads to the Probe Compensation connector (maximum of four channels at a time).
Turn on (display on screen) the connected channels that you want to deskew.

Double-tap in the Waveform view and set Waveform Mode to Overlay.

Push the Autoset button.

Adjust the vertical Scale and Position controls for each channel so that the signals overlap and are centered on the display.
Adjust the horizontal Scale so that the differences in the channel delays are clearly visible.

Determine the channel you want to use as your reference.

Double-tap the Channel badge of a channel other than the reference channel and tap the Other panel.

Tap the Deskew field and use the multipurpose knob to align this channel with the reference channel waveform such that the
waveforms cross the trigger point at the same time. For fine adjust, double-tap the Deskew field to open a number pad.

Repeat steps 9 and 10 for each additional channel you want to deskew.
To deskew additional channels:
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a. Disconnect all probe tips except the reference probe from the Probe Compensation connections.
b. Connect up to three probe tips and ground leads to the Probe Compensation connector (maximum of four channels at a time).
c. Repeat steps 3 through 12 for the additional channels to deskew.

Connect a keyboard or mouse

The instrument supports most standard USB-connected keyboards and mice, and wireless-connected keyboards and mice (using a
USB-connected dongle).

Connect a keyboard and/or mouse by connecting their USB cable, or USB dongle, into any available USB Host port. The keyboard or
mouse should work immediately. If it does not, try the following:

1. Remove and reinsert the USB cable or dongle in the same port.
2. Insert the USB cable or dongle into a different USB port.

Connect an external monitor or projector
Use the video outputs to send the instrument display to a projector or to a flat-panel LCD monitor.

1. Power on the oscilloscope.
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2. Connect the appropriate video cable to the projector or monitor. Connect the other end to the correct DVI, Display Port, or VGA
connector on the oscilloscope.

3. Power on the projector or monitor.
4. Follow the projector or monitor instructions to set up and adjust the image.
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Analog channel operating basics

Acquiring a signal
After acquiring a signal you can take measurements and plot the resullts.
Use the following procedure to set the scale and position parameters for analog signal acquisition.

1. Press the Default Setup button.

2. Connect the probe output to the desired oscilloscope channel, and connect the probe input to the input signal source using proper
probing/connecting techniques.

A Note: Some probes automatically set their termination and other values.

3. Tap the channel button to add the channel waveform to the waveform view and add a channel badge to the setting bar. A channel
button lights when its channel is on.

4. Double-tap the channel badge to open the channel Vertical Settings menu. To change the input coupling, select the appropriate
coupling button.
+ Select DC to couple both the AC and DC components of an input signal.
+  Select AC to couple only the AC components of an input signal.

5. Use the Vertical knobs to scale and position the waveform vertically on the screen. The Knobs should be highlighted with the active
channel's color. Dragging the waveform handle also positions the waveform.

6. Use the Vertical Settings menu to change the offset. Tap Offset, and then use a multipurpose knob to adjust the offset.

7. Use the Horizontal knobs to scale and position the waveform horizontally on the screen and to set the record length. Dragging the
reference icon also positions the waveform.

8. Use the Horizontal menu to set the record length and sample rate (when in Manual mode).

9. You may attempt to stabilize the display by pressing the trigger Level knob to set the trigger level to 50%. The 50% level is calculated
as the midpoint between the highest and lowest samples of the acquired waveform. If your signal is periodic you should see a stable,
triggered signal. This method will not work as well with random signals.

Autoset to quickly display a waveform

The Autoset function analyzes the signal characteristics and changes the instrument Horizontal, Vertical, and Trigger settings to
automatically display a triggered waveform. You can then make further changes to trigger and horizontal settings to view the waveform
point of interest.

1. Connect the probe with the signal of interest to an available channel. The signal can be analog or digital.

Double-tap the Trigger badge and set the trigger source to that of the signal of interest.

Connect any other associated signal(s) to available channel input(s).

Add the channel waveforms to the Waveform view. See Add a channel waveform to the display on page 90.

Tap File > Autoset or push the front-panel Autoset button. When using the Stacked Display mode, the instrument analyzes the signal
characteristics of the trigger source channel (analog or digital) and adjusts the horizontal, vertical, and trigger settings accordingly

to display a triggered waveform for that channel. The Vertical scale is adjusted in each waveform slice of all active waveforms to
maximize ADC utilization.

o~ owbd

86



Analog channel operating basics

When using the Overlay Display mode, the instrument adjusts the horizontal and trigger settings of the trigger source channel to
display a triggered waveform for that channel. Vertical scale and position adjustments for all active channels in Overlay Display mode
are controlled by the Autoset in Overlay Display Mode Optimizes selection in the Autoset panel of the User Preferences menu. If
the selection is Visibility, Autoset vertically scales and positions all active channel waveforms such that they are uniformly spaced on
screen. If the selection is Resolution, Autoset vertically scales and positions all active channel waveforms such that they each use as
much of the ADC's range as possible.

Note: You can set which parameters the instrument can adjust when running an Autoset. Access the Autoset panel in Utility >
User Preferences > Autoset. See User Preferences (Utility menu) on page 499.

Autoset guidelines

Autoset displays three or four cycles (depending on the detected signal) with the trigger level near the midlevel of the signal.

The trigger is set to type Edge, rising slope, DC coupling.

If no channels are displayed before pushing Autoset, the oscilloscope adds Ch 1 to the Waveform view whether it has a signal or not.
Autoset ignores math, reference, and bus waveforms.

A channel or waveform with a frequency less than 40 Hz is classified as no signal.

Set Horizontal parameters

Use this procedure to set the horizontal time base parameters such as mode, minimum sample rate, horizontal scale, delay, and trigger
delay time (relative to the center of the waveform record.

1.

Double-tap the Horizontal badge on the Settings bar to open the Horizontal configuration menu.
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HORIZONTAL

raoe

Horizontal Trigger

1 ps/div 10 ps 2D Runt

SR: 6.25 GS/s 160 psp T

RL: 62.5 kpts ¥ 49.5% U:2.24V L: 500 mV

DVM| |AFG

2. Use the menu selections to set horizontal parameters.
3. Tap the Help icon on the menu title for more information on these settings.

How to trigger on a signal
Use this procedure to open the Trigger menu to select and configure the trigger event type and conditions.

1. Double-tap the Trigger badge on the Settings bar to open the Trigger configuration menu.

2. Select a trigger from the Trigger Type list. The trigger type sets what fields are available in the menu and also updates the illustration
to show a graphic of the trigger type.

TRIGGER ©

SETTINGS
— i .

A Note: For the MSO58LP, the AUX In external trigger input only supports Edge triggering.
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To trigger on a bus, you must first add the bus to the Waveform view. See Add a math, reference, or bus waveform on page 94

A Note: Triggering on buses other than Parallel requires purchasing and installing serial trigger and analysis options.

TRIGGER @

SETTINGS

4. Tap the Help icon on the menu title for more information on these settings.

5. Tap outside the menu to close the menu.

Set the acquisition mode
Use this procedure to set the method the instrument uses to acquire and display the signal.

1. Double-tap the Acquisition badge on the Settings bar to open the Acquisition configuration menu.

Select the other fields and panels to refine the trigger conditions. The menu fields and trigger graphic updates as you make changes to
the trigger settings. Displayed fields depend on the selected trigger type. Selection changes take effect immediately.

2. Select the acquisition method from the Acquisition Mode list. Set any other parameters associated with the selected acquisition type.

ACQUISITION

Run / Stop Single / Seq

Sample

Peak Detect

High Res

Envelope

@D Pulse Width

1.9V

1 <46.56 ns 14 Oct 2016
7:13:59 PM

3. Tap the Help icon on the menu title for more information on these settings.

4. Tap outside the menu to close the menu.
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Start and stop an acquisition
Acquisition controls the start and stop of waveform acquisition.

1. To start an acquisition, double-tap the Acquisition badge and tap Run/Stop in the Acquisition configuration menu. You can also push
the Run/Stop button on the front panel.

Run/Stop Single /Seq Clear

2. To stop an acquisition, tap Run/Stop again or push the Run/Stop button.

3. To take a single acquisition, double-tap the Acquisition badge and tap Single/Seq in the Acquisition configuration menu, or push the
Single/Seq button on the front panel.

4. The color of the Run/Stop and Single/Seq buttons on the front panel indicate the acquisition status (green = acquiring, red = stopped).

5. To clear the current acquisition data from waveform memory, double-tap the Acquisition badge and tap Clear in the Acquisition
configuration menu, or push the Clear button on the front panel.

Enable the History
Use this procedure to enable history of the acquisitions.

1. Double-tap the Acquisition badge on the Settings bar to open the Acquisition configuration menu.
2. Select the Enable Acquisition History box.

ACQUISITION

Single / Seq. ‘

' D Enable Acquisition History

1303-024

3. Tap the Help icon for more information on these settings.
4. Tap outside the menu to close the menu.

Add a channel waveform to the display
Use this procedure to add a channel signal to the Waveform View.

1. Connect signal(s) to the channel input(s).
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2. Tap an Inactive Channel button (in the Settings bar) of a connected channel.

The selected channel is added to the Waveform View and a Channel badge is added to the Settings bar.

3. Continue tapping Inactive Channel buttons to add more channels (digital or analog). Channels are displayed from lowest-numbered
channel at the top, to highest-numbered channel at the bottom of the view, regardless of the order they were added (in stacked mode).

4. Double-tap a channel badge to open that channel's configuration menu to check or change settings. See Configure channel and
waveform settings on page 91.

Configure channel and waveform settings

Use the channel and waveform configuration menus to set parameters such as vertical scale and offset, coupling, bandwidth, probe
settings, deskew values, external attenuation values, and other settings.

Use this procedure to set up analog signal input.

+ An analog probe or cable is connected to the channel before setting up the channel.
+ There is a channel or waveform badge in the Settings bar.

1. Double-tap a Channel or Waveform badge to open the configuration menu to the Vertical Settings panel. Displayed fields and controls
can change depending on menu selections.

VERTICAL SETTINGS

l . 500 mV/div u
Set
-

S iv | 500 mvrdiv | 500 mvidiv
1 1 MQ
50 z % | 500 MHz B | 500 MHz B~
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Field or control

Description

Display Enables (On) or disables (Off) displaying the channel waveform in the Waveform View window.

Invert Reverses the amplitude polarity of each sample point. When On, Invert adds a down arrow symbol
to the channel badge.
See Invert channel guidelines on page 453.

Vertical Scale Sets the vertical scale using the multipurpose knob, double-tap to bring up the virtual keypad, or tap
the up and down arrows to change the scale.

Offset Sets the channel signal vertical offset. When there is an offset, the channel handle displays it in the
waveform view.

Setto 0 Sets the channel signal vertical offset to 0 units.

Position Double-tap the field to set the vertical position using the virtual keypad.

Setto 0 Tap to set the waveform zero volt level to the center of the slice or waveform view.

Label Double-tap the field to add a label to the channel display using the virtual keypad.

Bandwidth Limit Tap to select the bandwidth limit from the drop-down list.

Coupling Tap to set the input coupling to DC or AC.

Termination Tap to set the input termination to 1 MQ or 50 Q. If you are using a supported TekVPI probe, this

value is automatically set by the probe and these controls are not available.

Bandwidth Filter Optimized
For

Tap to select a bandwidth filter that is optimized for flatness or step response. This selection is only
available on 6 Series MSO instruments.

Flatness selects a brick-wall filter optimized for flatness within band with a sharp rolloff. Flatness
filtering is not compatible with Peak Detect and Envelope acquisition modes.

Step Response selects a Bessel-Thompson filter that minimizes overshoot with a gradual rolloff.

High Res acquisition mode requires Flatness filtering.

2. To set up your probe, tap the PROBE SETUP panel. The fields and controls in the Probe Setup panel vary with the type of probe
connected to the channel. A TPP probe is shown in this example, for other probes, see the probe user documentation.
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CHANNEL 2

VERTICAL SETTINGS

Probe Type: TPP1000
Serial Number: CUOD086
Version: 0.3
Attenuation: 10X
Propagation Delay: 0

Compensate Probe
Restore Factory
Default

OTHER

Field or control

Description

Probe Information

Displays the probe type, serial number, and attenuation, if it is available.

Probe Compensation Status

Displays the compensation status of the attached probe.

Compensate Probe

Starts the probe compensation procedure.

Restore Factory Default

Returns the compensation to the factory default settings.

3. To set up deskew, external attenuation, or alternate units, tap the OTHER setup panel.

VERTICAL SETTINGS

PROBE SETUP
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Field or control

Description

Deskew Allows setting the channel deskew value.
Setto 0 Sets the channel deskew to 0.
Multi-Channel Brings up the Deskew configuration menu.

External Attenuation

Allows setting an external attenuation for the channel. As one field is edited, the other field changes
to reflect the corresponding value.

Set to Unity Sets left numeric input field to 1X and right input to 0.0 dB.

Alternate Units Toggles alternate units on or off.

Units Sets the ratio units. This field is disabled when the Alternate Units switch is off.

Ratio Sets the desired ratio value. As one field is edited, the other field changes to reflect the
corresponding value. This button is disabled when the Alternate Units switch is off.

Set to Unity Sets the ratio to 1. This button is disabled when the Alternate Units switch is off.

4. When Multi-Channel in the Other panel is selected, the DESKEW configuration menu is displayed.

OK,
Deskew

A
Field or control Description
From Source Selects the From Source to Deskew.
Probe Displays the probe name or a drop-down list to select the probe connected to the From Source.
Propagation Delay Displays the propagation delay of the probe shown in the Probe control.
To Source Selects the To Source to Deskew.
Probe Displays the probe name or a drop-down list to select the probe connected to the To Source.
Propagation Delay Displays the propagation delay of the probe shown in the Probe control.
OK, Deskew Uses the deskew values to adjust the horizontal delay between channels

5. Tap outside the menu to close the menu.

Add a math, reference, or bus waveform

Math waveforms let you create new waveforms based on operations between two or more waveforms or by applying equations to
waveform data. A reference waveform is a static waveform record displayed for comparison. Bus waveforms let you view and analyze

serial or parallel data.

There is no set limit to the number of Math, Reference, or Bus waveforms you can add to the Waveform View, other than system physical

memory constraints.

1. Tap the Add New Math, Add New Ref, or Add New Bus button in the Settings bar.

Add || Add || Add

New | | New | | New
Math| | Ref || Bus
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2.

The instrument adds the waveform to the Waveform view, adds a Waveform badge to the Settings bar, and opens a configuration
menu. This example shows adding a Math waveform.

Use the configuration menus to refine the waveform parameters. Displayed fields depend on the waveform and selections made in the
menu. Selection changes take effect immediately.

This example shows adding a Math waveform, using the Math Source fields to select Ch 1 and Ch 2 as the waveform sources, set the
math type to Basic math operation, and subtracting channel 2 from channel 1.

MATH 1 [©)

s D0 o
.

5- .m«/.-»m‘u»:wm‘v-wA o

Do || e
Ex

When adding a Reference waveform, the instrument displays a Recall configuration menu. Navigate to and select the reference
waveform file (*.wfm) to recall, then tap the Recall button. The instrument displays the Reference waveform.

5. Double-tap a math, reference, or bus badge to check or change the waveform settings.

N o

Tap the Help icon on a configuration menu title for more information on math, reference, and bus waveform settings.
Tap outside the menu to close the menu.

Analog view of digital waveform

Use this procedure to see the digital waveforms in analog view.

1.

Tap the Add New Bus button in the Settings bar.

Add || Add || Add

New | | Mew || New
Math | Ref || Bus

The instrument adds the Bus waveforms to the Waveform view, adds a Bus badge to the Settings bar, and opens a configuration
menu.

Tap the Add New Math button in the Settings bar.

The instrument adds the Math waveforms to the Waveform view, adds a Waveform badge to the Settings bar, and opens a
configuration menu.
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3. Set the Math Type as Basic from Math configuration menu.
4. Select the Bus <x> you want to decode from Source 1 drop-down list. Source 1 sets the available fields in the menu.
5. Select the Field that you want to plot for the selected bus.

©

@ 30.375 /div . . .
. Set
— R

L}

Filter FFT [ ]

OIS I

6. Select the other fields and panels to refine the waveform parameters.
7. Tap the Help icon for more information on math waveform settings.
8. Tap outside the menu to close the menu.

1303.025

Add a measurement
Use this procedure to select and add measurements.

1. Acquire the channel(s) and/or waveform(s) on which you want to take measurements.

Utilty  Help Tektroni

Add New

w bl " i r ML i gl T e
Tuy A S it I i Ipbent L I ity s oo il

Stopped

w B 20ps alyze
Gl 125655 sopwer | Sample: 8 bits
RL: 250 kpts ¥ 48% 3 V L:696 mV_J 4.314 kAcgs
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Note: Waveforms do not need to be displayed to be used for measurements, as long as the channel or waveform badge is
on the Settings bar and is acquiring the signal to measure.

2.  Tapthe Add New...Measure button to open the Add Measurements configuration menu or drag the Measure button onto a
waveform in the waveform display area to automatically set the source.

AMPLITUDE MEASUREMENTS

e i
1] estoreat o (U] Sz
an acrurs

Note: If the menu shows tabs other than Standard, then optional measurement types have been installed on the
instrument. Select a tab to show the measurements for that option.

3. Tapthe Source field and select the measurement source. The list shows all available sources of analog 8 port or digital 16 port
channel that are valid for the measurement.

Source

E
ch1

i ]

. Ch3

| Cha 1
chs
Ché
ch7

chs
1 ]

1 Math 1
A

¥ Ref 1 u
| S

4.  Select a measurement category panel, such as Amplitude Measurements or Timing Measurements, to display measurements for
those categories.

5.  Some optional measurement packages are available in this menu as well like PWR, DJA, DBDDR3, DPM, IMDA, and WBG-DPT.

Select a measurement and tap Add to add the measurement to the Results bar. You can also double-tap a measurement to add it to
the Results bar.
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Add New...

Cursors| | Note

ADD MEASUREMENTS Measure | Search

Standard | Results
Table || Plot

(Meas1 e
Frequency
: 3125 kHz

AMPLITUDE MEASUREMENTS / >

TIMING MEASUREMENTS.

Al | Period f;{ Frequency 3R | Data Rate
- =

[i] Delay [ﬁ Rise Time U Fall Time
[&] Phase. [Z] :l.s!l:g Slew [}m] ;:l‘llng Slew
[@] Burst Width [ﬂ] zg‘;'l‘g“" QuDy [@ 2‘,‘32"“ (21557

JITTER MEASUREMENTS >

7.  Select and add other measurements for the current source. Tap the measurement category panels to display and select other
measurements to add.

8. To add measurements for other sources, select a different source, select a measurement, and add the measurement.

Add New...

Cursors| | Note

ADD MEASUREMENTS ? Measure | Search

Standard Results (g
Wieas 1 =
Frequency
: 3125 kHz
Wieas 2
Peak-to-Peak

Burst Width
:0.0005

AMPLITUDE MEASUREMENTS >

TIMING MEASUREMENTS

[sut] prios (sl Frequeney (2] Datarate
@ Positiva Pulse @ Hegouve Pulse @ Sy

@ Delay @ Rise Time @ Fall Time
@ Phase @ Reing slew @ Falingsew
(] oo |71 550054 e

JITTER MEASUREMENTS >

9. Tap outside the Add Measurements menu to close the menu.

10. To further adjust a measurement's settings, double-tap a measurement badge to open a configuration menu for that measurement.
See Configure a measurement on page 98.

11.  Tap the Help icon on the menu title for more information on settings.

Configure a measurement

Use this procedure to add statistical readouts to the measurement badge, display plots for the measurement, and refine measurement
parameters (configuration, global versus local scope of settings, gating, filtering, and so on).

1. Double-tap a measurement badge to open its Measurement configuration menu.

98



Analog channel operating basics

4. Use the available fields to refine the measurement conditions. Displayed fields depend on the measurement. Selection changes take
effect immediately. Selection changes can also change fields in other panels.

5. Tap the Help button on the menu title for more information on this menu's settings.
6. Tap outside the menu to close the menu.

Delete a Measurement or Search badge

Use this procedure to remove a Measurement or Search badge from the Results bar.

1. Touch and hold the Measurement or Search badge that you want to delete. The instrument opens a right-click menu.
2. Select Delete Meas to delete that badge from the Results bar.

Fall Time
M 10.25 ns

Configure Meas 7...

Delete Meas 7
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A Note: You can undo a measurement delete.

3. The second way to delete a Measurement or Search badge is by flicking it off the right edge of the display. Flicking to the left from the
right edge of the display recovers the badge.

A Note: Badge recovery is possible within 10 seconds only of removal.

Add a plot of a measurement

Measurement plots let you graph the distribution of waveform data point occurrences (histogram), plot the frequency components
(spectrum) of a waveform, show the time trend of a measurement, display an eye diagram, and other supported plots. Available plots
depend on the measurement.

1. Double-tap a Measurement badge to open the Meas configuration menu.
MEAS 1 (©)

FREQUENCY

Add New...

ors| | Note

Curs
M
Re:
T

m:
N: 7599232

CONFIGURE

REFERENCE LEVELS

GATING

vivivi ey

FILTER / LIMIT RESULTS

2. Tap a Plots button to add that plot for the measurement to the screen.

MEAS 1

FREQUENCY

M
m:

9 MHz
N: 7599232

CONFIGURE

REFERENCE LEVELS

GATING

vivi iv v

FILTER / LIMIT RESULTS

The following shows adding a Histogram plot.
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You can add more than one plot to measurements (to different measurements or the same measurement). For example, you can add
two histogram plots for the same measurement, set one to display the X-Axis with a Logarithmic scale, and the other plot to display the
X-Axis with a Linear scale.

3. You can move plot windows by dragging the Plot view title bar to a new position. The blue background area moves to show where the

plot will be located when you remove your finger from the title bar. You can also resize plot windows by selecting and dragging the Plot
view border. You should use a mouse to do these operations, as it is easier to select and drag plots with a mouse.

4. Double-tap within a Plot view to open a configuration menu to set display characteristics. Tap the Help icon on the configuration menu
title for more information on that menu's settings. Tap outside the menu to close the menu.

Display a Histogram plot

Use this procedure to display a histogram plot.

To display a histogram plot you must be taking a measurement.
1. Double-tap a measurement badge.

The Measurement configuration menu is displayed.
2. Tap the Histogram plot button.

The Histogram plot is displayed in a separate Plot view.
3. Double-tap in the plot view to open a configuration menu for that plot.
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Display a Time Trend plot
Use this procedure to display a time trend plot.
To display a time trend plot you must be taking a measurement.

1. Double-tap a measurement badge. The Measurement configuration menu is displayed.

2. Tap the Time Trend plot button. The Time Trend plot is displayed. Time Trend plots are shown in the Waveform View rather than in a
separate Plot view.

Display a Acq Trend plot
Use this procedure to display a acq trend plot.
To display a acq trend plot you must be taking a measurement.

1. Double-tap a measurement badge. The Measurement configuration menu is displayed.
2. Tap the Acq Trend plot button.

Note:

+ Plot rendering resets when there is change in the oscilloscope settings such as the vertical settings, horizontal, acquisition

A and trigger etc.
+  When oscilloscope acquisition is stopped and restarted again, the plot will continue to render without resetting.
+ Acq trend plot does not support Save/Recall session feature.
«  Cursors can be enabled on the plot.

The Acq Trend plot is displayed in a separate Plot view.
3. Double-tap in the plot view to open a configuration menu for that plot.

Display a Spectrum plot
Use this procedure to display a spectrum plot.
To display a time spectrum plot you must be taking a measurement.

1. Double-tap a measurement badge. The Measurement configuration menu is displayed.
2. Tap the Spectrum plot button.

The Spectrum plot is displayed in a separate Plot view.
3. Double-tap in the plot view to open a configuration menu for that plot.

Display an XY or XYZ plot

Use this procedure to display an XY or XYZ plot.

Tap Add New... Plot. The Plot configuration menu is displayed.

If creating an XY plot, tap XY.

If creating an XYZ plot, tap XYZ.

Tap the X Source drop down and select the X Source from the list.

Tap the Y Source drop down and select the Y Source from the list.

If creating an XYZ plot, tap the Z Source drop down and select the Z Source from the list.

S gk~ b=
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7. Tap Add. The plot is displayed in a separate Plot view.
8. Double-tap in the Plot view to open a configuration menu for that plot.

Display an Eye Diagram plot
Use this procedure to display an eye diagram of a waveform.

Prerequisite: An active signal for which you want to plot an eye diagram.
A Note: MSO44 and MSO46 (non-B version) does not support Eye Diagram plot.

Tap Add New... Plot to open the Plot configuration menu.

Tap Eye Diagram.

Tap the Source drop down and select the signal source from the list.

Tap Add. The instrument adds the eye diagram in a separate plot window and adds a TIE measurement badge to the Results bar.
Double-tap in the Plot view to open a configuration menu for that plot.

o Db~

Display a Phasor Diagram for Power Quality measurement
Use this procedure to display a phasor diagram plot.

To display a phasor diagram plot, you must be taking an Power Quality measurement (Add New... Measurement> IMDA tab > Electrical
Analysis panel > Power Quality measurement).

1. Double-tap a Power Quality measurement badge. The Measurement configuration menu is displayed.
2. Tap the Phasor Diagram button.

The Phasor Diagram plot is displayed in a separate Plot view.
3. Double-tap in the Plot view to open the configuration menu for that plot.

Display a Phasor Diagram for DO0 measurement
Use this procedure to display a phasor diagram plot for DQ0 measurement.

To display a phasor diagram plot, you must be adding a DQO measurement (Add New... Measurement > IMDA tab > Electrical Analysis
> DQ0 measurement).

1. Double-tap an DQO measurement badge. The Measurement configuration menu is displayed.
2. Tap the Phasor Diagram button. The Phasor Diagram plot is displayed in a separate Plot view.
3. Double-tap in the Plot view to open the configuration menu for that plot.

Display a Harmonics Bar Graph plot for IMDA Harmonics measurement
Use this procedure to display a bar graph.

To display a harmonics bar graph, you must be taking a Harmonics measurement (Add New... Measurement > IMDA tab > Electrical
Analysis panel > Harmonics measurement)

1. Double-tap a Harmonics measurement badge. The Measurement configuration menu is displayed.
2. Tap the Bar graph button. The Bar graph is displayed in a separate Plot view.
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3. Double-tap in the Plot view to open the configuration menu for that plot.

Add Mask Testing to an Eye Diagram plot
Use this procedure to add mask test segments to an eye diagram plot and display the mask segment hits information in the Results bar.

Prerequisites: An eye diagram plot is on the screen.
A Note: 4 Series MSO does not support Eye Diagram plot.

A mask configuration file (.msk) that matches the time scale (unit interval) and vertical settings of the eye diagram.

1. Double-tap in the eye diagram plot to open the Eye Diagram configuration menu.

2. Tap the Mask panel.

3. Use the Mask panel fields to select and load a mask configuration file and set the bit type for testing. See Eye Diagram plot
configuration menu on page 525.

Note: The mask configuration file that you load must match the time scale (unit interval) and vertical settings of the active eye
diagram.

This step also adds a Mask badge to the Results bar.

Seq 1: 0 Ul hits
Seq 2: 787 Ul hits
Seqg 3: 0 Ul hits
Total; 787 Ul hits
Status: fail

The Mask badge shows the number of unit interval hits per segment and the pass/fail status. You can expand the Mask badge when
acquisition is stopped to show the Navigation buttons.

When Autofit Mask to Minimize Hits box is checked, the mask violations are displayed in sample hits.

Use the Navigation buttons to center the source waveform on the previous or next mask search mark where a mask hit occurred. In the
case of mask hit groups (see the following text), the Navigation buttons center the source waveform on the beginning mask hit group
search mark where the successive mask hits started.

The mask hit search marks on the source waveform are not precise due to the interpolated waveform used to create the eye diagram.

When a set of successive waveform sample points (for example, 50 sequential sample points) touch a mask, then the whole series
of successive sample points is considered as one mask hit group. The successive mask hit groups are marked with a beginning and
ending search mark, instead of individual search marks for each hit.

4. Tap the Mask Test button to set it to On and display the mask segments in the eye diagram.
5. Tap outside of the menu to close it.

6. To set the number of hits required to fail a mask test, double-tap the Mask badge in the Results bar to open the Mask Hits menu and
set the hit fail value. See Mask Badge configuration menu on page 466.

Display an FFT math waveform
Use this procedure to display an FFT math waveform.

The FFT process mathematically converts the standard time-domain signal (repetitive or single-shot acquisition) into its frequency
components. The FFT function processes the waveform record and displays the FFT frequency domain record, which contains the input
signal frequency components from DC (0 Hz) to 2 the sample rate (also called the Nyquist frequency).
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Tap Add New Math to create a math waveform and open the Math configuration menu.
Tap Source and select the signal source from the list.
Set Math Type to FFT. The FFT of the waveform is displayed in an FFT Math waveform view.

Double-tap on the FFT waveform display to open a configuration menu to further refine the FFT display. See Math FFT plot
configuration menu (Math waveform) on page 537.

oo b~

Display a B-H curve plot for Magnetic Property measurement

Use this procedure to display a B-H curve plot for a power measurement.

To display a B-H Curve plot, you must be taking a Magnetic Property measurement (Add New... Measurement > Power tab > Magnetic
Analysis panel > Magnetic Property measurement).

1. Double-tap the Magnetic Property measurement badge to open the configuration menu.
2. Tap B-H Curve to add a new B-H Curve Plot view to the screen.
3. Double-tap in the Plot view to open a configuration menu for that plot.

Display an | vs (integral of) V plot for | vs V measurement

Use this procedure to display an | vs. [V plot for | vs. [V measurement.

To display an | vs. [V plot, you must be taking a | vs. [V measurement (Add New... Measurement > Power tab > Magnetic Analysis > |
vs. |V measurement).

1. Double-tap the I vs. [V measurement badge to open the configuration menu.
2. Taplvs. |Vtoaddanewlvs. [V Plot view to the screen.
3. Double-tap in the Plot view to open a configuration menu for that plot.

Display an Inductance Curve plot for Inductance measurement

Use this procedure to display an inductance curve plot.

To display an inductance curve plot, you must be taking an Inductance measurement (Add New... Measurement > Power tab > Magnetic
Analysis panel > Inductance measurement).

1. Double-tap an Inductance measurement badge.

The Measurement configuration menu is displayed.
2. Tap the Inductance button.

The Inductance Curve plot is displayed in a separate Plot view.
3. Double-tap in the Plot view to open the configuration menu for that plot.

Display a Safe Operating Area (SOA) measurement and plot
Use this procedure to display a SOA plot. This is an XY plot with a mask.
To display an SOA power measurement and plot:

1. Tap the Add New... Measurement button.
2. Tap the Power tab.
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3. Set the voltage and current sources for the measurement.
4. Tap the Switching Analysis panel.
5. Select the SOA measurement and tap Add.

The SOA measurement adds a Power measurement badge to the Results bar, and automatically adds the SOA plot to the screen.
6. Double-tap in the Plot view to open a configuration menu for that plot.

Display a power Switching Loss (SWL) Trajectory plot
Use this procedure to display a trajectory plot for a power measurement.

To display a trajectory power plot, you must be taking a Switching Loss measurement (Add New... Measurement > Power tab >
Switching Analysis panel > Switching Loss measurement).

1. Double-tap the Switching Loss measurement badge to open the configuration menu.
2. Tap Trajectory Plot to add a new Trajectory Plot view to the screen.
3. Double-tap in the Plot view to open a configuration menu for that plot.

Display instantaneous power and energy plots from the Power Quality
measurement

Use this procedure to display a power/energy plot from the Power Quality measurement.

To display the power and energy plots you must be taking the Power Quality measurement.

1. Tap the Add New... Measurement button.

. Tap the Power tab.

. Set the Voltage and Current sources for the measurement.
. Tap the Electrical Analysis panel.

2
3
4
5. Select the Power Quality measurement and tap Add.

The measurement is added to the Results bar, and automatically adds PQ: Power and PQ: Energy math waveforms (plots) to the

Waveform view. Math plots are shown in the Waveform View rather than in a separate Plot view.

+  PQ: Power displays the power waveform computed from the Power Quality input sources.

« PQ: Energy displays the energy waveform computed from the Power Quality input sources. See Waveform View configuration
menu on page 636.

Display a Harmonics Bar Graph plot for the Power Harmonics
measurement
Use this procedure to display a bar graph.

To display a harmonics bar graph, you must be taking a Harmonics measurement (Add New... Measurement > Power tab > Electrical
Analysis panel > Harmonics measurement).

1. Double-tap a Harmonics measurement badge.

The Measurement configuration menu is displayed.
2. Tap the Bar graph button.

The Bar graph is displayed in a separate Plot view.
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3. Double-tap in the Plot view to open the configuration menu for that plot.

Display a Power Supply Rejection Ratio plot
Use this procedure to display a Power Supply Rejection Ratio plot for a power measurement.
To display a Power Supply Rejection Ratio power measurement and plot:

Tap the Add New... Measurement button.

Tap the Power tab.

Set the voltage and current sources for the measurement.

Tap the Power Supply Rejection Ratio panel.

Select the Power Supply Rejection Ratio measurement and tap Add.

ok~ b=

The Power Supply Rejection Ratio measurement adds a Power measurement badge to the Results bar, and automatically adds the
Power Supply Rejection Ratio plot to the screen.

6. Double-tap in the Plot view to open a configuration menu for that plot.

Display a Control Loop Response (Bode) plot

Use this procedure to display a Control Loop Response (Bode) plot for a power measurement.
To display an Control Loop Response power measurement and plot:

1. Tap the Add New... Measurement button.

Tap the Power tab.

Set the voltage and current sources for the measurement.

Tap the Frequency Response Analysis panel.
Select the Control Loop Response measurement and tap Add.

A ol o

The Control Loop Response measurement adds a Power measurement badge to the Results bar, and automatically adds the Control
Loop Response plot to the screen.

6. Double-tap in the Plot view to open a configuration menu for that plot.

Note: Gain Margin (GM) represents the margin value and not the actual value annotated in the Bode plot. The GM value
indicates distance (basically how far) from the reference value (zero dB line). The margin is computed as zero minus the
measured value. The measured value becomes negative when it is below 0 dB, then margin is positive and vice versa.

Add a Search

Use this procedure to set search criteria and mark a waveform where those events occur.

You can search on analog and digital signals, math waveforms, and reference waveforms. You can add searches to different waveforms
and multiple searches to the same waveform.

Prerequisite: Display the channel or waveform signal on which to search. The waveform must be displayed to create a search for it.

1. Tap the Add New...Search button to open the Search configuration menu.
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SEARCH 1

2. Use the configuration menu fields to set the search criteria in the same way that you would set for a trigger condition (select the
Search Type, Source, and conditions on which to search).

A Note: You cannot search for sequential events (there is no Sequence search type).

3. The searched waveform is marked with one or more triangles as soon as the search criteria becomes true. Each search uses a
different color for its markers. The example image shows search criteria set to find positive pulse widths that are less than 70 ns wide.

4. To stop showing marks on a waveform, double-tap the Search badge and tap Display to Off.

5. To move the waveform to center marks on the display, push the Run/Stop front panel button to stop acquisition, single-tap a Search
badge, and tap the < or > Navigation button.

Search: Pulse ...
Events: 2

A Note: Navigation buttons are only functional when the oscilloscope acquisition mode is set to Stop.

This opens the Zoom mode and moves the waveform to the previous or next event mark on the waveform.

6. If available for a search, tap the Min or Max button to center the waveform in the display at the minimum or maximum value of the
search events in the waveform record.

7. To return the instrument to normal acquisition mode, tap the Zoom icon in the upper right corner of the Waveform View to turn off
Zoom mode, and push the Run/Stop front-panel button to set it to Run mode.
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Change waveform view settings

Use this procedure to change the waveform display mode (Stacked or Overlay), waveform trace interpolation algorithm, waveform
persistence, style and intensity, and graticule style and intensity.

1. Double-tap on an open graticule area to open the Waveform View configuration menu.

Waveform View

WAVEFORM VIEW

3. Use the other controls to set the waveform interpolation algorithm, waveform point persistence, style, and intensity, and graticule style
and intensity.

4. Tap the Help icon on the menu title to open the Waveform View menu help topic for more information on the waveform view
parameters.

5. Tap outside the menu to close the menu.

Display and configure cursors

Cursors are on-screen lines that you can move to take measurements on specific parts of a waveform or plot, or between two different
waveforms. Cursor readouts show both current position values and the difference (delta) between cursors. Polar cursor readouts are
available through the cursor configuration menu for XY and XYZ plots.

1. Tap the waveform slice (in Stacked mode), or the channel or waveform badge (in Overlay mode) to which you want to add cursors.
2. Tap the Add New...Cursors button, or push the front-panel button. The cursors are added to the display.
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3. Use Multipurpose Knobs A and B to move the cursors, or touch and drag a cursor. Cursors show readouts that show position and
difference measurements between the cursors.

4. To move the cursors to a different channel or waveform, just tap in that waveform graticule.
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5. To further configure cursors, double-tap on either cursor line or the cursor readouts to open the Cursors configuration menu. For
example, tap the Cursor type to select the cursors to display, such as Waveform, V Bars, H Bars, and V&H Bars. See Cursor
configuration menu on page 460.

The cursor configuration menu in the waveform view.
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Linked

6. To split the cursors between two waveforms, tap the Source field and select Split and select the source for each cursor. The cursors
are moved to the specified waveforms.
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7. Tap the Help icon on the menu title for more information on the menu settings.

8. To stop showing cursors, push the front panel Cursor button, press and hold to open the right-click menu and turn cursors off, or open
the Cursors configuration menu and set Display to Off.

Display and configure Multi-source cursor readouts

Multi-source cursor readouts are displayed for waveform cursor type. It display amplitude and delta values between cursors for all the
active sources in Stacked display mode. The readouts also display the time and delta values on the selected source. The cursor time
values are common for all the active sources.
1. Tap the waveform slice (in Stacked mode), the channel, or the waveform badge (in Overlay mode) you want to add cursors to.
2. Tap the Add New... Cursors button, or push the front panel Cursor button. The cursors are added to the display.
Use Multipurpose Knobs A and B to move the cursors, or touch and drag a cursor. Cursors display position and difference
measurements readouts between the cursors.
3. Double-tap on the cursor line or the cursor readouts to open the Cursors configuration menu.
4. Tap Cursor Type and select Waveform from the drop-down menu.
5. Tap Source and select ALL from the drop-down menu.

Allincludes time domain analog waveforms like math, reference, trend, etc.

12



Analog channel operating basics

Av: 30.356 pV  Av/At: 126.48 Vs

CURSORS @)

Waveform v

ALL

Waveform View
) .

ST O T O O O O O OSSO O 4 S O S O
| [ lv:-4.743 mV S R A 591,749 bV AviAt: 2.47 Vs =+ A A 151 mY

] J‘ I EEN II-. :‘I"' 114
64 mA | 4
| T

ARG AT AN

9 mA | Av/At: 1.37

6. Tap the Help icon for more information on the menu settings.
7. To stop displaying cursors,

a. push the front panel Cursor button,
b. press and hold to open the right-click menu and turn cursors off, or
c. open the Cursors configuration menu and set Display to Off.

Multi-source cursor readouts guidelines
The waveform in each slice displays the crosshairs where the cursors intersect the waveform.
If the cursor Readout Location is set to Graticule in the configuration menu:

+ The cursor readouts display the amplitude and amplitude delta values for all the active sources.
+ The cursor readouts for the selected waveform shows both time and amplitude values and deltas.
+ Ifyou select a different waveform or channel, the cursor readouts and horizontal in-graticule labels moves to the selected waveform.

If the cursor Readout Location is set to Badge in the configuration menu:

+ Al active waveforms in the Waveform View have cursor readout results associated with them, even if they are overlaid in a slice.
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G808

+  The first section of the badge shows the delta time information.

+ The second section of the badge shows the time and amplitude values associated with Cursor A.
+  The third section of the badge shows the time and amplitude values associated with Cursor B.

+ The fourth section of the badge shows the delta amplitude information.

Using Default Setup
Use Default Setup to restore instrument settings to their factory defaults.

1. Press the front panel Default Setup button to return the instrument to its factory default settings (horizontal, vertical, scale, position,
and so on).

Touch Off Default Setup

User

XXXX-008

2. You can also select File > Default Setup to restore default settings.

Using Fast Acq

Fast Acq (fast acquisition mode) reduces the dead time between waveform acquisitions, enabling the capture and display of transient
events such as glitches or runt pulses. Fast acquisition mode can also display waveform occurrences at intensity levels that reflect their
rate of occurrence. The Horizontal badge displays Analyze when FastAcq is set to Off and FastAcq when it is set to On.

1. To use Fast Acquisition mode, double-tap the Horizontal badge and tap Fast Acq to toggle Fast Acq to On. You can also push the
Fast Acq front-panel button.

Run / Stop Single / Seq
26 E

XXXX-003

2. To display waveform with an intensity that reflects the rate-of-occurrence, double-tap the Horizontal badge, tap the Fast Acq Palette
field, and select a display palette from the drop-down.

14



Analog channel operating basics

HORIZONTAL

2o min] | -] —
D

3. View the waveform to find glitches, transients, or other random events. When you have identified an anomaly, use the advanced trigger
system to capture the event of interest for further analysis.

Note: If Fast Acquisitions mode is on and you attempt to activate a feature that conflicts with this mode, Fast Acquisitions
mode will be disabled. When the conflicting feature is turned off, Fast Acquisitions will resume in most cases.

Note: Enabling FastAcq mode disables Fast Frame mode (if it was enabled). Likewise, enabling Fast Frame mode disables
FastAcq mode (if it was enabled).

Add a callout to a view
Tap the Add New... Callout button to add callouts at the default position, but you can relocate it later.

1. Tap the Add New... Callout button on the upper right of the results bar. The oscilloscope adds a text placeholder with default text as
Double tap to edit at the center of the screen. However, you can move it around to place it at your choice.

2. The default callout field wraps text at about 15 characters. Use a mouse to select the callout and select any point from the available 8
touch points to resize the callout field to a larger size, to autowrap the callout text for the longer callout.

3. Double-tap or Double-click on the callout text top to open the callout Settings configuration menu.

CALLOUT

SETTINGS

FORMAT >

4. Select the type of callout from the drop-down list. The types of callout available are as follow:
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Callout Type Description

Note Adds a callout as a text.

Arrow Adds a callout text with an arrow.

Rectangle Adds a callout text with an arrow pointing to a rectangle. The rectangle can be dragged to any position.

Bookmark Adds a callout text with a bookmark added for either Waveform view (ch, math, ref), Spectrum view (freq
domain traces, rf vs time domain traces), or Time Trends. Specify the source channel from the drop-down list
and X-position of the callout.

5. Tap in the Text field and use a keyboard to enter the callout text, or double-tap in the Text field and use the on-screen keyboard to

enter the callout text.

Note: You can enter only one row of text in the Text field of the Text Settings configuration menu (using an attached
keyboard). You can enter multiple rows using the on-screen keyboard entry field.

6. If you used the on-screen keyboard to enter text, tap the Enter button on the keyboard to close the keyboard and show the callout on

the screen.

7. Use the format menu controls to set font type, size, color and other characteristics. See Text Settings configuration for details.

CALLOUT

SETTINGS

FORMAT

8. Tap outside the callout Settings configuration menu to close it.
9. To move a callout, touch and drag the callout text to a new position.

Delete a Callout

Tap and hold on a callout text to open a menu to delete that Callout.

1. Touch and hold on the callout text you want to delete (or right-click with the mouse). The oscilloscope opens the right-click menu.
2. Select Delete. The callout is deleted immediately.
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Acquiring digital signals

Connect a TLP058 FlexChannel digital logic probe to any oscilloscope input channel. Connect the logic probe inputs to the DUT (see the
probe instructions). Then use the following instructions to set up, acquire and display digital signals.

Connect and set up digital signals

Use the digital channel configuration menu to set the digital channels to acquire signals.

The digital channel configuration menus are available only if a FlexChannel-supported digital logic probe is attached to the oscilloscope.

10.

CAUTION: To prevent damage to the instrument always wear an antistatic wrist strap when making connections to the instrument
and DUT. Always observe the maximum input voltage ratings for input connectors.

Connect the FlexChannel digital logic probe to the instrument. The digital signal waveforms display on the screen.

Connect the probe to the signal sources. Use the accessories in the Tektronix Probe Accessory Kit (shipped with the probe) to
connect to your DUT.

Push the Menu button on the logic probe to open the digital channel configuration menu. Set up digital channels to match your digital
logic requirements.

CHANNEL 1 @)
’ Extra

) B
) B S
T

0 D
0 D
0 D
0 D
11220 D

Turn All Off Set All Thresholds

Tap Display to toggle the digital channel group On or Off. Doing this closes the menu and removes the Digital channel badge from
the Settings bar.

To change the displayed height of the digital channels, tap a Height button. The height settings are only available when the display
mode is set to Overlay in the Waveform View configuration menu.

Use the upper Label field to enter a custom label for the overall digital channel. Double-tap on the field and use the virtual keyboard
or tap the field and use an attached keyboard.

Tap the Bit control to toggle individual digital channel bits On or Off and remove them from the displayed logic waveform.

Tap a Threshold field and use multipurpose knob A to set individual channel bit threshold levels. You can also set the bit threshold
by double-tapping the field and setting the threshold using the virtual keypad.

Use the bit Label fields to enter labels for the individual digital channel bits (D0-D7). Double-tap on the field and use the virtual
keyboard or tap the field and use an attached keyboard.

Tap to turn all digital bits Off. Doing this closes the menu and removes the associated channel badge from the Settings bar.
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Acquiring digital signals

11, To set all bit thresholds to the same value, enter a threshold value in the lower threshold field and tap Set All Thresholds.

Add a serial bus to the Waveform view
Use this procedure to add a serial bus to the Waveform view.

This instrument supports decoding parallel buses (standard with the instrument) and several serial buses options. All serial bus functions
are options that must be purchased and installed before they are available in the instrument menus.

Use a Bus configuration menu to define a bus from which to acquire, decode, and display data.

1. Tap the Add New Bus button on the Settings bar to add a Bus badge to the Settings bar, add a bus waveform to the screen, and open
the Bus configuration menu. The default bus type is parallel.

BUS 1 ©)

f Set
Parallel v

Define
Inputs

2. Tap Bus Type and select the bus type from the drop-down list.
BUS 1 ©)

‘. Set

3. Use the fields and controls to select the bus signal sources, thresholds, other parameters, and the output format. The following image
shows the settings for an Audio 12S serial bus.
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BUS 1 @
) i Set
o) o[

Bus and Waveforms +
Signed Decimal v

The decoded bus is updated on the screen as you make changes to the settings.

{Left Channel-52 _Right Channel:92 (_Left Channel:-94 )_Right Channel:94 { Left Channel:-96

4. Tap outside of the Bus configuration menu to close it.
5. Double-tap the Trigger badge and use the Trigger configuration menu to trigger on a specific condition in the bus.

TRIGGER ©)

Word Select v

94 ( Right Channel:94 | Left Ch

|
|

6. For more information on serial bus settings, tap the Help button on the Bus configuration menu.

Add a parallel bus to the Waveform view
Use this procedure to add a parallel bus to the Waveform view.

When you acquire data from a Parallel bus, you can set up the bus to be clocked or unclocked. If the bus is not clocked, the instrument
acquires all data from the parallel bus at the sample rate of the instrument.

1. Tap the Add New Bus button on the Settings bar. This adds a Bus badge bus to the Settings bar, adds a bus waveform to the screen,
and opens the Bus configuration menu. The default bus type is parallel.
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BUS 1 ©)

Set
Parallel v

2. If setting up a clocked bus:
BUS 1 @
i [ 2seaia ] )
D

Define
Inputs.

a. Set Clocked Data to Yes.
b. Tap the Clock Source field and select the source for the parallel bus clock signal.
c. Tap the Polarity and Threshold controls and set the clock signal transition to detect and threshold level, respectively.

3. Tap Define Inputs and select the signal sources for the parallel bus. Signal sources can be analog, digital, math, or reference. Tap a
signal in the Sources list to add it to the bus list on the left.

PARALLEL BUS - DEFINE INPUTS

e

The bus waveform updates as you make changes on the configuration menu. Tap the + symbol next to the waveform handle to turn on
and off showing the signals associated with the bus waveform.
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— _ |
¥ Data:2h (_Data:2h ) Data:2h i Data:2h i Data:2h | Data

[ |1l \ B\\\ Il

4. Use the rest of the fields and controls in the configuration menu to set up the parallel bus parameters (label, position, display and
decode formats).

5. Tap outside of the Bus configuration menu to close it.

6. To get a stable triggered waveform, double-tap the Trigger badge, set the Trigger Type to Bus, select the bus Source to the parallel
bus you just set up, and enter the data condition on which to trigger in the Data field.

7. Forinformation on parallel bus menu settings, tap the Help button on the Bus configuration menu.
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Advanced triggering

You can check the advanced trigger status in the trigger menu. The menu indicates the trigger type and then shows sources, levels, or any
other parameters that are important for the particular trigger type.

Triggering concepts
User selected trigger conditions are used to capture waveforms for measurement and analysis.

The next figure shows how triggers fit into the overall instrument operation.

Storage

Acquisition Acquisition ’ .
f{ Input 7] system # system Display
Waveform
M~ transform
system

Trigger > Horizontal
99 e time base

03006

Trigger helps you to capture meaningful waveforms to display on screen. This instrument has simple edge triggers as well as a variety of
advanced triggers.

-

T~

/ ]
/ f
] / /

/
/

Normal trigger mode Automatic trigger mode Triggered waveform

N J
Y
Untriggered waveforms 002007
The trigger event

The trigger event establishes the time-zero point in the waveform record. All waveform record data are located in time with respect to that
point. The instrument continuously acquires and retains enough sample points to fill the pretrigger portion of the waveform record (that part
of the waveform that is displayed before or to the left of the triggering event on screen).

When a trigger event occurs, the instrument starts acquiring samples to build the post-trigger portion of the waveform record (displayed
after or to the right of the trigger event). Once a trigger is recognized, the instrument will not accept another trigger until the acquisition is
complete and the holdoff time has expired.

Trigger on a pulse width event

Pulse-width triggering triggers the oscilloscope when a signal pulse width is less than, greater than, equal to, or not equal to a specified
pulse width. This trigger is useful for digital logic troubleshooting.

To trigger on a pulse width event:

1. Double-tap the Trigger badge to open the Trigger configuration menu.
2. Tap Trigger Type and select Pulse Width. See Pulse Width Trigger configuration menu on page 612.
3. Tap Source and select the trigger source.
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4. Tap Trigger When and select the pulse width condition on which to trigger (> Limit, < Limit, = Limit, # Limit, Outside Range, Inside
Range).

PW < Limit PW > Limit

- H—,i
\
? ! r ! |
—| — Threshold level — — — m
|
| | |

PW = Limit + 5%

| > | -

Tolerance

PW # Limit + 5% PW Outside Range PW Inside Range
U ‘
Range
Tolerance o =Trigger point Range ang

5. Set the pulse width time constraints:

a. For all trigger when conditions except Outside Range or Inside Range, tap the Time Limit field and use the assigned multipurpose
knob to set the pulse width time condition to meet.

b. For Outside Range or Inside Range conditions, tap the High Time Limit and High Time Limit fields and use the assigned
multipurpose knobs to set the pulse width time range condition to meet.

Tap the Level field and set the threshold value at which you want to measure pulse width.
. Select the pulse polarity on which to trigger.

To further refine the trigger conditions, set Logic Qualification to On and tap the Define inputs button to define the logic condition of

any other signals that must be true at the same time as the pulse width trigger event is true. See Logic Qualification - Define Inputs
configuration menu on page 626.

Trigger on a timeout event

Use Timeout triggering to trigger the oscilloscope when a signal stays above, stays below, or stays above or below a specified level for
longer than a specified time limit.

To trigger on a timeout event:

1. Double-tap the Trigger badge to open the Trigger configuration menu.

2. Tap Trigger Type and select Timeout. See Timeout Trigger configuration menu on page 624.
3. Tap Source and select the signal source.

4, Tap Trigger When and select the condition on which to trigger (Stays High, Stays Low, or Either).

Stays High Stays Low

Either

1716-008

5. Tap the Threshold field and use the assigned multipurpose knob (or double-tap the field and use the keypad to enter a value) to set
the threshold value that determines when the signal is high or low.

6. Tap the Time Limit field and use the assigned multipurpose knob (or double-tap the field and use the keypad to enter a value) to set
the maximum time that a signal can stay high or low before transitioning to the opposite state.
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7. To further refine the trigger conditions, set Logic Qualification to On and tap the Define inputs button to define the logic condition of
any other signals that must be true at the same time as the pulse width trigger event is true. See Logic Qualification - Define Inputs

configuration menu on page 626.

Trigger on a runt signal event

Use Runt triggering to locate signal pulses that do not make a full logic level transition.

To trigger on a runt event:

1. Double-tap the Trigger badge to open the Trigger configuration menu.
. Tap Trigger Type and select Runt. See Runt Trigger configuration menu on page 616.

2
3. Tap Source and select the trigger source.
4. Tap Trigger When and select the condition on which to trigger.

Positive Polarity Negative Polarity
Occurs Occurs
] ]
—~ —_— p— | I
/ \ : : \ \y \/
o I I \
\ ! I
\ | | |
- \ [
| \ 1
| \ \ i I
— \ =l
< Limit < Limit
7] M
o | | — M\ /1
T 1 T 1 I 1
\ I I \ R S A
| \ ! ! \ ! !
/ | ! \ / ! !
= ! = ! !
Limit Limit
> Limit > Limit

\
— ——
\ o \ |
/ \ [ ! [
) ! | 1
] \ (I \ [
{ A | | \ | |
Limit Limit
= Limit = Limit
i 7]
™ I I \ I !
— \
[ I I \ !
/ | |
P ! I \ | 1 I
/ | I (| I I
/ | | U/ I I
| /1 | (| 1 1
Limit £5% Limit £5%
# Limit # Limit
X0 X
M | | [ 1
S e E R R \ | ]
/ | | | \ |
] \ | | ! 1 |
/ \ | \ / 1 1
I . — I [
| ! \ /
/ /1 | \ 1 1
Limit £5% Limit £5%
# Limit # Limit

124

Either Polarity
Occurs

i
| J‘_\\ / I 1/
7 W T
\\ “c \/
| b | 1
i\ i ) |
— N |

[\

/
A |

;o\ /

< Limit

Limit

Limit £5%

# Limit

— " !
TRYAY

i
‘\ T

@@

|
Limit +5%

# Limit

1716-010



Advanced triggering

5. Tap the Upper Threshold field and use the assigned multipurpose knob to set the threshold value that defines the upper limit that the
signal must cross to be a valid signal transition (or double-tap the field and use the keypad to enter a value).

6. Tap the Lower Threshold field and use the assigned multipurpose knob to set the threshold value that defines the lower limit that the
signal must cross to be a valid signal transition (or double-tap the field and use the keypad to enter a value).

7. If Trigger When is set to a limit value, use the Time Limit field to set the runt signal time constraints.

8. To further refine the trigger conditions, set Logic Qualification to On and tap the Define inputs button to define the logic condition of
any other signals that must be true at the same time as the pulse width trigger event is true. See Logic Qualification - Define Inputs
configuration menu on page 626.

Trigger on a signal window event

Use Window triggering to trigger when a signal enters or exits a specified threshold range (window), or remains inside or outside the
window for a specified time limit.

To trigger on a window event:

Double-tap the Trigger badge to open the Trigger configuration menu.

Tap Trigger Type and select Window. See Window Trigger configuration menu on page 626.
Tap Source and select the signal source.

Tap Trigger When and select the condition on which to trigger.

Tap the Time Limit field to set the time value for the Trigger When condition.

Tap the Upper Threshold field and use the assigned multipurpose knob (or double-tap the field and use the keypad to enter a value)
to set the value that defines the upper window threshold.

7.  Tap the Lower Threshold field and use the assigned multipurpose knob (or double-tap the field and use the keypad to enter a value)
to set the value that defines the lower window threshold.

o kb=

8. If Trigger When is set to a limit value, use the Time Limit field to set the time constraints for how long a signal stays within or
outside the window.

9.  Use the Threshold Crossing field drop-down list to set the window threshold to cross when Trigger When is set to Inside > Limit or
Outside > Limit.

10. To further refine the trigger conditions, set Logic Qualification to On and tap the Define inputs button to define the logic condition
of any other signals that must be true at the same time as the pulse width trigger event is true. See Logic Qualification - Define Inputs
configuration menu on page 626.

Trigger on a logic event

Use the Logic trigger to trigger the oscilloscope when the specified logic conditions occur on any combination of analog and digital inputs.
To trigger on a Logic event:

1. Double-tap the Trigger badge to open the Trigger configuration menu.

2. Tap Trigger Type and select Logic. See Logic Trigger configuration menu on page 609.

3. Set Use Clock Edge? to enable or disable finding logic patterns that occur on the clock edge of a specified channel.
4

. Tap Logic Pattern Define Inputs and use the Logic Trigger menu to set the logic state and the signal logic threshold level for each
analog or digital signal.

5. Tap Clock Source and select the signal to use as the clock.
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6. Use the Clock Edge controls to set the signal transition edge to use to evaluate the logic condition at the clock transition.

Clock edge logic
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7. Tap the Clock Threshold field and set the threshold level that the clock signal must pass through to be considered a valid transition.
The clock threshold value is independent of the input signal threshold(s).

8. Tap Trigger When and select the waveform condition on which to trigger when not using a clock edge.

No clock edge logic
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9. Tap Define Logic and set the logic condition that must occur with all specified signals to cause a trigger event.
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Trigger on a setup-hold event

Use the Setup & Hold trigger to trigger on a waveform when a data signal changes state inside of a specified setup and hold time, relative
to a clock edge.

To trigger on a Setup/Hold event:

1. Double-tap the Trigger badge to open the Trigger configuration menu.

2. Tap Trigger Type and select Setup & Hold. See Setup and Hold Trigger configuration menu on page 622.
3. Tap Clock Source and select the signal to use as the clock.
4

. Tap the Clock Level field and set the threshold level that the clock signal must pass through to be considered a valid transition. The
clock threshold value is independent of the input signal threshold(s).

Use Clock Edge to set which clock signal edge to use to start the trigger evaluation.

6. Tap Define Inputs and use the Define Inputs menu to set the signal input sources and their threshold levels. See Setup and Hold
Trigger - Define Inputs configuration menu on page 624.

7. Tap the Setup Time field and set the length of setup time that the data signal must be stable before a clock edge occurs.
8. Tap the Hold Time field and set the length of hold time that the data signal must be stable after a clock edge occurs.

o

Falling Rising

1716-007

Trigger on arise or fall time event

Use the Rise/Fall Time trigger to trigger when the rise or fall time of a signal is less than, greater than, equal to, or not equal to a specified
time limit

To trigger on a Rise/Fall event:

1. Double-tap the Trigger badge to open the Trigger configuration menu.

2. Tap Trigger Type and select Rise/Fall. See Rise/Fall Time Trigger configuration menu on page 614.
3. Tap Source and select the trigger signal source.

4, Tap Trigger When and select the condition on which to trigger.
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5. Tap the Time Limit field to set the time value for the Trigger When condition.
6. Tap the Upper Threshold field and use the assigned multipurpose knob (or double-tap the field and use the keypad to enter a value)

Set up trigger on a parallel bus

Use this procedure to set up triggering on a parallel bus.

Use this procedure if you have already created a parallel bus.

128

1716-009

to set the length of setup time that the data signal must be stable before a clock edge occurs.

Tap the Lower Threshold field and use the assigned multipurpose knob (or double-tap the field and use the keypad to enter a value)
to set the length of hold time that the data signal must be stable after a clock edge occurs.

Use the Slope controls to set the signal transition direction to detect. (rising, falling, or either direction).

. To further refine the trigger conditions, set Logic Qualification to On and tap the Define Inputs button to define the logic conditions

of other signals that must be true at the same time as the setup and hold event. See Logic Qualification - Define Inputs configuration

menu on page 626.
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Double-tap the Trigger badge.
Tap the Trigger Type field and select Bus from the list.
Tap the Source field and select the parallel bus on which to trigger.

Tap either the Binary or Hex Data boxes to enter the parallel bus data value, in either Binary or Hexadecimal format, on which to
trigger. The number of bits shown depends on the number of sources (channels) in the parallel bus.

oo b~

a. Use multipurpose knob A to select the digit or digits to change.
b. Use multipurpose knob B to change the value of the selected digits.

Set up trigger on a serial bus
Use this procedure to set up triggering on a serial bus.

Use this procedure if you have already created a serial bus. Serial buses require purchasing and installing serial bus options. To trigger on
a Rise/Fall event:

1. Double-tap the Trigger badge on the Settings bar.

2. Tap Trigger Type and select Bus from the list.

3. Tap Source and select a serial bus from the list.

4

. Tap Trigger On and select what to trigger on from the list. The displayed fields and controls depend on the bus type and Trigger On
selection. Use these fields to trigger on a specific bus condition. See Bus Trigger configuration on page 573.

Trigger on sequential events (A and B triggers)

Use the A and B Trigger Events to trigger on a second event after a first event occurs.

Set up sequential triggering

1. Double-tap the Trigger badge to open the Trigger configuration menu.
2. Tap Trigger Type and select Sequence. Sequence Trigger configuration menu on page 618
3. Setup the A Trigger Event:

Tap the A Trigger Event button to open the A Trigger Event menu.

Tap Trigger Type and select a trigger type from the drop-down list. This example uses Edge.
Tap Source and select the A event trigger source.

If displayed, tap Coupling and select the trigger coupling.

Tap Level and set the desired trigger level using the multipurpose knob. Or double-tap the field to set the value using the virtual
keypad.

f. Tap a Slope button to select the slope of the signal on which to trigger (Rise, Fall, Either).
g. Tap anywhere outside the A Trigger Event menu to close it.
4, Set up the B Trigger Event:

® o 0 T o

Tap the B Trigger Event button in the main Trigger configuration menu to open the B Trigger Event menu.
Tap Trigger Type and select a trigger type. This example uses Runt.

Tap Source and select a trigger source.

Tap Trigger When and select the condition on when to trigger on a runt signal.

Tap a Polarity icon to set the runt pulse polarity to detect (positive, negative, or either).

Tap the Upper Threshold and Lower Threshold fields and set the levels that a signal must cross to be considered a valid signal.
Signals that don't cross both these thresholds are runt signals.

"o o0 T W
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g. Tap anywhere outside the B Trigger Event menu to close it.
5. To trigger on a specific occurrence of the B trigger event:

a. Tap After the A Trigger Event is found: Trigger on the Nth Trigger Event button in the main Trigger menu.
b. Tap Where N is: and use the multipurpose knob to set the oscilloscope to trigger on the Nth occurrence of a B trigger event.
6. To trigger on the B event after a specific time delay:

a. Tap After the A Trigger Event is found: Trigger on the 1st B Event button.

b. Tap After a Delay of: and use the multipurpose knob to set the desired delay time to wait before detecting and triggering on a B
trigger event. You can also double-tap the field and use the virtual keypad to enter a delay time.

Set Trigger Holdoff

Trigger Holdoff sets the time, after triggering on an event, that the instrument waits before detecting the same trigger event to start the next
acquisition.

Setting the correct holdoff time is important to get a stable trigger. The longer holdoff time for the top waveform causes unstable triggering.
The shorter holdoff set for the bottom waveform only triggers on the first pulse in the burst to remedy the unstable trigger.

Holdoff Holdoff Holdoff
i

O Indicates trigger points

Holdoff Holdoff Holdoff Holdoff
141 o

Prerequisite: You have set up a trigger event for a signal.

1. Double-tap the Trigger badge on the Settings bar to open the Trigger configuration menu.
2. Tap the Mode & Holdoff panel.

3. To set a specific holdoff time, tap Time, then tap Holdoff Time and use the assigned multipurpose knob to specify a holdoff time. Or
double-tap the field and use the virtual keypad to enter a holdoff time.

4. To delay the trigger a random amount of time between triggers, tap Random.

Trigger on an external signal using the AUX input (MSO58LP, MS064,
LPD64 only)

Use this procedure to trigger the instrument from an external signal connected to the AUX input (MSO58LP, MSO64, LPD64 only).

To access the user interface on a Low Profile instrument, connect a monitor to a video port on the rear of the instrument, and connect a
mouse to any USB Host port. You do not need to connect a mouse if your remote monitor is touch-capable. You can also remotely access
the user interface of a network-connected instrument by entering the instrument's IP address in a web browser.

To remotely set a control or run this task on a Low Profile instrument, see the instrument Programmer Manual (Tektronix part number
077-1305-xx) for the correct command or commands to use.

1. Double-tap the Trigger badge on the Settings bar.
2. Tap Trigger Type and select Edge from the list.
3. Tap Source and select Aux.
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A Note: The Aux setting is available only for the Edge trigger type.

4. Set the values for Coupling, Level, and Slope to trigger on the Aux connector signal.

Settings take effect immediately.

Create Visual Trigger areas

The Visual Trigger function extends standard triggering by letting you easily draw and define areas on the screen to further qualify trigger
conditions. This procedure describes how to enable the visual trigger mode and draw areas on the screen.

1. Set the standard trigger conditions to trigger on and display the waveforms to which you want to add visual trigger areas.

2. Double-tap the More button and select the Visual trigger button on the DRAW A BOX menu window. This sets the Draw-a-Box
function to Visual trigger mode.

DRAW A BOX @

lisual Waveform

3. Tap outside the menu to close the Draw A Box menu. The Draw-a Box icon is highlighted to show that it is in Visual Trigger draw
mode.

4. Tap the Draw-A-Box Zoom icon at the up right of the Results Bar to draw a rectangle on the waveform screen for the first area to
define. The area created is associated with the channel to which it was added (in Stacked mode) or the active channel (in Overlay
mode), and assigned the default area logic condition of In (the area is true when the waveform intersects any part of the area).

5. Continue drawing rectangles to add other visual trigger areas:

a. Ifin Stacked mode, you can draw visual trigger areas in different waveform slices.
b. Ifin Overlay mode, select a channel before creating areas for that channel.
6. When you are done drawing visual trigger areas, single-tap anywhere to end the area draw function.

7. To draw areas again, tap the Draw-A-Box zoom icon again. Single tap allow you to draw the box once following which the Draw-A-Box
is reset automatically. Whereas double tap allow you to draw boxes multiple times continuously.

A Note: The draw box button autoselects if you choose an option in the More context panel.

8. To change the shape of an area, see Edit visual trigger areas on the screen on page 131 and Edit visual trigger areas using the Area
menu on page 133.

Edit visual trigger areas on the screen

Use the touchscreen or a mouse to directly edit an area, including moving, changing size, duplicating an area, moving individual vertices,
adding and deleting vertices, and rotating the area.

1. To move a visual trigger area, touch and drag the area to a new position.

A Note: You cannot drag a visual trigger area from one waveform slice to another while in Stacked display mode.

2. To delete a visual trigger area:

a. Touch and Hold or right-click on the area to delete.
b. Select Delete Area from the menu.
3. Toresize a visual trigger area:
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a. Single-tap an area to enable resize area mode. Resize mode draws resize points on all four sides and the corners of a boundary
area that contains the area.

b. Touch and drag a top, bottom, left, or right resize point to resize the area vertically or horizontally.
¢. Touch and drag a corner resize point to resize both the length and height of the area in the dragged direction.

A Note: You cannot move an area while in resize mode.

d. To exit resize mode, tap outside the visual trigger area. The instrument returns to normal operation.
4. To add vertices to or delete vertices from a visual trigger area:

a. Tap an area twice to enable add/delete vertex mode. Add/delete mode draws a crosshair at each existing vertex, and a plus symbol
midway between each existing vertex.

Note: A triangular area does not draw the existing vertices with crosshairs, as they cannot be deleted; only the midway
plus symbols are shown to let you add vertices to a triangle.

b. Tap a vertex crosshair to delete that vertex.

c. Tap a plus symbol to add a new vertex at that location. The area is redrawn to show the new vertex. You can continue to add
vertices; there is no limit to the number of vertices in an area.

A Note: You cannot move vertices while in add/delete vertex mode.

d. To exit add/remove vertex mode, tap outside the visual trigger area. The instrument returns to normal operation.
5. To move vertices in a visual trigger area:

a. Tap the area three times to enable move vertex mode. The move vertex mode draws crosshairs on all vertices of the area.

b. Touch and drag a vertex to move it to a new position.
c. To exit move vertex mode, tap outside the visual trigger area. The instrument returns to normal operation.
6. To rotate a visual trigger area:

a. Tap four times in the area to enable rotate area mode.
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b. Touch and drag the dot in the area to rotate the area.

Note: Once you are touching and dragging the rotate dot, you can move your finger outside of the area to get finer control
over the rotation increments.

c. To exit rotate area mode, tap outside the visual trigger area. The instrument returns to normal operation.

Edit visual trigger areas using the Area menu

Use these procedures to edit Visual Trigger areas using the Area menu, including moving, changing size, moving individual vertices,
adding and deleting vertices, and rotating the area.

See Visual Trigger Area configuration menu on page 630 for more information on the Area menu.
See Edit visual trigger areas on the screen on page 131 for information on graphically editing an area on the screen.
1. To change the input source of an area using the Area menu:

a. Double-tap on the area to edit.
b. Tap the Source field.

c. Select a new source channel. The area moves to the selected source. If the selected source is not displayed, the instrument
does not display that channel when the area is changed to that source.

d. Tap outside the menu to exit.
2. To change the shape of an area using the Area menu:

a. Double-tap on the area to edit.

b. Tap the Shape field.

c. Select the shape to which to change the area. The area changes shape immediately.
d. Tap outside the menu to exit.
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10.

134

To change the area waveform logic condition using the Area menu: The waveform logic condition defines the logic true condition to

assign an area when any part of a waveform intersects any part of an area:

+ Inmeans that the area is true if any part of a waveform intersects any part of the area.

+ Out means that the area is true if a waveform never intersects any part of the area.

+ Don't Care ignores any waveform intersections. This creates a placeholder area to let you experiment with area definitions while
developing your visual trigger.

a. Double-tap on the area to edit.

b. Tap the Waveform Must Be button of the logic true condition to assign to the area (In, Out, Don't Care). The selected logic
condition is assigned immediately to the area.

c. Tap outside the menu to exit.
To change the height of an area using the Area menu:

a. Double-tap on the area to edit.

b. Tap the Height field and enter the height value as units of the current vertical channel settings (volts, amps, and so on). Or
double-tap on the field and use the A knob to change the value. The shape immediately changes height while maintaining the
vertical center position of the area.

c¢. Tap outside the menu to exit.
To change the vertical center of an area using the Area menu:

a. Double-tap on the area to edit.

b. Tap the Vertical Center field and enter the height value as units of the current vertical channel settings (volts, amps, and so on).
Or double-tap on the field and use the A knob to change the value. The shape immediately changes the vertical center position of
the area.

c. Tap outside the menu to exit.
To change the width of an area using the Area menu:

a. Double-tap on the area to edit.

b. Tap the Width field and enter the width value as horizontal time (seconds). Or double-tap on the field and use the A knob to
change the value. The shape immediately changes width while maintaining the horizontal center position of the area.

c. Tap outside the menu to exit.
To change the horizontal center of an area using the Area menu:

a. Double-tap on the area to edit.

b. Tap the Horizontal Center field and enter the new horizontal center position value. Or double-tap on the field and use the A knob
to change the value. The shape immediately changes the horizontal center position.

c¢. Tap outside the menu to exit.
To flip an area vertically using the Area menu:

a. Double-tap on the area to edit.

b. Tap the Flip Vertical button. The area immediately flips vertically around its center position.
c¢. Tap outside the menu to exit.

To flip an area horizontally using the Area menu:

a. Double-tap on the area to edit.

b. Tap the Flip Horizontal button. The area immediately flips horizontally around its center position.
c¢. Tap outside the menu to exit.

To rotate an area using the Area menu:

a. Double-tap on the area to edit.
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C.

Tap the Rotate field and use the A knob to change the value. The area immediately rotates when you enter a value or change
the value with the A knob. Or double-tap on the field and enter the number of degrees to rotate the area, where zero (0) degrees
is the position when the area was created. You can rotate an area from 0° to 360°.

Tap outside the menu to exit.

11.  To add a point (vertex) to an area using the Area menu:

a. Double-tap on the area to edit.
b. Tap the Edit Vertices panel.

d.
e.

f.

Select the vertex in the Define Area list counter-clockwise from you want to insert a new vertex. Selecting a vertex highlights that
vertex on the area.

Tap Insert Point. A new vertex is added to the area, marked with an X, and is highlighted in the list.
Continue adding vertices as needed.
Tap outside the menu to exit.

12.  To delete a point (vertex) from an area using the Area menu:
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Double-tap on the area to edit.

Tap the Edit Vertices panel.

Select the vertex in the Define Area list that you want to delete. Selecting a vertex highlights that vertex on the area.
Tap Delete Point. A new vertex is deleted to the area, marked with an X, and is highlighted in the list.

Continue deleting vertices as needed.

Tap outside the menu to exit.

13.  To move individual vertices in an area using the Area menu:
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e.

Double-tap on the area to edit.
Tap the Edit Vertices panel.
Select the vertex in the Define Area list that you want to move. Selecting a vertex highlights that vertex on the area.

Tap the X (time) axis or Y (Ampl.) field in the list and use the A and B knobs to change the position values. Or double-tap on
each field and enter the new positional values for that vertex.

Tap outside the menu to exit.

14. To reset the shape using the Area menu:

a.
b.
c.
d.

Double-tap on the area to edit.

Tap the Edit Vertices panel.

Tap Reset Points. The shape changes to a triangle centered in the display or slice.
Tap outside the menu to exit.

RF vs Time trigger

Use the Time Domain Traces available in the Spectrum View tab to trigger a time domain signal. Select the Magnitude or Frequency
control to enable these sources in the Trigger Settings menu.

Below is the example of trigger on an amplitude modulated signal with carrier 1 GHz modulated with a 20 KHz square wave.

1. In the Channel menu > Go to Vertical Settings tab > set 50 ohm in the termination.
2. Set the maximum licensed bandwidth (8 GHz for MSO6).
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HANNEL 1
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3. Inthe Channel menu > Spectrum view tab, under RF vs. Time Waveforms, select Magnitude.
4. Select the Display toggle to On.

CHANNEL 1

! _.’\ | W, A
AU AR

100 mV/div | 36 mVidiv

5. In the Spectrum view tab, set Center Frequency and span to the region of interest (1 GHz center frequency with 100 MHZ span is
used).

6. Change the horizontal scale to 10 us/div to view 2 periods of the modulation signal.

7. Open the Magnitude vs. Time menu and adjust the Vertical Scale and Position until you view the Magnitude vs. Time trace on
Oscilloscope UL.

2 Note: Use pinch and drag to adjust the height and position.

The waveform displayed will not be stable, as it is still in triggering on CH1.
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8. Inthe Trigger menu, select CH1 > Mag_vs._Time.

9. Adjust the trigger level to the center of the Magnitude vs. Time waveform.

The displayed waveform is now stable because it is triggered on the Magnitude vs. Time.
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Using Spectrum View

Spectrum View provides a time domain view of the frequency components of a signal.

Spectrum View concepts

Typical oscilloscope displays show electrical signals as a graph of time on the x-axis versus amplitude on the y-axis (time domain). A
spectrum trace shows the same electrical signals as a graph of frequency on the x-axis versus amplitude on the y-axis (frequency domain).

Amplitude

Frequenc
(Power) qeeney

Time

FET )

Time domain view Frequency domain view
sum of sine waves individual sine waves

1303-003

Figure 11: The time and frequency domain components of a waveform.

All time-domain signals can be defined as a composite of discrete sine waves, each with their own frequency, magnitude, and phase.
The frequency-domain waveform (or spectrum trace) is a Fast Fourier Transform (FFT) decomposition of the time-domain signal into its
constituent sine wave frequency components.

There are several advantages to examining signals in the frequency domain:
+ ltis easier to analyze signal noise characteristics. In the time domain, noise can appear as a fuzzy waveform, but in the frequency
domain you can determine if it is broadband, random noise, or perhaps cross-talk from another signal on your DUT.

+ ltis easier to analyze and measure the distortions on signals. Although a 1% distortion on a sine wave may not be discernible in the
time domain, it will be very obvious in the frequency domain as harmonics of the signal.

+  Wireless communication measurements are described in the frequency domain in terms of frequency bands and channels. A spectrum
trace lets you focus analysis on the relevant frequency range and make specialized measurements such as occupied bandwidth and
modulation quality.
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FFT and Spectrum View

Most modern oscilloscopes provide a Math FFT function to display the frequency-domain spectrum of a signal. The typical approach to
creating an FFT is to use the same data acquisition used for the time-domain waveform (1), process it through an FFT, and display that
data in a separate area or window (2).
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The disadvantage of a standard Math FFT is that the instrument uses the same acquisition data for both the time- and frequency-domain
views. Therefore, the instrument settings for sample rate and record length affect both the time-domain and Math FFT acquisitions.
Displaying an optimized FFT trace often involves manual calculations of the time-domain parameters like sample rate and record length.
This also means that the instrument settings often cannot be optimized to show relevant information in both the waveform and Math FFT
views at the same time. The following image shows a change in the Horizontal Scale setting that quickly changes the Math FFT plot.
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The Spectrum View feature in 4/5/6 Series instruments solves this problem by using a separate hardware path in the acquisition engine

of each channel to acquire the frequency-domain data in parallel with the time-domain data. This frequency-domain data is processed,
transformed, and displayed in a separate Spectrum View window (3) that is optimized to display and adjust spectrum traces independently
of the time-domain waveform. Notice that the Spectrum View trace has not changed in the above images with changes to the time-domain
signal, but the Math FFT signal is not usable for measurements in the second image.

Another key feature of Spectrum View is that you can display a spectrum trace for each FlexChannel input, along with their
corresponding time-domain waveforms. The Spectrum View user interface is optimized to display and control frequency-domain
parameters such as reference level, center frequency, span, and resolution bandwidth. Changing settings when the Spectrum View
window is active (selected) does not change settings of the associated time-domain waveform in the Waveform View.
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Time Domain Traces concepts

Time Domain Traces let you view and analyze Magnitude, Frequency, and/or Phase versus time traces for each Spectrum View trace.

Overview

Time Domain Traces display information collected from Spectrum View alongside other time domain waveforms. This allows for analysis of
spectral content as it changes over time, providing some features of a real-time spectrum analyzer. Because the Spectrum View controls
are not tied to the horizontal settings of the oscilloscope, these traces can be examined in detail without sacrificing Span or RBW.

The data in these traces is derived from the IQ data of the acquired signal. This is the same source that is used to calculate the spectrum
trace.

Magnitude Vs. Time

The Magnitude Vs. Time trace shows the magnitude (amplitude) of the Spectrum View signal span versus time. Typical uses include
viewing and analyzing RF pulse power and transmission/channel power.
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Waveform View

eq: 1 MHz
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This trace provides three different ways to calculate and present RF magnitude:

+ Linear Power: Direct use of linear power
+ Linear Amplitude: Square root of the linear power values
+ Log Power (dB)

Frequency Vs. Time

The Frequency Vs. Time trace shows the dominant frequency of the Spectrum View signal and the change in frequency over time.

Spectrum View

Waveform View

WM ARG

1303-018
This trace can help characterize frequency modulation, frequency drift, and brief changes in frequency that might not be obvious in the
spectrum trace.

Phase Vs. Time

The Phase Vs. Time trace shows the change in the signal phase over time, where the instrument measures the incoming signal's
dominant or carrier frequency to derive a reference signal to use as the phase reference.
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This trace can help characterize phase modulation and phase drift. Changes in phase are not visible in the spectrum trace, and can be
difficult to locate in the time-domain signal.

Display a spectrum trace
Spectrum traces are initially set up from each channel's badge menu.

Display the channel signal for which you want a spectrum trace.

Double-tap the channel badge.

Tap the Spectrum View panel.

Set Display to On. The instrument opens the Spectrum View window and adds a Spectrum badge to the Settings bar.
Select the Frequency Domain Traces to show in the Spectrum View (Normal, Max Hold, Min Hold, and/or Average).
Select the vertical Units (default is dBm).

Select which RF vs. Time waveforms to display.

Double-tap the Spectrum badge. See Spectrum badge menu on page 566.

Use the Center Frequency, Span, FFT Window, and RBW Mode controls to set these parameters to display the spectrum trace for
the channel waveform. This menu also controls the Spectrum Time Bar (see Spectrum View and Spectrum Time on page 146).

To change the Span, use a horizontal pinch or expand motion on the touchscreen, or use the front-panel Horizontal Scale knob.
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Note: Setting Span sets the same span value across all spectrum traces, regardless of the center frequency. For example,
the trace 1 center frequency is set to 40 MHz, and span is set to 20 MHz, so trace 1 shows frequencies from 30 MHz to 50
MHz. If you add a spectrum trace for channel 2 with a center frequency of 60 MHz, trace 2 uses the same 20 MHz to show
frequencies from 50 MHz to 70 MHz.

11.  To change the vertical Scale, use a vertical pinch or expand motion on the touchscreen, or use the front-panel Vertical Scale knob.

12. To add peak markers to the trace, double-tap in a spectrum slice to open the Spectrum View menu and tap the Markers panel. Use
the controls to set the number of markers to display, the threshold level at which to detect peaks, and the excursion range required
by the peaks. See Spectrum View window configuration menu on page 560
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Enable the spectrogram
Use this procedure to display the spectrogram.
Spectrogram is initially set up from each channel's badge menu.

Display the channel signal for which you want a spectrogram.

Double-tap the channel badge.

Tap the Spectrum View panel.

Set Display to On. The instrument opens the Spectrum View window.

Select the Frequency Domain Traces to show in the Spectrum View (Normal, Max Hold, Min Hold, and/or Average).
Select the Spectrogram box.
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The spectrogram displays in the spectrum view.

The Spectrum View user interface

A spectrum trace shows the magnitudes of the frequency components that make up the time-domain waveform. Use spectrum traces in
the Spectrum View to view noise, distortion, and crosstalk information of time-domain signals.

The Spectrum View elements

Predominant frequencies (with greater magnitude) are shown as peaks in the view. The vertical graticule represents the signal magnitude,
and the horizontal axis represents frequency, with the starting (lowest) frequency at the left side of the graticule.

Each spectrum trace can display up to four spectrum trace types for each source channel: Normal, Max Hold, Min Hold, and Average.
You can turn each of these traces on and off independently. You can display all or some of them simultaneously.
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Figure 12: The Spectrum View window elements

The trace handle. See Spectrum trace handle and trace types on page 150.
2. The Reference level. The vertical scale (V/div) setting of the source time-domain waveform sets the spectrum trace reference level

as follows:

Source vertical |Trace reference |Source vertical |Trace reference
scale level scale level

500 uV/div -42 dBm 100 mV/div 4 dBm

1 mV/div -36 dBm 200 mV/div 10 dBm

2 mV/div -30 dBm 500 mV/div 18 dBm

5 mV/div -22 dBm 1 Vidiv 24 dBm

10 mV/div -16 dBm 2 Vidiv 30 dBm

20 mV/div -10 dBm 5 V/div 38 dBm

50 mV/div -2 dBm 10 V/div 44 dBm

The Reference marker labels and measures the highest-magnitude peak of the visible spectrum trace.

4.  The Automatic markers label and measure the adjacent next-highest-magnitude peaks of the spectrum trace. The frequency and
magnitude readouts can be absolute values or values relative to the Reference marker. See Spectrum peak markers on page 151.

5.  The Center Frequency is a specified frequency at the center of the spectrum display. For many measurements it is the frequency of
interest to measure, such as a carrier frequency. It may or may not be the highest magnitude peak in the trace. Each trace can have
a separate center frequency setting. Changing the horizontal position of a trace in the Spectrum View window changes the center
frequency of that trace and repositions the trace as needed.
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6. The Amplitude (magnitude) scale. The vertical scale setting of the spectrum trace (pinch/expand actions on the touch screen, or the
Vertical Scale knob on the front panel) sets the scale values.

7.  The Max Hold trace shows the maximum data values that are accumulated and displayed over multiple acquisitions of the Normal
trace.

8. The Normal trace shows each acquisition as new data is acquired. This is the default trace mode. The trace is shown in the same
color as the source channel.

9.  Average trace shows data that is averaged over multiple acquisitions. This is true power averaging, which occurs before the log
conversion. Each power of 2 averaging reduces the displayed noise by 3 dB.

10. Min Hold trace shows the minimum data values accumulated over a specified number of acquisitions.

11.  The Span is the range of frequencies (lowest to highest) to show on the spectrum trace. All spectrum traces have the same span
regardless of the center frequency setting.

Spectrum View guidelines
+ The Spectrum View window supports stacked and overlay display modes. When in Overlay display mode:

+ The vertical and horizontal in-graticule labels apply to the currently selected channel.

+ The MANm spectrum trace handle (see Spectrum trace handle and trace types on page 150) for the currently selected channel is
shown highlighted, just like with analog channels.

« The MANm trace handle for non-selected traces are shown in the same fashion as non-selected analog channels.
+ The Spectrum View does not support zoom.

+ Horizontal pinch and expand touch gestures adjust the spectrum span in the same style as a horizontal pinch/expand in the Waveform
View.

+ Ahorizontal pan adjusts the center frequency. While panning, the pan motion will pause momentarily when the Reference Marker
reaches the middle of the graticule. This provides a very simple Marker to Center functionality.

« Vertical pinch and expand touch gestures adjust the spectrum vertical scale in the same style as a vertical pinch/expand in the
Waveform View.

+ Avertical pan adjusts the vertical position. While panning, the pan motion will pause momentarily when the trace handle reference
level reaches the top of the graticule. This provides a very simple reference level to top functionality.

Spectrum View and Spectrum Time

Spectrum Time controls the area in the time-domain acquisition used to create the Spectrum View trace. Conceptually like gating, use
Spectrum Time to examine the spectrum of specific areas of interest in the acquisition record.

Spectrum View is the part of the time-domain waveform acquisition used to create the Spectrum View trace for that channel.

Spectrum Time is shown by a shaded bar along the bottom of a Channel graticule in the Waveform View. This bar is called the
Spectrum Time Bar. The Spectrum Time Bar visually indicates both the range and time position in the acquisition record used to create
the spectrum trace.
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The Spectrum Time width (amount of the acquisition record) is determined by the FFT Window factor divided by Resolution Bandwidth

1303-015

(RBW). Changing the FFT window type and/or the RBW parameters changes the Spectrum time width.

Using Spectrum View

The Spectrum Time position can be moved through the time domain acquisition using a variety of methods including tapping and dragging
it, using the Wave Inspector Pan knob, or with the Spectrum Time position control in the Spectrum configuration menu.

The FFT Window, RBW, and Spectrum Time settings are in the Spectrum menu (see Spectrum badge menu on page 566).

The Spectrum Time Bar is shown whenever a Spectrum View trace is enabled for a channel.

Table 3: Spectrum View RF vs Time, Acquisition time vs Span

Oscilloscope 6 Series / 6 Series B 6 Series B 5 Series 4 Series
25 GS/s 12.5 GS/s 6.25 GS/s 6.25 GS/s

Span Max RFVT (seconds) Max RFVT (seconds) Max RFVT (seconds) Max RFvT (seconds)
2 GHz 0.086

1.25 GHz 0.172

1GHz 0.172 0.086

500 MHz 0.344 0.172 0.086 0.021

Table continued...
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Oscilloscope 6 Series / 6 Series B 6 Series B 5 Series 4 Series
25GSIs 12.5 GS/s 6.25 GS/s 6.25 GS/s

Span Max RFvT (seconds) Max RFvT (seconds) Max RFvT (seconds) Max RFvT (seconds)

312.5 MHz 0.687 0.344 0.172 0.043

200 MHz 0.687 0.344 0.172 0.043

150 MHz 1.374 0.687 0.344 0.086

100 MHz 1.374 0.687 0.344 0.086

50 MHz 2.749 1.374 0.687 0.172

40 MHz 2.749 1.374 0.687 0.172

39 MHz 5.498 2.749 1.374 0.344

20 MHz 5.498 2.749 1.374 0.344

19 MHz 10.995 5.498 2.749 0.687

10 MHz 10.995 5.498 2.749 0.687

5 MHz 21.990 10.995 5.498 1.374

4 MHz 43.980 21.990 10.995 2.749

2 MHz 43.980 43.980 21.990 5.498

1 MHz 87.961 43.980 43.980 10.995

Example use of Spectrum Time to determine the time to a stable signal.

This example shows the use of Spectrum Time to determine the time for a spread spectrum (SS) clock to become stable after power-up.
The clock signal is centered around 98.5 MHz.

An acquisition was taken with a long enough time setting to ensure that the SS clock signal had stabilized. The RBW was set to 500 Hz,
and the Spectrum Time position was set to just before the SS clock signal became stable. See the following image.

The Spectrum Time Bar position was slowly moved to the right until a valid SS clock signal was shown in the Spectrum view, as shown in

the following image.
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Using cursors in the Waveform View, the measured time from power-up to when the SS clock signal is stable was 4.847 seconds.

Spectrum Time guidelines

+ Spectrum Time can be as long as, but never longer than, the RF acquisition time.

+ To position the Spectrum Time Bar to areas of interest, tap and drag the bar, or use the front-panel Pan knob to move the bar of the
selected Waveform View channel.

* You can set the Spectrum Time Bars to lock together across all input channels, so that moving one moves all Spectrum Time bars. The
Spectrum Time Bars can also be unlocked and moved to show the Spectrum of different portions of different channels.

+  When Spectrum Time is not locked across all channels (Lock Spectrum Time Across All Channels is not selected), and zoom is
On, the Pan front-panel knob controls the Zoom Box of the selected channel.

+  When Spectrum Time is not locked across all channels (Lock Spectrum Time Across All Channels is not selected), and zoom is
Off, the Pan front-panel knob controls the Spectrum Time Bar of the selected channel.
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Spectrum trace handle and trace types

The spectrum trace handle provides details on the trace reference level, the source channel for the trace, and which trace types are
displayed and selected.
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Figure 13: The Spectrum View trace handle elements

1.

o~ oDb

The trace's source channel (at top of the handle) and trace reference level (top edge of the handle, with dashed line extending across
the screen). Spectrum View shows the spectrum traces relative to a Reference Level reference point. The color of the handle is the
same as the source channel.

If the Reference level is outside of the displayed trace (above or below the graticule), the handle is drawn with the channel source text
pointing toward the Reference level.

A capital M indicates that the maximum trace is enabled. If the maximum trace is not enabled, this letter is not shown.

A capital A indicates that the average trace is enabled. If the average trace is not enabled, this letter is not shown.

A capital N indicates that the normal trace is enabled. If the normal trace is not enabled, this letter is not shown.

A small m indicates that the minimum trace is enabled. If the maximum trace is not enabled, this letter is not shown.

The above image shows all traces enabled and the A (Average) trace selected. Highlighting around a letter indicates that trace type is
selected.

Trace handle and trace type guidelines

There are important distinctions between enabled (displayed) and selected traces:
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An enabled trace is a trace type that is enabled in the Spectrum View panel of the source channel badge and is shown in the
spectrum view window. If the trace type is not enabled, its corresponding letter is not shown in the trace handle and there is no
corresponding trace shown on the screen.

A selected trace (highlighted around the letter) is the trace that is used for marker and cursor readouts. Only one trace type can be
selected at a time. Double-tap the trace handle to change the selected trace type.

You can enable and display any combination of trace types for each spectrum trace.
Disabling all trace types causes the spectrum view for that channel to close.

If there is only one spectrum trace shown in the Spectrum View, and you disable all trace types or turn off the spectrum function for
that channel, the Spectrum View window closes.
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Spectrum peak markers

Automatic peak markers assist with quickly identifying the frequency and amplitude of peaks in the spectrum trace. Access the marker
settings by double-tapping in a spectrum trace slice window (Stacked mode) or trace (Overlay mode) to open the Spectrum View menu.
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Figure 14: The spectrum peak markers

1. The highest peak shown is considered the Reference peak, and is labeled with a red Reference marker triangle. The Reference
marker readout (also in red) always shows the absolute amplitude and frequency of that peak, regardless of the Readout type setting
(Absolute or Delta).

2. The Automatic peak markers are hollow white triangles that mark the next highest peaks in the trace, depending on the marker
parameters.

3. Absolute readouts on markers show the actual frequency and amplitude values of the marked peaks of the selected trace.

4. Delta readouts on Automatic markers show the delta frequency and delta amplitude of the marked peaks, of the selected trace, relative
to the Reference marker readout.

Marker parameters

To set marker parameters, double-tap in the Spectrum View window and tap the Markers panel (see Spectrum View window configuration
menu on page 560). Marker parameters include:

+ Turning marker display On or Off.

«  The number of markers to display (1 to 11). Selecting 1 shows just the Reference marker.

+ The peak Threshold value, which is the minimum absolute peak level that peaks must equal or exceed to display a mark on that peak.

+ The peak Excursion value, which is the minimum magnitude (excursion range) that peaks must equal or exceed to display a mark on
a peak.

+  The type of readout values to display (Absolute or Delta).

Spectrum View and front panel controls
The front panel controls provide direct access to many spectrum-related parameters when you select the Spectrum View window.

+ The Vertical Scale knob controls the vertical scale of the currently selected spectrum trace. Note that this is purely a display function.
It does not change the source channel's volts/div setting or the reference level of the spectrum.

4/5/6 Series MSO MSO4X, MSO4XB, MSO5X, MSO5XB, MSO64, MSO6XB, MSO58LP, and LPD64 Help 151



Using Spectrum View

+ The Vertical Position knob controls the vertical position of the currently selected spectrum. This is a display function to visually
position the spectrum trace.

« Pushing the Vertical Position knob resets the vertical position such that the spectrum reference level is at the top of the slice
(Stacked mode) or the top of the display (Overlay mode).

+ The front panel vertical channel buttons only function for time domain (analog) channels. If you are in Spectrum View mode, pushing a
channel button activates the Waveform View window and selects the button's channel.

+ The Horizontal Scale knob controls span. This affects all spectrum traces.

+ The Horizontal Position knob controls center frequency. This affects all channels if center frequencies are locked. If not, it affects only
the currently selected spectrum trace.

+ Pressing the Horizontal Position knob moves the Reference Marker to center screen.

Spectrum View and badges

Spectrum View makes changes to channel badges and adds a new Spectrum badge.

When a channel is set to show a Spectrum View trace, the second row of the channel badge changes from the probe symbol or input
impedance readout to the vertical units of that channel's spectrum trace.

Ch 1
300 mV/div

When the first spectrum trace is enabled for any analog channel, the instrument opens the Spectrum View window and adds the
Spectrum badge to the Settings Bar. The first line of the Spectrum badge shows the center frequency of the selected spectrum trace.

CF1: 98.6000000 MHz
Span: 5.00000 MHz
RBW: 2.00 kHz

Tap the Spectrum badge to show the Span buttons to quickly increase or decrease the Spectrum trace span. Changing the span for one
Spectrum trace changes the span for all traces.

The Spectrum badge shows a Spectrum Time which indicates the width of the Spectrum Time bar.

Spectrum

A A

CF: 100000000 MHz
Span: 200,000 MHz
REW: 200 kHz

ST 9.500 ps

I/Q SR: 391 M5/

When more than one Spectrum trace is enabled and at least two center frequencies are defined, the Spectrum badge lists the center
frequency for each enabled Spectrum trace.

Double-tap the Spectrum badge to open the Spectrum menu to set Span, RBW, and other parameters.
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10 MHz n u Blackman-Harris v

RBW: 10.0 kHz

1303-010
The spectrum Span, RBW (resolution bandwidth), and (FFT) Window settings apply to all spectrum traces. The Center Frequency and
Spectrum Time can be set for each Spectrum trace. See the Spectrum badge menu on page 566.

Spectrum View Time Domain trace badges

The Spectrum View Time Domain traces (Magnitude Vs. Time, Frequency Vs. Time, Phase Vs. Time) are shown when you enable
these functions in the Spectrum View panel of a Channel badge configuration menu.
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CHANNEL 1

VERTICAL SETTINGS

PROBE SETUP

SPECTRUM VIEW

Ch1 chi-f

55 mV/div | 100 mV/div | 2 kHz/div 100 m°/div
11 dBm/div

1 GHz

Each time domain trace has its own badge for each channel, and each badge has its own configuration menu. Open a badge menu by
double-tapping on the badge.
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CHANNEL 1 - MAGNITUDE VS. TME ()

On . 500 mV/div u- b/

Amplitude (linear)

Chi-f Chi-¢
55 mV/div | 500 mV/div | 2 kHz/div | 100 m®/div
11 dBmvdiv

1GHz

Save and recall spectrum traces

You can save spectrum trace data to a file, and recall the trace to use as a reference trace or for other analysis purposes. Recalled
spectrum traces are shown in the Spectrum View window.

Save a spectrum trace

Use the File > Save As menu to save spectrum trace data to a specified location. See Save a waveform or spectrum trace to a
file on page 173.

In the Source field, select the spectrum trace source channel and select the spectrum trace type from the expanded list. The Source list
shows all available sources (Analog, SV_Normal, Normal, Max Hold, and so on) that are enabled in the Spectrum View panel of the
Channel badge.

Source

SV_Normal

mCch3 SV_Max_Hold

Echs > | SV_Min_Hold

SV_Average

Recall a spectrum trace

Use the File > Recall menu to navigate to and select a spectrum trace file to recall. See Recall a reference waveform or spectrum
frace on page 176. Select the spectrum trace file to recall In the Name field.

Spectrum trace file names include the name of the source channel (rf1 = Ch1, rf2 = Ch2, and so on) and the spectrum trace type (normal,
average, and so on). For example, the file name SpreadSpectrum 022 rf5 average.wfm indicates that the spectrum trace
was from channel 5, and is an averaged spectrum trace.
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Setting waveform display parameters

Use waveform display controls to set the display mode, persistence, style, and intensity display parameters, and graticule style and
intensity.

Set waveform display mode (Stacked or Overlay)
Use this procedure to change the waveform display mode (Stacked or Overlay).

1. Double-tap on an open graticule area to open the Waveform View configuration menu.
2. Tap the Display Mode buttons to toggle between Overlay and Stacked modes.

In stacked display mode, each waveform is stacked vertically in separate graticule slices. This is the default display mode.

In overlay display mode, all waveforms are displayed in a single graticule (traditional waveform view).

Set the Waveform Interpolation mode

Use this procedure to set the waveform interpolation mode, which sets how waveform data points are calculated between record data
points.
1. Double-tap on an open graticule area to open the Waveform View configuration menu.
2. Tap the buttons under Interpolation to select either Sin(x)/x or Linear.
Sin(x)/x calculates record points along a curve between the actual acquired samples. This form of interpolation is useful when
acquiring rounded waveforms such as sine waves. It is good for general-purpose uses but may introduce overshoot or undershoot

in signals with fast rise times. This interpolation is also useful for looking at high-frequency signals, especially where the frequency
components are just below the Nyquist frequency.

Linear calculates record points between actual acquired samples using a straight-line fit. This interpolation is useful for measuring
waveforms with fast rise times, such as pulse trains.

Set the waveform persistence, style, and intensity
Use the Waveform View configuration menu to set waveform persistence, style, and intensity.

1. Double-tap on an open graticule area to open the Waveform View menu.
2. Tap the Persistence field to select the persistence option.

a. Off disables display persistence.
b. Auto lets the oscilloscope automatically determine a persistence time for you.

c. Infinite persistence continuously accumulates record points until you change one of the acquisition display settings. Use infinite
persistence for displaying unique signal anomalies, such as glitches.

d. Variable persistence accumulates record points for a specified time interval. Each record point decays independently according to
the time interval. Use variable persistence for displaying infrequently appearing signal anomalies, such as glitches.
If you select Variable persistence, tap Variable Persistence Time and set the time using the multipurpose knob, or double-tap the
field and use the virtual keypad to enter the time value.
3. Tap the Waveform Style buttons to set waveforms to draw as vectors (continuous lines) or dots.

+ Vectors displays the waveform with the waveform sample values connected using the selected interpolation method.
+ Dots displays the individual waveform sample values with no interpolation.
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4. Tap the Waveform Intensity field and use the multipurpose knob to set the brightness of all waveforms.

Set the graticule style and intensity
Use this procedure to set the graticule (display grid) style and intensity.

1. Double-tap on an open graticule area to open the Waveform View configuration menu.
2. Tap the Graticule Style field to select a graticule style from the list.

+  Grid provides a grid, cross hairs, and frame on the instrument display.
+ Time provides a vertical grid of time marks, cross hairs, and frame on the instrument display.

+  Full shows a frame and a grid on the instrument display. This style is useful for making quick, full-screen measurements with
cursors and automatic readouts when cross hairs are not needed.

+ None provides a frame without a grid and cross hairs.
3. Tap the Graticule Intensity field and use the multipurpose knob to set the brightness of all graticules.

Note: Changing the graticule intensity also changes the intensity of vertical scale readouts and horizontal time readouts on
the screen. Graticule intensity does not change the intensity of callout text on the screen.
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Mask testing waveforms

Mask testing determines how well your signals conform to expected signal quality and provides instant automated statistical analysis. A
mask defines a portion of the instrument display that a signal must not enter. Mask testing is supported for analog channels, analog math
waveforms, analog reference waveforms, and RF vs. Time waveforms.

Create a Mask

Use the More button to create a new mask on the instrument display.

1.

Double-tap the More button and select the Mask button on the DRAW A BOX menu window. This sets the DRAW A BOX function to
Mask mode.

DRAW A BOX (©)

Visual e Waveform
Trigger o Histogram

Tap outside the menu to close the DRAW A BOX menu. The Draw a Box icon is highlighted to show that it is in Mask draw mode.

. Tap the Draw-A-Box Zoom icon at the up right of the Results Bar to draw a rectangle on the waveform screen for the first segment to

define. The segment created is associated with the channel to which it was added (in Stacked mode) or the active channel (in Overlay
mode).

Continue drawing rectangles to add other mask segments;:

a. Ifin Stacked mode, you can draw mask segments in different waveform slices.
b. Ifin Overlay mode, select a channel before creating segments for that channel.
When you are done drawing the mask segments, tap anywhere to end the segment draw function.

. To draw segments again, tap the Draw A Box zoom icon again.

To change the shape of a segment, see and Edit visual trigger areas using the Area menu on page 133.

Edit mask segments on the screen

Use the touchscreen or a mouse to directly edit a segment, including moving, changing size, duplicating a segment, moving individual
vertices, adding and deleting vertices, and rotating the segment.

1.

To move a mask segment, touch and drag the segment to a new position.

A Note: You cannot drag a mask segment from one waveform slice to another while in Stacked display mode.

To delete a mask segment:

a. Touch and Hold or right-click on the segment to delete.
b. Select Delete Segment from the menu.
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3. To resize a mask segment:

a. Single-tap a segment to enable resize segment mode. Resize mode draws resize points on all four sides and the corners of a
boundary area that contains the segment.

b. Touch and drag a top, bottom, left, or right resize point to resize the segment vertically or horizontally.
c¢. Touch and drag a corner resize point to resize both the length and height of the segment in the dragged direction.

A Note: You cannot move a segment while in resize mode.

d. To exit resize mode, tap outside the mask segment. The instrument returns to normal operation.
4. To add vertices to or delete vertices from a mask segment:

a. Tap a segment twice to enable add/delete vertex mode. Add/delete mode draws a crosshair at each existing vertex, and a plus
symbol midway between each existing vertex.

Note: A triangular segment does not draw the existing vertices with crosshairs, as they cannot be deleted; only the
midway plus symbols are shown to let you add vertices to a triangle.

h. Tap a vertex crosshair to delete that vertex.
c. Tap a plus symbol to add a new vertex at that location. The segment is redrawn to show the new vertex. You can continue to add
vertices; there is no limit to the number of vertices in a segment.

A Note: You cannot move vertices while in add/delete vertex mode.

d. To exit add/remove vertex mode, tap outside the mask segment. The instrument returns to normal operation.
5. To move vertices in a mask segment:
a. Tap the segment three times to enable move vertex mode. The move vertex mode draws crosshairs on all vertices of the segment.
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b. Touch and drag a vertex to move it to a new position.
c. To exit move vertex mode, tap outside the mask segment. The instrument returns to normal operation.
6. To rotate a mask segment:

a. Tap four times in the segment to enable rotate segment mode.

b. Touch and drag the dot in the segment to rotate it.

Note: Once you are touching and dragging the rotate dot, you can move your finger outside of the segment to get finer
control over the rotation increments.

c. To exit rotate segment mode, tap outside the mask segment. The instrument returns to normal operation.
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Edit mask segments using the Mask Definition menu

The Mask Definition menu allows you to edit the mask, including moving, changing size, moving individual vertices, adding and deleting
vertices, and rotating the segment. You have the choice to edit a mask by segments or waveform tolerance with the Mask Defined By
options in the Mask Settings panel.

See Mask Definition configuration menu on page 467
See Edit mask segments on the screen on page 158 for information on graphically editing a segment on the screen.

CAUTION: Do not toggle between the Mask Defined By options without saving your mask settings. When Waveform
Tolerances is selected, a mask generated by the Segment settings are replaced with a mask generated by the tolerance
fields.

See for more information on the mask settings.
1. To change the shape of a segment using the Mask Settings menu:

a. Double-tap on the segment to edit.

b. Select Segments under the Mask Defined By options.

c¢. Tap the Shape field.

d. Select the shape to which to change the segment. The segment changes shape immediately.
2. To change the height of a segment using the Mask Settings menu:

a. Double-tap on the segment to edit.
b. Select Segments under the Mask Defined By options.

c. Tap the Height field and enter the height value as units of the current vertical channel settings (volts, amps, and so on). Or
double-tap on the field and use the A knob to change the value. The shape immediately changes height while maintaining the
vertical center position of the segment.

3. Tochange the vertical center of a segment using the Mask Settings menu:

a. Double-tap on the segment to edit.
b. Select Segments under the Mask Defined By options.

c. Tap the Vertical Center field and enter the height value as units of the current vertical channel settings (volts, amps, and so on).
Or double-tap on the field and use the A knob to change the value. The shape immediately changes the vertical center position
of the segment.

4,  To change the width of a segment using the Mask Settings menu:

a. Double-tap on the segment to edit.
b. Select Segments under the Mask Defined By options.

c¢. Tap the Width field and enter the width value as horizontal time (seconds). Or double-tap on the field and use the A knob to
change the value. The shape immediately changes width while maintaining the horizontal center position of the segment.

5.  To change the horizontal center of a segment using the Mask Settings menu:

a. Double-tap on the segment to edit.
b. Select Segments under the Mask Defined By options.

c. Tap the Horizontal Center field and enter the new horizontal center position value. Or double-tap on the field and use the A knob
to change the value. The shape immediately changes the horizontal center position.

6. Toflip a segment vertically using the Mask Settings menu:

a. Double-tap on the segment to edit.

b. Select Segments under the Mask Defined By options.

c. Tap the Flip Vertical button. The segment immediately flips vertically around its center position.
7.  Toflip a segment horizontally using the Mask Settings menu:
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10.

1.

12.

13.

14.
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a. Double-tap on the segment to edit.

b. Select Segments under the Mask Defined By options.

c. Tap the Flip Horizontal button. The segment immediately flips horizontally around its center position.
To rotate a segment using the Mask Settings menu:

a. Double-tap on the segment to edit.
b. Select Segments under the Mask Defined By options.

c. Tap the Rotate field and use the A knob to change the value. The segment immediately rotates when you enter a value or
change the value with the A knob. Or double-tap on the field and enter the number of degrees to rotate the segment, where zero
(0) degrees is the position when the segment was created. You can rotate a segment from 0° to 360°.

To add a point (vertex) to a segment using the Edit Vertices menu:

Double-tap on the segment to edit.
Select Segments under the Mask Defined By options.
Tap the Edit Vertices panel.

Select the vertex in the Define Area list counter-clockwise from you want to insert a new vertex. Selecting a vertex highlights that
vertex on the segment.

e. Tap Insert Point. A new vertex is added to the segment, marked with an X, and is highlighted in the list.
f. Continue adding vertices as needed.
To delete a point (vertex) from a segment using the Edit Vertices menu:

a0 T

Double-tap on the segment to edit.

Select Segments under the Mask Defined By options.

Tap the Edit Vertices panel.

Select the vertex in the Define Area list that you want to delete. Selecting a vertex highlights that vertex on the segment.
Tap Delete Point. A new vertex is added to the segment, marked with an X, and is highlighted in the list.

Continue deleting vertices as needed.

To move individual vertices in a segment using the Edit Vertices menu:

™o o0 T W

Double-tap on the segment to edit.

Select Segments under the Mask Defined By options.

Tap the Edit Vertices panel.

Select the vertex in the Define Area list that you want to move. Selecting a vertex highlights that vertex on the segment.

Tap the X (time) axis or Y (Ampl.) field in the list and use the A and B knobs to change the position values. Or double-tap on
each field and enter the new positional values for that vertex.

To reset the shape using the Edit Vertices menu:

®» o0 oo

a. Double-tap on the segment to edit.
b. Select Segments under the Mask Defined By options.

c. Tap the Edit Vertices panel.

d. Tap Reset Points. The shape changes to a triangle centered in the display or slice.
To save the segment edits:

a. Tap the Save panel.

b. Tap Save Mask. Only edits to the segment settings are saved.

c¢. Tap outside the menu to exit.

To change the vertical tolerance of a segment using the Mask Settings menu:

a. Double-tap on the segment to edit.
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b. Select Waveform Tolerances under the Mask Defined By options.

c. Tap the Vertical Tolerance field and enter the tolerance value as units of the current channel settings (volts, amps, and so on).
Or double-tap on the field and use the A knob to change the value.

d. Tap the Update Mask Now button to immediately change the vertical tolerance of the segment.
15. To change the horizontal tolerance of a segment using the Mask Settings menu:

a. Double-tap on the segment to edit.
b. Select Waveform Tolerances under the Mask Defined By options.

c. Tap the Horizontal Tolerance field and enter the tolerance value as units of the current channel settings (volts, amps, and so
on). Or double-tap on the field and use the A knob to change the value.

d. Tap the Update Mask Now button to immediately change the horizontal tolerance of the segment.
16. To save the waveform tolerance edits:

a. Tap the Save panel.
b. Tap Save Mask. Only edits to the waveform tolerance settings are saved.
¢. Tap outside the menu to exit.
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Waveform histogram

Histograms visually shows the distribution of how many sample points fall in selected section of waveform record. Waveform Histogram
provides you tool to statistically analyze the waveforms using histograms in the graticule. This helps you to quickly determine how your
device is responding to the inputs at discrete intervals of time and make the right decisions to change the device parameters.

Create a waveform histogram
Use the More button to create a waveform histogram on the instrument display.

1. Tap the More button and select the Waveform Histogram button in the DRAW A BOX menu window. This sets the DRAW A BOX
function to Waveform Histogram mode.

DRAW A BOX

i
i Visual
Trigger

2. Tap outside the menu to close the DRAW A BOX menu. The DRAW A BOX icon is highlighted to show waveform histogram draw
mode is active.

3. Draw a rectangle on the waveform screen. The rectangle created is associated with the channel to which it was added (Stacked mode)

or the active channel (Overlay mode).
4. Double-tap the DRAW A BOX button to add multiple histograms in the areas of interest of waveform record.
5. Continue drawing histograms on different waveforms:

a. In Stacked mode, you can draw histograms in different waveform slices.

b. In Overlay mode, select a channel before creating histograms for that channel.
6. When you are done drawing the histogram, tap anywhere to end the histogram draw function.
7. To draw a new histogram box again, tap the DRAW A BOX button again.

Edit histogram on the screen
Use the touchscreen or a mouse to directly edit a histogram, including moving, changing size, duplicating a histogram.

1. To move a histogram, drag the histogram box to a new position.

A Note: You cannot drag a waveform histogram from one waveform slice to another while in Stacked display mode.

2. To delete a histogram:

+ Touch and hold or right-click on the histogram and select Delete Histogram or Delete All Histograms from the menu.
+Touch and hold or right-click on the histogram badge and select Delete Histogram or Delete All Histograms from the menu.
+  Select the histogram badge and press the Delete key on the keyboard.

3. Toresize a histogram:

a. Single-tap a histogram to enable resize histogram mode. Resize mode draws resize points on all four sides and the corners of a
boundary area that contains the histogram.
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b. Touch and drag a top, bottom, left, or right resize point to resize the histogram vertically or horizontally.
c¢. Touch and drag a corner resize point to resize length and height of the histogram in a direction.

A Note: You cannot move a histogram while in resize mode.

Waveform Histogram guidelines

The waveform histogram is based on a single source.
You can draw unlimited histograms per source waveform.

The waveform histogram are supported on analog channels, analog math waveforms, analog reference waveforms, and RF vs. Time
waveforms.

The waveform histograms are compatible with FastAcq, it only update with the intermittent waveforms that are sent to host for analysis
processing as opposed to being updated with every waveform acquired by FastAcg.

The waveform histograms are compatible with Fast Frame, it shows accumulated view across all frames.

The waveform histograms are compatible with History acquisitions, it shows accumulated view across all acquisitions.

The waveform histograms are compatible with roll mode.

The waveform histogram are not supported on Digital channels, Bus waveforms, Time-trend waveforms, and Math FFTs.

A single waveform histogram can be either vertical or horizontal, but not both.

Measurement Results Table includes result from histogram measurements that appear in the one or more histogram results badges.

To add measurement results table for waveform histogram, see Add Results Table configuration menu on page 343
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Zoom in on waveforms

Use the zoom tools to magnify waveforms to view signal details.

Turn on Zoom mode

Zoom mode lets you look at a portion of your waveform in greater detail. Enable Zoom mode and touch and drag on-screen to select the
area to zoom.

To enable Zoom mode, use one of the following methods:

1. Double-tap the More button and select the Zoom button on the DRAW A BOX menu window. This sets the Draw-a-Box function to
Zoom mode.

DRAW A BOX

Tap the Draw-A-Box Zoom icon button at the up right of the Results Bar, then touch and drag in the Waveform view to draw a box on
the area of interest. The Zoom mode stays enabled so that you can draw boxes to zoom in different areas of the Zoom Overview, or
draw boxes to further zoom in on the same area.

2. Push the front-panel Zoom button.

HORIZONTAL
Position « E:ﬁ'“
m to Center
Scale
Navigate
m Fine

3514-014

3. Tap the Zoom icon in the corner of Waveform and Plot views.

4. Zoom overview:
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a. To use Zoom once enabled, tap the zoom icon touch and draw a box around an area of interest in the Waveform or Plot view to
immediately display the zoomed waveform and the Zoom Overview window.

b. You can draw boxes in the Waveform view, most plots, and the Zoom Overview area.

c. The Zoom mode stays enabled so that you can draw boxes to zoom in different areas of the Zoom Overview, or draw boxes to
further zoom in on the same area.

d. Single-tapping anywhere disables the zoom box draw mode.

e. To exit the zoom display mode, tap the Zoom icon in the corner of Waveform and Plot views, or push the front-panel Zoom button.
5. For more information on zoom:

«  Zoom user interface on page 68

+  Zoom mode and Searches on page 167
+  Using Wave Inspector front-panel controls for zoom on page 167

Using Wave Inspector front-panel controls for zoom

Use the Wave Inspector controls to increase or decrease the area of the zoom box and to control the part of the waveform shown in the
main Zoom view.
1. Push the front-panel Zoom button to open Zoom mode. Push the Zoom button again to exit zoom mode.

2. Turn the Zoom knob (center knob) to increase or decrease the horizontal area of the zoom box in the Zoom Waveform Overview,
which in turn controls the amount of the waveforms shown in the main Zoom view.

3. Turn the Pan knob (outer knob) to move the Zoom box left or right in the Zoom Waveform Overview, which in turn controls the part of
the waveform shown in the main Zoom view.

4. Forinformation on the Zoom interface, see Zoom user interface on page 68.

Zoom mode and Searches
Use Zoom and Searches to find events of interest on a waveform.

Searches provide a way to mark a waveform event or events for reference. You can set marks automatically with search criteria such as
particular edges, pulse widths, runts, logic states, rise/fall times, setup and hold, and bus data types.

When in Zoom mode, you can use the front-panel left and right arrow buttons to position the waveform in the Zoom Overview and Zoom
View window to the previous or next search mark on the waveform. Push and hold a front-panel navigation button to continuously step to
and show the next search mark.

You can also tap a Search badge and use its navigation buttons to position the waveform to previous or next search marks.
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Search tables and Zoom mode

+  When you select a row in the Search Results Table, Zoom mode adjusts the position of the zoom window to place the selected search
event in the middle of the zoom window.

+ If zoom was not already on, it is turned on with its previous zoom factor and the zoom window position adjusted to show the selected
search event.

+ When a Search Results Table is selected, Multipurpose knob A is assigned to the index column. Use knob A to scroll through the table
and display the selected event in the zoom window.

+ If you pan (move horizontally) the zoom window by dragging it, or by using the front panel Pan control, the search table highlights
which (if any) search result is at the center of the zoom window.

For information on creating a Search, see Add a Search on page 107.
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Measurement configuration

After adding a measurement, you can customize the measurement for more precise results.

To customize measurements, double-tap a Measurement badge in the Results bar to open the measurement configuration menu.

Label a measurement

Use this procedure to add a custom label to a measurement.
Measurement labels appear on the Measurement badge and can be added to Results tables.

Labels are set in the Measurement panel of the Measurements configuration menu. See Measurement configuration menu
overview on page 211.

Prerequisite: To set measurement reference levels you must be taking a measurement. See Add a measurement on page 96.

1. Double-tap a Measurement badge in the Results bar to open the Measurement configuration menu.
2. Tap the Configure panel.
3. Use one of the following methods to enter label text:

+ Tap the Label field and enter the label text using a keyboard and press the keyboard Enter key to add the label text to the
Measurement badge.

+ Double-tap the Label field and enter the label text using the virtual keyboard, then tap the Enter button to add the label text to the
Measurement badge. Tap outside the virtual keyboard to close it.

Note: The new label text replaces the default measurement name on the Measurement badge that shows the measurement
type (Frequency, Peak-to-Peak, and so on). To view the measurement type for a relabeled measurement, double-tap the
Measurement badge and look at the topmost panel name, which has the measurement name.

Custom measurement labels can be added to a Results table.
4. Tap anywhere outside the Measurement menu to close it.

Set measurement reference levels

Use this procedure to set measurement reference levels.

Reference levels are set in the Reference Levels panel of the Measurements configuration menu. See Measurement configuration menu
overview on page 211.

Prerequisite: To set measurement reference levels you must be taking a measurement. See Add a measurement on page 96.

Procedure

1. Double-tap a Measurement badge. The Measurement configuration menu is displayed.
2. Tap the Reference Levels panel.
3. Select either Global (default) or Local:

+ Global causes changes in this panel to be updated in all other measurements that also have Global selected in this panel.
When switching from Global to Local:

+  If a specific measurement has not been set to Local before then no changes are made to any of the values. You can update the
parameters.

+ If a specific measurement has been set to Local before, then changed back to Global and then again switched to Local, the last
used Local values are shown.
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+ Local causes changes in this panel to only effect this measurement. When switching from Local to Global, all fields will update to
the current Global parameters.

Tap Set Levels In and select either % or Absolute.

+ % sets the High, Mid, and Low reference levels as percentages of the calculated Top and Base signal levels. Tap the Levels 10% -
90%, 20% - 80%, or Custom button to select the type of percent value to set.
+ 10% - 90% sets the Low, Mid and High Ref values to 10%, 50% and 90% respectively for both rising and falling edges.
+ 20% - 80% sets the Low, Mid and High Ref values to 20%, 50% and 80% respectively for both rising and falling edges.

+ Custom opens the Rising and Falling Edge numeric entry fields to set High, Mid and Low Ref levels to different values for the
rising and falling edges of a waveform. Tap the Rising Edge and Falling Edge High, Mid, or Low fields and set the level using
the assigned multipurpose knob. Or double-tap the field and use the virtual keypad to enter a value.

+ Absolute sets the High, Mid, and Low reference levels to specific signal levels. Tap the Levels Same or Unique buttons to select
the type of absolute value to set.

+ Same sets the High, Mid, and Low reference for both rising and falling edges of a signal to the specified values. Tap the
Threshold High, Mid, or Low field and set the threshold using a multipurpose knob. Or double-tap the field and use the virtual
keypad to enter a value.

+ Unique opens the Rising and Falling Edge numeric entry fields to set High, Mid and Low Ref levels to different values for the
rising and falling edges of a waveform. Tap the Rising Edge and Falling Edge High, Mid, or Low fields and set the level using
the assigned multipurpose knob. Or double-tap the field and use the virtual keypad to enter a value.

Tap the Base Top Method drop down tab and select the method from the list. This setting is only available when using the % level
setting.

Touch Hysteresis and use the assigned multipurpose knob to set the value.

. Tap anywhere outside the Measurement configuration menu to close it.

Set measurement gates

Use this procedure to specify which portion of your waveform is used to take measurements.

Gating is set in the Gating panel of the Measurements configuration menu. See Measurement configuration menu overview on page 211.

To set measurement gates you must be taking a measurement. See Add a measurement on page 96.

Procedure

1.
2.
3.
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Double-tap a measurement badge to open the Measurement configuration menu.
Tap the Gating panel.
Tap Gating and select either Global or Local gating:

+ Global causes changes in this panel to be updated in all other measurements that also have Global selected in this panel.
When switching from Global to Local:
+ If a specific measurement has not been set to Local before then no changes are made to any of the values. You can update
the parameters.

+ If a specific measurement has been set to Local before, then changed back to Global and then again switched to Local, the
last used Local values are shown.

+ Local causes changes in this panel to only effect this measurement. When switching from Local to Global, all fields will update to
the current Global parameters.

Tap the Gating Type drop down tab and select the gating type from the list:

* None takes measurement across the entire waveform record.



Measurement configuration

10.
1.

+ Screen takes measurements on that portion of the waveform shown in the display. When Zoom is on, the display is the zoom
window.

+ Cursors takes measurements on that portion of the waveform between the cursors. Selecting Cursors opens cursors on the
measurement source. Set the cursors so that the waveform area of interest is between the cursors.

+ Logic takes measurements only when the logical state of a specified waveform is true. If Logic gating is selected, continue with
the following steps.

+ Search takes measurements between the start and stop times defined by a specified search. Search gating is only valid for
optional DDR3 measurements on a 6 Series MSO instrument.

+ Time takes measurements between the times specified in the Start Gate Time and End Gate Time fields, relative to the trigger
point.

For the Logic and Search gates, tap the Source field and select the source from the list.

For the Logic gate, tap the Threshold field and use the assigned multipurpose knob to set the desired threshold dividing a logic Low
or High state.

For the Logic gate, tap the Hysteresis field and use the assigned multipurpose knob to set the desired hysteresis.

For the Logic gate, tap Active and select either the High or Low active state. High sets the gating to take measurements when the
specified waveform is an active High. Low sets the gating to take measurements when the specified waveform is an active Low logic
state.

Tap anywhere outside the Measurement configuration menu to close it.
Tap on a gating-enabled measurement badge to display the vertical gate bars on the waveform for that measurement.
To return measurement gating to its default value, open the Gating panel and select a gating type of None.

Set measurement filters

Use this procedure to set measurement filters.

Filters are set in the Filter/Limit Results panel of the Measurements configuration menu. See Measurement configuration menu
overview on page 211.

To set measurement filters you must be taking a measurement. See Add a measurement on page 96.

Procedure

1.
2.
3.

Double-tap a Measurement badge in the Results bar to open the Measurement configuration menu.
Tap the Filter/Limit Results panel.
Select either Global or Local.

+ Global causes changes in this panel to be updated in all other measurements that also have Global selected in this panel.
When switching from Global to Local:
+ If a specific measurement has not been set to Local before then no changes are made to any of the values. You can update the

parameters.

+ If a specific measurement has been set to Local before, then changed back to Global and then again switched to Local, the last
used Local values are shown.

+ Local causes changes in this panel to only effect this measurement. When switching from Local to Global, all fields will update to
the current Global parameters.

Tap the High Pass Filter field and select the type of filter from the drop down list.

If you select a filter other than None, tap the HPF Freq (F1) field and set the frequency using the assigned multipurpose knob. Or
double-tap the field and use the virtual keypad to enter a value.

Tap the Low Pass Filter field and select the type of filter from the drop down list.
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If you select a filter other than None, tap the LPF Freq (F2) field and set the frequency using the assigned multipurpose knob. Or
double-tap the field and use the virtual keypad to enter a value.

6. Tap anywhere outside the Measurement configuration menu to close it.

Set measurement limits

Use this procedure to set measurement limits. Measurement limits let you set boundaries to eliminate nonrelevant values from a
measurement.

Measurement limits are set in the Filter/Limit Results panel of the Measurements configuration menu. See Measurement configuration
menu overview on page 211.

To set measurement limits you must be taking a measurement. See Add Measurements configuration menu overview on page 189.

1. Double-tap a Measurement badge in the Results bar to open the Measurements configuration menu.
2. Tap the Filters/Limit Results panel.
3. Tap Limit Measurement Results to let you restrict displayed measurements to only those that are within a specified range.
+  Tap the Min Value field and set the minimum acceptable measurement value using the assigned multipurpose knob. Or double-tap
the field and use the virtual keypad to enter a value.

+ Tap Max Value and set the maximum acceptable measurement value using the assigned multipurpose knob. Or double-tap the
field and use the virtual keypad to enter a value.
4. Tap Limit Measurement Population to let you set the number of measurement acquisitions (population) to acquire before stopping
acquisitions for this measurement.

Tap the Limit field and set the population limit using the assigned multipurpose knob. Or double-tap the field and use the virtual keypad
to enter a value.

Note: If Limit Measurement Results and Limit Measurement Population are both On, the values in the Measurement badge
are for the number of measurement acquisitions set in the population Limit field that were within the Limit Measurement
Results settings.

5. Tap anywhere outside the Measurement configuration menu to close it.
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Saving and recalling information

Use these procedures to save or recall waveforms, setups, or sessions.

Save a screen image

Use this procedure to save a screen image.

1.

Tap the File menu and select Save As.

The Save As configuration menu opens.

2. Tap Screen Capture to open the Screen Capture tab.
3. Tap Save Location or Browse to select the location to save the file.

a. Tap the drop down arrow in the Save Location field and select the location to save the file from a list of recent save locations. Or
double-tap the field and use the virtual keyboard to enter a path to the save location.

b. Tap Browse to open the Browse Save As Location configuration menu to navigate to and select a location at which to save the file.

Tap File Name shows the name last used to save a file. The default name is Tek000. To change the file name, double-tap the file name
and enter a new file name using the virtual keyboard.

Tap Auto Increment File Name to enable or disable automatic incrementing of a file name. Auto Increment File Name lets you save
sequential files without needing to manually rename them each time. The count number is added to the end of the file name.

+ If Auto Increment File Name is enabled the Count defaults to 000 if there are no files at the specified location and file name that
already use incremented file names. If there are files at the save location that already use the specified file name, and have already
been saved using count increments, the Count field shows the next count value that will be added to the file name when the file is
saved.

+ To change the starting count value, tap the Count field and use the assigned knob to change the value, or double-tap the field and
use the virtual keypad to change the value.

6. Tap Save As Type and select the desired graphic image file type from the list.

Tap Save to save the screen image to the specified file name, location, and type.

Note: Once you have saved a file using the Save As configuration menu, you can push the front-panel User button to
immediately save the same type file again, without opening any menus.

Save a waveform or spectrum trace to afile

Use this procedure to save channel waveform (analog or digital) data to a comma-separated values (csv) or Tektronix waveform data
(wfm) file, for later analysis or inclusion in reports. You can also save Spectrum View traces to files.

1.

Tap the File menu and select Save As.

The Save As configuration menu opens.

2. Tap Waveform to open the Waveform tab.
3. Tap Save Location or Browse to select the location to save the file.

a. Tap the Save Location drop down arrow and select the location to save the file from a list of recent save locations. Or double-tap
the field and use the virtual keyboard to enter a path to the save location.

b. Tap Browse to open the Browse Save As Location configuration menu to navigate to and select a location at which to save the file.

File Name shows the name last used to save a file. The default name is Tek000. To change the file name, double-tap the file name and
enter a new file name using the virtual keyboard.

Tap Auto Increment File Name to enable or disable automatic incrementing of a file name. Auto Increment File Name lets you save
sequential files without needing to manually rename them each time. The count number is added to the end of the file name.
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8.

+ If Auto Increment File Name is enabled the Count defaults to 000 if there are no files at the specified location and file name that
already use incremented file names. If there are files at the save location that already use the specified file name, and have already
been saved using count increments, the Count field shows the next count value that will be added to the file name when the file is
saved.

+ To change the starting count value, tap the Count field and use the assigned knob to change the value, or double-tap the field and
use the virtual keypad to change the value.

Tap Save As Type and select the desired waveform data type from the list.
Tap Source and select the source of the waveform to save from the list. You can save a single waveform or all waveforms.

The Source menu shows a right arrow in the source list if a source has more than one waveform available to save, such as an analog
channel and its corresponding spectrum trace(s). Tap the source menu item to expand that item to show available waveform sources.
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Tap Save to save the waveform to the specified file name, location, and type.

Note: Once you have saved a file using the Save As configuration menu, you can push the front-panel User button to
immediately save the same type file again, without opening any menus.

Save instrument settings to a file

Use this procedure to save instrument settings to a Tektronix setup (.set) file.

1.

Tap the File menu and select Save As.

The Save As configuration menu opens.

2. Tap Setup to open the Setup tab.
3. Tap Save Location or Browse to select the location to save the file.
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a. Tap the Save Location drop down arrow and select the location to save the file from a list of recent save locations. Or double-tap
the field and use the virtual keyboard to enter a path to the save location.

b. Tap Browse to open the Browse Save As Location configuration menu to navigate to and select a location at which to save the file.

File Name shows the name last used to save a file. The default name is Tek000. To change the file name, double-tap the file name and
enter a new file name using the virtual keyboard.

Tap Auto Increment File Name to enable or disable automatic incrementing of a file name. Auto Increment File Name lets you save
sequential files without needing to manually rename them each time. The count number is added to the end of the file name.

+ If Auto Increment File Name is enabled the Count defaults to 000 if there are no files at the specified location and file name that
already use incremented file names. If there are files at the save location that already use the specified file name, and have already
been saved using count increments, the Count field shows the next count value that will be added to the file name when the file is
saved.
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+ To change the starting count value, tap the Count field and use the assigned knob to change the value, or double-tap the field and
use the virtual keypad to change the value.

6. Enable Include Reference Waveforms to include waveform files for all active waveforms in the setup file.
7. Tap Save to save the setup information to the specified file name and location.

Note: Once you have saved a file using the Save As configuration menu, you can push the front-panel User button to
immediately save the same type file again, without opening any menus.

Save reports
Use this procedure to save reports.
1. Tap the File menu and select Save As.

The Save As configuration menu opens.

Tap Report to open the Report tab.

Tap Save Location or Browse to select the location to save the file.

a. Tap the Save Location drop down arrow and select the location to save the file from a list of recent save locations. Or double-tap
the field and use the virtual keyboard to enter a path to the save location.

b. Tap Browse to open the Browse Save As Location configuration menu to navigate to and select a location at which to save the
file.

4.  File Name shows the name last used to save a file. The default name is Tek000. To change the file name, double-tap the file name
and enter a new file name using the virtual keyboard.

5.  Tap Auto Increment File Name to enable or disable automatic incrementing of a file name. Auto Increment File Name lets you save
sequential files without needing to manually rename them each time. The count number is added to the end of the file name.

+ If Auto Increment File Name is enabled the Count defaults to 000 if there are no files at the specified location and file name
that already use incremented file names. If there are files at the save location that already use the specified file name, and have
already been saved using count increments, the Count field shows the next count value that will be added to the file name when
the file is saved.

+ To change the starting count value, tap the Count field and use the assigned knob to change the value, or double-tap the field
and use the virtual keypad to change the value.

6. Tap Save As Type and select the report file format from the list.

7. Tap Append Report to enable appending this report to a previous report that uses the same file name.
8.  Double-tap Comments and use the virtual keyboard to add descriptive comments to the report.

9. Tap Include Images and Annotations to include screen images and annotations in the report.

10. Tap Include Setup Configuration to include the instrument settings data in the report.

11. Tap Save to save the report file to the specified file name, location, and type.

Note: Once you have saved a file using the Save As configuration menu, you can push the front-panel User button to
immediately save the same type file again, without opening any menus.

Save sessions

Use this procedure to save a session file. A session file contains instrument setup information, measurements, reference waveforms of
active signals, plots, and eye diagram masks if enabled.

1. Tap the File menu and select Save As.

The Save As configuration menu opens.
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2. Tap Session to open the Session tab.
3. Tap Save Location or Browse to select the location to save the file.

a. Tap the Save Location drop down arrow and select the location to save the file from a list of recent save locations. Or double-tap
the field and use the virtual keyboard to enter a path to the save location.

b. Tap Browse to open the Browse Save As Location configuration menu to navigate to and select a location at which to save the file.

File Name shows the name last used to save a file. The default name is Tek000. To change the file name, double-tap the file name and
enter a new file name using the virtual keyboard.

Tap Auto Increment File Name to enable or disable automatic incrementing of a file name. Auto Increment File Name lets you save
sequential files without needing to manually rename them each time. The count number is added to the end of the file name.

+ If Auto Increment File Name is enabled the Count defaults to 000 if there are no files at the specified location and file name that
already use incremented file names. If there are files at the save location that already use the specified file name, and have already
been saved using count increments, the Count field shows the next count value that will be added to the file name when the file is
saved.

+ To change the starting count value, tap the Count field and use the assigned knob to change the value, or double-tap the field and
use the virtual keypad to change the value.

Tap Save to save the session data to the specified file name, location, and type.

Note: Once you have saved a file using the Save As configuration menu, you can push the front-panel User button to
immediately save the same type file again, without opening any menus.

Recall a reference waveform or spectrum trace

Use this procedure to recall (load) and display a saved waveform or spectrum trace as a Reference waveform. There is no set limit to the
number of reference waveforms that you can load and display.

1.

Tap the Math Ref Bus >Add New Ref button on the Settings bar.

The Recall configuration menu opens to the last location used to recall a waveform or spectrum trace file. If the location is not
available, the menu defaults to the instrument C drive.

Tap Files of Type: and select the file type from the list.

The files list updates to show all files that match the selected file type.
Tap the file name in the list to add the file to the File Name field.

. Tap Open to exit the menu and add the reference waveform to the screen.

5. If the file location shown in the Look In field does not contain the file to recall, navigate to the folder that contains the file to recall,
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using one of the following methods:
+ To recall files from recently accessed file locations, tap the drop down arrow in the Look in field and select from the list of recently
accessed locations.

+ Tapin the Drive column and use the displayed contents to navigate to locations on the internal storage location C, a connected
USB drive (E -K), or a network-connected drive.

+  Double-tap the Look in field and use the virtual keyboard to manually enter a path to the file location (folder).

As you navigate the folders, the files list area shows all files that match the file type selected in the Files of Type field.
Select the file to recall, using one of the following methods:

+ If the file was recently recalled, tap the drop down arrow in the File Name: field and select from a drop-down list of recently
recalled files.

+  Select a file name in the main files list. The file Name field updates to show the selected file name.

A Note: You can double-tap on a file name to immediately recall the file and close the menu.
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7. Tap Recall.

The reference waveform is loaded and displayed, and a Ref badge is added to the Settings bar. If you recalled a spectrum trace
waveform, that waveform is shown in the Spectrum View window, with the handle name of R1, R2, and so on.

Recall a Setup file
Use this procedure to recall (load) and configure instrument settings from a Setup file.

1. Select File > Recall from the Menu bar to open the Recall configuration menu.
2. Tap Setup to open the Setup tab.

The Recall configuration menu opens to show the settings last used to recall a setup file.
3. Tap Files of Type: and select the file type from the list.

The files list updates to show any files that match the selected file type.
4. Navigate to the folder that contains the file to recall, using one of the following methods:

+ To recall files from recently accessed file locations, tap the drop down arrow in the Look in field and select from the list of recently
accessed locations.

+ Tapin the Drive column and use the displayed contents to navigate to locations on the internal storage location C, or on a
connected USB drive (E -K).

+ Double-tap the Look in field and use the virtual keyboard to manually enter a path to the file location (folder).

As you navigate the folders, the files list area shows all files that match the file type selected in the Files of Type field.
5. Select the file to recall, using one of the following methods:

+ Ifthe file was recently recalled, tap the drop down arrow in the File Name: field and select from a drop-down list of recently
recalled files.

+ Select a file name in the main files list. The File Name field updates to show the selected file name.

A Note: You can double-tap on a file name to immediately recall the file and close the menu.

6. Tap Recall.

The instrument loads the setup file and reconfigures the oscilloscope to the setup file settings.

Recall a Session file
Use this procedure to recall (load) instrument settings and associated waveforms (as Reference waveforms) from a Session file.

1. Select File > Recall from the Menu bar to open the Recall configuration menu.
2. Tap Session to open the Session tab.

The Recall configuration menu opens to show the settings last used to recall a session file.

3. Tap Files of Type: and select the file type from the list.

The files list updates to show any files that match the selected file type.
4. Navigate to the folder that contains the file to recall, using one of the following methods:
+ To recall files from recently accessed file locations, tap the drop down arrow in the Look in field and select from the list of recently
accessed locations.

+ Tapin the Drive column and use the displayed contents to navigate to locations on the internal storage location C, oron a
connected USB drive (E -K).
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+  Double-tap the Look in field and use the virtual keyboard to manually enter a path to the file location (folder).

As you navigate the folders, the files list area shows all files that match the file type selected in the Files of Type field.
Select the file to recall, using one of the following methods:

+ If the file was recently recalled, tap the drop down arrow in the File Name: field and select from a drop-down list of recently
recalled files.

+ Select a file name in the main files list. The File Name field updates to show the selected file name.

A Note: You can double-tap on a file name to immediately recall the file and close the menu.

Tap Recall.

The instrument loads the session file and reconfigures the oscilloscope to the session file settings.

Open a mask test file for an Eye Diagram plot

Use this procedure to open (load) and display an eye diagram mask for an eye diagram plot.

Pre

requisites:

An eye diagram plot. To display an eye diagram plot, see Display an Eye Diagram plot on page 103.

An eye diagram mask file that defines at least three segments.

An eye diagram mask file that matches the time scale (unit interval) and vertical settings of the eye diagram.

1.

2
3.
4
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Double-tap anywhere in the eye diagram plot to open the plot configuration menu.

. Tap the Mask panel.

Tap Browse.

. Use the Browse Mask File Location menu to navigate to and select an eye diagram mask file. See Recall Mask File configuration

menu on page 529.

If the file was recently recalled, tap the arrow in the File Name: field and select from the list of recently recalled files.

A Note: You can double-tap on a name in the File Name field to immediately recall the file and close the menu.

Tap Recall to close the menu and display the three eye diagram masks in the eye diagram plot.



Menus and dialog boxes

Menus and dialog boxes

All of the menus on your instrument and the available settings within each menu.

Act On Event configuration menu

Use this configuration menu to set the actions the instrument takes when specified conditions are met (trigger event, measurement limit
failure, mask hit failure, and so on).

To open the Act On Event menu, select the Act On Event button in menus where this button is available.

Act On Event menu fields and controls

Displayed fields and controls can change depending on menu selections.

ACT ON EVENT

ACTIONS TO TAKE
Discrete
Events

SAVE CONFIGURATION >

Field or control | Description

Actions To Take panel

Act on Event On/Off Allows you to configure Act On Event before enabling. If the maximum number of saves is hit, this
control turns off.

Event Type Select the event type as Discrete Events or Timer Events for saving screen capture, measurement

result statistics logging, and saving waveforms.

Note: The Timer events does not work with Single/sequence. It runs for Run/Stop
sequencing only.

Timer Interval Sets the time interval between two timer events. Available when Event Type is Timer Events.

Count Sets number of timer events that should happen before stopping Run/Stop sequencing. Available
when Event Type is Timer Events.

Table continued...
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Field or control

Description

Save Screen Capture

Saves the screen image at the time of the event, to the format designated in the Save Configuration
panel.

Save Waveform Saves the waveform data at the time of the event, to the format designated in the Save Configuration
panel.

Stop Acquisitions Stops the instrument from acquiring any more data.

SRQ This is a signal sent via the VISA connection to alert listeners that an event has occurred. Enabling
this will send such an event when the action has occurred and if the status registers are configured
correctly.

Number of Saves Allows you to toggle between Unlimited or Specify a Maximum for number of saves. Default option
selected is Unlimited.

Maximum Enter the maximum number of saves in the text field. This is enabled when Number of Saves is set to

Specify a Maximum.

Save Configuration panel

Save Location

Choose the location of the saved files when an action triggers a save event.

Browse

Browse to the save location through a visual file tree.

File Name

Name the saved file. When a file is saved, the file name is followed by a time stamp.

Screen Capture Format

Choose format of the screen capture save files.

Waveform Format

Choose waveform format for the screen capture save files.

Source

Choose the source for the waveform save files.

Actions guidelines

Al actions are taken on a per acquisition basis. This means that if Save Screen Capture is checked in multiple columns and during a
single acquisition the criteria is met in multiple columns, only a single screen capture is saved.

+  For a timer event if there is no change in waveform dataset, the active measurement does not compute and log, instead shows an *
symbol next to the measurement in the selected log file.

+ The waveform save and screen capture save happens even if the waveform data is same for the two timer events.

+ Ifthere is no change in the waveform dataset and if any measurement configuration changed in between two timer events then the
measurements are computed and the measurement result statistics are added in the log file (without * symbol).

Acquisition configuration menu

Use this configuration menu to set which data points are used to acquire waveforms, and enable automatically saving acquisitions to files.

The Acquisition menu fields and controls

To open the Acquisition menu, double-tap the Acquisition badge on the Settings bar.

Displayed fields and controls can change depending on menu selections.

Field or control

Description

Run/Stop Toggles the oscilloscope between constant acquisition (Run) and no acquisitions (Stop). When
stopped, the oscilloscope shows waveforms from the last completed acquisition.
Single/Seq Acquires a single acquisition or a set number of acquisitions, then stops.

Table continued...
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Field or control

Description

Clear

Erases acquired waveform data points from memory. Applies to all live acquisition waveforms.

Acquisition Mode

Sample creates a record point by saving one or more samples during each acquisition interval.
Sample mode is the default acquisition mode. The instrument does no post processing of the acquired
samples in this mode.

Peak Detect alternates between saving the highest sample in one acquisition interval and the lowest
sample in the next acquisition interval. Useful for capturing fast and random events such as narrow
waveform pulses.

High Res applies unique finite impulse response (FIR) filters based on the current sample rate. This
FIR filter maintains the maximum bandwidth possible for that sample rate while rejecting aliasing.
The filter removes noise from the oscilloscope amplifiers and ADC above the usable bandwidth for
the selected sample rate. Implementation of the filter in hardware, ahead of the trigger and storage,
reduces trigger jitter and enables using Fast Acq mode while in High Res mode. High Res mode

also guarantees at least 12 bits of vertical resolution. The number of bits of resolution is displayed in
the Acquisition badge in the Settings bar. The High Res sample rate and record length settings are
displayed in the Horizontal badge. High Res mode sets the maximum real time sample rate to half the
maximum sample rate.

Envelope acquires and displays a waveform record that shows the extremes in variations over several
acquisitions. The instrument saves the highest and lowest values in two adjacent intervals (similar to
the Peak Detect mode). Unlike Peak Detect mode, the peaks are gathered over many trigger events.

Average acquires and displays a waveform record that is the average result of several acquisitions.
This mode reduces random noise.

Roll Mode scrolls sequential waveform points across the display in a right-to-left rolling motion. Roll
Mode starts automatically when the timebase is set to 240 ms/div and when Trigger Mode is set to
Auto. Roll Mode works at sample rates up to 10 MS/s. To disable Roll Mode, set Trigger Mode to
Normal.

Single Sequence/Stop After

Enables stopping acquisitions after a specified number of acquisitions. Only works when using the
Single/Sequence button.

Enable Acquisition History

Enables the acquisition history. By default, the option is unchecked. When checked, the History badge
is enabled even if the acquisitions are running or stopped.

Timebase Reference Source

Sets the time base source used by the oscilloscope to acquire and measure signals. Internal sets the
oscilloscope to use an internal reference signal. External sets the oscilloscope to use a 10 MHz signal
connected to the rear-panel Ref In connector.

On some instruments External is divided into External (+2 ppm) and External (£1 k ppm) selections.
The narrow External (2 ppm) setting locks the timebase within 2 ppm of 10 MHz. The wide External
(£1 k ppm) allows the timebase to be within 1 k ppm of 10 MHz.

Fast Frame panel

Sets the Fast Frame acquisition mode. See Fast Frame Panel on page 181

Fast Frame Panel

Use this panel to enable FastFrame™ mode and select the number of frames to acquire.

The Fast Frame panel is accessed from the Acquisition badge menu.

To open the Acquisition menu:

1. Double-tap the Acquisition badge.

2. Tap the Fast Frame panel.

3. Use the fields to set the Fast Frame parameters.
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Fast Frame menu fields and controls

Field or control Description

Fast Frame Enables or disables the Fast Frame mode. When enabled (On), the screen shows either the last
acquisition frame captured, or will wait for a acquisition completion of all the framed events.

Number of Frames Shows the number of frames acquired. Tap on the field and use the multipurpose knob set the number
of frames to acquire, or double-tap on the field and use the virtual keypad to enter a frame count. The
maximum number of frames you can capture is displayed in the frame information readout area.

Frame information readout Displays frame acquisition information. The information changes depending on instrument settings,

area primarily the timebase, sampling rate and record length.

Summary Frame Enables or disables creating and displaying a summary frame at the end of the frame record.

When the current acquisition mode is either Sample or High Res, the Summary Frame shows an
average of all frames.

When the current acquisition mode is Peak Detect, the Summary Frame shows an envelope of all
frames.

Fast Frame usage guidelines
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Enabling Fast Frame mode disables FastAcq mode (if it was enabled). Likewise, enabling FastAcq mode disables Fast Frame mode (if
it was enabled).

You should define the trigger conditions to capture only the waveform, or waveform segment, in which you are interested, before
enabling Fast Frame mode.

You can use Fast Frame mode to acquire and compare frames for multiple signal inputs (analog, digital, math).
You can use Zoom mode to view details of frames.
Use Single/Seq triggering to acquire a single set of frames.

While in Fast Frame mode, measurements are taken across all frames, not just the currently selected frame. Measurement badges
show the ‘ symbol to indicate that the values are from the current acquisition (all frames). Lack of a * means the values are across
many Fast Frame acquisitions.

To obtain rapid statistical results on massive populations, open the Acquisition badge menu, select Single Sequence, and set the
Single Sequence/ Stops After field to acquire multiple sets of frames and keep statistics on all of them. When the sequence finishes,
the last set of frames is still in memory and the instrument has accrued statistical data for a large number of frames.

Use the Run/Stop button to manually start and stop the acquisition. Frames are acquired continuously until stopped, at which point the
last N frames are in memory.

Search works across all frames, not just the currently selected frame.

In search mode, the Navigation buttons (Prev/Next arrow buttons) move from frame to frame as needed based on where the event is
found.

You can save Fast Frame waveforms as reference waveforms using the normal Save As process. Saved Fast Frame waveforms can
be recalled as Reference waveforms.

You can save and recall sessions with Fast Frame active. All frames are restored when the Session is recalled.

If you display a regular (non-Fast Frame) reference waveform, the Reference waveforms is always displayed regardless of the
currently selected frame.
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Fast Frame badge

Use the Fast Frame badge in the Results bar to select which frame to view and enable frame waveforms overlay mode. Fast Frame works
on all displayed analog, digital, and math waveforms.

The Fast Frame badge is opened when you enable the Fast Frame mode in the Fast Frame panel of the Acquisition configuration menu.

Fast Frame badge fields and controls

Field or control Description
Frame count Shows the total number of frames captured at the top of the badge.
Selected Frame Shows the selected frame in all displayed waveforms (analog, digital, and math). Use Multipurpose A

knob to scroll through and select specific frames.

To enter a specific frame number to display, use the Selected Frame field in the Fast Frame
configuration menu.

Frame scrolling uses a wrap-around method. For example, when you reach the end of the frame list,
scrolling further displays frame 1.

If you have enabled overlay mode, the current frame's waveform is highlighted in blue in all displayed
waveforms (analog, digital, and math).

Reference Frame Selects a frame in the current frame acquisition that you want to use as a time reference against
which to compare the selected frame. Displays a Delta readout that shows the difference between the
Selected Frame and the Reference Frame.

To directly enter a specific frame number to display, use the Reference Frame field in the Fast Frame
configuration menu.

Available only when Include Reference Frame in Badge is selected in the Fast Frame configuration
menu.

Time stamps Shows the time difference between frame one and the Selected frame. If Include Reference Frame
in Badge is enabled, each frame readout area (Selected and Reference) in the badge shows the time
difference between frame one and the Selected and Reference frames.

When both Selected and Reference frames are enabled, a Delta time readout shows the time
difference between the Selected frame and the Reference frame.

If the difference time displayed goes beyond 10 seconds, then digits are dropped from the right as
needed and the displayed timestamp is rounded. Note that this is just for Ul display purposes. The full,
precise value is stored and available.

Navigation buttons Tap to display the previous or next frame. Navigation buttons are only displayed when acquisition is set
to Stopped.
Summary Displays the summary frame. the Summary frame button is only displayed when the Summary Frame

button is enabled in the Acquisition menu Fast Frame panel.

Fast Frame badge configuration menu

Use the Fast Frame configuration menu to set Fast Frame overlay mode, enable reference frame timestamp readouts, and display Fast
Frame-related plots.

The Fast Frame configuration menu is accessed from the Fast Frame badge. To open the Fast Frame configuration menu, double-tap the
upper (readouts) area of the Fast Frame badge.
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Fast Frame configuration menu fields and controls

Field or control

Description

Frame count

Shows the total number of frames captured at the top of the badge.

Overlay Frames

Overlays all acquired frames for each displayed source (analog, digital, and math).

If you have enabled overlay mode, the current frame's waveform is highlighted in blue in all displayed
waveforms (analog, digital, and math).

Selected Frame

Sets or shows the current Selected frame number, and also shows the associated frame waveform in
the Waveform View. Tap the field and use the Multipurpose knob A to scroll through the frame list.

Frame scrolling uses a wrap-around method. For example, when you reach the end of the frame list,
scrolling further displays frame 1.

To enter a specific frame number, double-tap on the Selected Frame field and use the virtual keypad
to enter a frame number.

Include Reference Frame in
Badge

Enables or disables providing a Reference frame readout in the Fast Frame badge. A Reference frame
readout shows a difference timestamp between Frame one and the Reference frame, and also the
delta between the Selected frame and the Reference frame timestamps.

A Reference frame is not shown or highlighted in the Waveform View

Reference Frame

Set a Reference frame number.

Tap the field and use the Multipurpose knob B to set a frame number. To enter a specific frame
number, double-tap on the Selected Frame field and use the virtual keypad to enter a frame number.

Available only when Include Reference Frame in Badge is selected.

Plot Fast Frame Results

Opens and displays the selected plot type.

Timestamp Time Trend plots the delta values from frame to frame for the current acquisition (full set
of frames). The first data point is the delta time between frame 1 and frame 2. The second data point

is the delta time between frame 2 and frame 3 and so on. It does not add data points with subsequent
acquisitions.

History badge configuration menu

Use the History configuration menu to set overlay acquisition, enable reference acquisition timestamp readouts, and display acquisition-
related plots. The History configuration menu is accessed from the History badge. To open the History configuration menu, double-tap the

History badge.

History configuration menu: Settings panel fields and controls

Field or control

Description

Overlay Acquisitions

Overlays all acquired acquisitions for each displayed source (analog, digital, and math).

If you have enabled overlay mode, the current acquisition waveform is highlighted in blue in all
displayed waveforms (analog, digital, and math).

Table continued...
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Field or control

Description

Selected Acquisition

Shows the waveforms associated with the Selected acquisition. Along with that the results of all active
analysis elements (Example: Math/Measurements/Search/Protocol buses) are computed as well. Tap
the field and use the Multipurpose knob A to scroll through the acquisition list.

To enter a specific acquisition number, double-tap on the Selected Acquisitions field and use the
virtual keypad to enter a acquisition number.

Include Reference
Acquisitions in Badge

Enables or disables a Reference acquisitions readout in the History badge. A Reference acquisition
readout shows the difference between Selected acquisition and the Reference acquisition. It also
displays the delta between the Selected acquisition and the Reference acquisition timestamps.

The Reference acquisitions are not shown or highlighted in the Waveform View.

Reference Acquisitions

Set a Reference acquisition number.

Tap the field and use Multipurpose knob B to set a acquisition number. To enter a specific acquisition
number, double-tap on the Selected Acquisitions field and use the virtual keypad to enter a frame
number.

Available only when Include Reference Acquisitions in Badge is selected.

Plots/Tables

Opens and displays the Timestamp Time Trend plot and Timestamp Results Table.

The Timestamp Time Trend plots the delta values for each current acquisition. See History Timestamp
Trend plot configuration menu on page 187

The Timestamp Results Table displays a result table of timestamp for all acquired acquisitions. See
History Timestamp Result Table configuration menu on page 188

History configuration menu: Other panel fields and controls

Field or control

Description

Navigation Method

Sets the navigation method as Previous / Next or Play / Pause. The default is Previous / Next.

Playback Speed

Sets the playback speed as Slow, Medium, or Fast. The default is Medium. Available when
Navigation Method is Play / Pause.

Cumulative Statistics / Plot
Results Based On

The Statistics and Plot results based on the selection of All Acquisitions or History Only. The default
is All Acquisitions.

All Acquisitions: Statistics and plots update with each acquisition. Once you stop acquisitions, the
results remain static.

History Only: With History Only selected, statistics and plots update only after acquisitions have

been stopped and are calculated only over the set of acquisitions stored in history. These results
remain static until you start acquiring again. When this happens, cumulative results remains blank until
acquisitions are stopped.

Right click menu for History badge

The following functions are available when you right click on a History badge.
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Field or control Description

Disable Acquisition History Select to disable acquisition history or to delete history badge. Disable Acquisition History does not
clear the history acquisitions.

Note: The current acquired history data will be cleared, if any Horizontal or Acquisition
parameters are changed.

Configure Acquisition History |Select to configure the acquisition history.

Guidelines to save History acquisitions

+  When you saves a setup, no channel data is stored (only reference waveforms are saved with setups).

+  When you saves a session, all History/FastFrame data is stored with the session.

+  When you saves a waveform, all history/frames associated with that waveform are saved.

«  When either History or FastFrame is active and you go to Save As menu, the Gating dropdown includes a option called Selected Acq.
+ If Selected Acq is selected when the save happens, only the currently selected Acg/frame is saved.

History usage guidelines
+  Enabling History mode allows you to review the last acquisitions after acquisitions are stopped or completed.

+ As you navigate through the history, you will see the acquired waveforms associated with each acquisition and all active analysis
features will run on the selected acquisition.

+ Any acquisition change (anything that can cause the acquisitions counter to reset or measurement statistics to reset) causes the
History buffer to be flushed and restart accumulation.

+ Single/Seq contributes to History mode.
+  Analysis results are provided in two categories

+ Single: This refers to the readouts/views within a single acquisition. These include:

+ Cursors, when placed on a waveform generated from a single acquisition
+  Math waveforms
+ Measurements and statistics related to the measurements that come from a single acquisition.
+ All plots except Histogram
+ Searches
+  Bus Decode
+ Cumulative: This refers to a readout/view from multiple acquisitions. These include:
+ Cursors, when placed on a waveform generated from many acquisitions (Spectrum View Max Hold, Min Hold, and Average
traces).
+ Statistics that are accumulated across multiple acquisitions.
+ Histogram plots
+  Measurement and search results report across all acquisition in History and can be navigated through, including from acquisition to
acquisition.
+ If Visual Trigger is on when the oscilloscope is running, the only acquisitions that meet the Visual Trigger criteria are saved to History
memory.

+ History Timestamp Time Trend plot and Timestamp Results Table get updated when the acquisitions are stopped.
+ The following features are not compatible with History mode:

+ FastAcq mode
+ FastFrame
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+ Roll mode
+ Average, Peak Detect, and Envelope acquisition modes
+ Math average

History Timestamp Trend plot configuration menu
Use this menu to change settings of a displayed History Timestamp Time Trend plot.

To open the History Timestamp Time Trend plot configuration menu, double-tap anywhere in a Timestamp Time Trend plot view.

History Timestamp Time Trend plot configuration menu fields and controls

Field or control Description

AutoScale Toggles AutoScale On or Off. Default is On. Turn AutoScale off to set the X and Y-axis range to view
an area of interest.

When AutoScale is Off (unchecked), the Plot view zoom mode enables and a small Zoom window
appears in the plot. Drag the blue zoom area box in the small Zoom window to view that area in the
main Plot view. You can also use the Zoom and Pan front-panel knobs to change the zoom area and
horizontal position.

Gridlines Selects which gridlines to show in the plot. Available gridlines are Horizontal, Vertical, and Both.

X-Axis From, To Sets the beginning and end scale range to display in the plot for the X-axis scales.
These values also define the horizontal area shown in the small Zoom window.

Available when AutoScale is Off.

Y-Axis From, To Sets the beginning and end scale range to display in the plot for the Y-axis scales.
These values also define the vertical area shown in the small Zoom window.

Available when AutoScale is Off.

Save panel fields and controls

Use the Save panel controls to save the plot image or date to a file for inclusion in reports or further analysis in other applications.

Field or control Description

Save Plot Image Tap to open the Save As menu. Navigate to the location where you want to save the plot image. Enter
a file name in the File Name field. Select the image file format (PNG, BMP, or JPG).

Tap OK to save the plot image.

Save Plot Data Tap to open the Save As menu. Navigate to the location where you want to save the plot data. Enter a
file name in the File Name field.

Tap OK to save the plot data as a comma-separated values (.csv) file.

Closing a plot view
To close (delete) a Plot view, tap the X in the upper right corner of the view.

Deleting the Measurement badge that enabled the plot also closes the plot.
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History Timestamp Result Table configuration menu
Use this menu to configure the Timestamp Results Table.

To open the Timestamp Results Table configuration menu, double-tap anywhere in the timestamp results table. If there are multiple
timestamp results tables, tap the tab of the timestamp results table to configure and then double-tap anywhere in that table.

Timestamp Results Table menu

Field or control Description

Column Visibility panel

Acquisition Number Sets the acquisition number for each acquisition.

Datestamp Sets the acquisition datestamp for each acquisition.

Timestamp Sets the acquisition timestamp for each acquisition.

Delta time Sets the delta time to display the deltas. Delta shows the time difference between the acquisitions.

Other panel

Save Table Opens a menu with which to save the results table data to a file. See Save As configuration menu
(Timestamp Results Table) on page 188.

Timestamp Results Table operations

+  Double-tap anywhere on a results table to open its configuration menu.
+ To scroll up and down in a results table, tap the table and use Multipurpose knob A to scroll and select table rows.
+ To move a column, touch and drag the column title to a new position in the table.

+ To add or remove a column from the table, double-tap the results table to open the table configuration menu and select from the
available columns to add or remove.

+ To resize a column width, use the mouse to position the cursor on the column name border to change, then click and drag the column
border to resize that column. If the column width change forces the truncation of data, hovering over a cell displays the full information
content of that cell (subject to significant digits limitations on numeric entries).

*You cannot sort the contents of a column.
*You cannot change the order of rows.

+ The History badge and Timestamp Results Table works in sync for selected acquisition. The History badge shows the same acquisition
that selected in results table. The results table row will be highlighted for acquisition currently showing in the history badge.

Save As configuration menu (Timestamp Results Table)

Use the Save As configuration menu to set the location and file name to which to save the contents of a results table, as a
comma-separated value (csv) format file.

To open the Save As configuration menu to save a results table

1. Double-tap anywhere in the Timestamp Results Table to open the timestamp table configuration menu.
2. Tap the Other panel.
3. Tap Save Table.
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Save As menu, Timestamp Results Table fields and controls

Field or control Description
Save Location Sets the save location for the file. The default value is the last location to which a file was saved.

Tap on the file path and use a keyboard to enter a new save location. Or double-tap on the file name to
open the on-screen keyboard and enter a path.

Tap the down arrow icon on the right end of the field to open a list of recent file save locations, for the
current save type, up to a maximum of 20 locations.

Browse Tap to open the Browse Save As Location dialog, to navigate to and select the location to which to
save the file. See Browse Save As Location configuration menu on page 490.
File Name The file name assigned to the file. The default file name is Tek000. The file name increments on the

next save (Tek001, Tek002, and so on).

Tap on the file name and use a keyboard to enter a new file name. Or double-tap on the file name to
open the on-screen keyboard and enter a file name.

Save as Type You can save only results table as comma separated values (.csv) files.

Add Measurements configuration menu overview
Use this configuration menu to select measurements you want to take on waveforms and add the measurements to the Results bar.
To open the Add Measurements configuration menu, tap the Add New... Measure button in the Analysis controls area.

The Add Measurements configuration menu always opens on the Standard measurement tab. The listed tabs and measurements
depend on the installed measurement options and the selected signal source.

To add a measurement, select the measurement type tab, select the input source or sources, select the measurement, and either tap the
Add button or double-tap the measurement. The measurement is added to the Results bar.

To change individual measurement settings, double-tap the Measurement badge to open a configuration menu for that measurement. See
Measurement configuration menu overview on page 211.

Add Measurements menu fields and controls

Field or control Description

Measurement tabs The tabs along the top organize measurements by their type. The Standard tab is the default set of
measurements that are built in to the instrument. Other tabs are shown when you install measurement
options. See The Jitter tab (Advanced Jitter and Eye Analysis) on page 197. See The Power

tab on page 200.
Measurement description Shows a graphic and short description of the selected measurement. Use this information to verify that
. the selected measurement is correct for what you want to measure.
(graphic and text)
Source Selects the measurement source. If the measurement requires more than one source (for example,
Skew, Phase, or many Power measurements), the menu shows two source fields from which to select.
Add button Adds the selected measurement as a measurement badge to the Results bar. You can also double-tap

a listed measurement to add it to the Results bar.
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Standard tab measurement panels

Panel

Description

Amplitude Measurements
panel

Tap the panel bar to list the available amplitude measurements. Touch and drag the list to scroll
through all measurements. See Amplitude Measurements panel on page 191.

Timing Measurements panel

Tap the panel bar to list the available time measurements. Touch and drag the list to scroll through all
measurements. See Timing Measurements panel on page 192.

Jitter Measurements panel

Tap the panel bar to list the available standard jitter measurements. See Jitter Measurements
panel on page 196.

Note: If you have installed the Advanced Jitter and Eye Analysis option, the Jitter
Measurements panel is removed from the Standard measurement tab and is replaced
with a Jitter tab at the top of the Add Measurements menu. See The Jitter tab (Advanced
Jitter and Eye Analysis) on page 197.

Spectrum Measurements panel

Tap the panel bar to list the available spectrum measurements. See Spectrum Measurements
panel on page 194

Note: The Spectrum Measurements panel is only available when Spectrum View is set
from the analog channel badge menu. See the Spectrum Measurements panel on page 194
settings.

Other tab measurements (require optional licenses)

Add Measurement tab

Description

Jitter Advanced Jitter and Eye Analysis measurements (option). Provides triggers and measurements for
advanced jitter and eye analysis. See The Jitter tab (Advanced Jitter and Eye Analysis) on page 197.

Power Advanced Power Analysis (option). Provides measurements for electrical analysis, output analysis,
amplitude analysis, timing analysis, and switching analysis. See The Power tab on page 200.

DPM Digital Power Management Analysis (option). Provides measurements for ripple analysis, transient
analysis, power sequence analysis, jitter and eye analysis. See The DPM tab on page 205.

DDR DDR (option). Provides measurements for DDR amplitude and timing analysis. See The DDR
measurements tab on page 208.

IMDA IMDA (Inverter Motors and Drive Analysis) (option). 3 phase measurement is provided for Electrical
analysis and Mechanical analysis. See The IMDA tab on page 204.

WBG-DPT WBG-DPT (Wide Band Gap-Double Pulse Test) (option). Provides measurements for Switching

parameter analysis, Switching timing analysis, and Diode recovery analysis. See The WBG-DPT
fab on page 209.

The Standard measurements tab

The Standard tab lists the default set of amplitude, Timing, and jitter measurements that are included with the instrument.

To open the Standard measurements tab, tap the Add New... Measure button. The Add Measurements configuration menu opens on the

Standard tab by default.

To add a measurement to the Results bar:

1. Select the signal source.
2. Tap a measurement panel:

Amplitude Measurements panel on page 191
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Timing Measurements panel on page 192
Jitter Measurements panel on page 196

Spectrum Measurements panel on page 194
3. Select a measurement. If a measurement requires two signal sources, select the sources in the Source 1 and Source 2 fields.
4. Tap Add. You can also double-tap a measurement to add it immediately to the Results bar.

Note: If you have installed Advanced Jitter and Eye Analysis option, all jitter measurements are in the Jitter tab. See The Jitter
tab (Advanced Jitter and Eye Analysis) on page 197.

Amplitude Measurements panel

The Amplitude Measurements panel lists available amplitude-related measurements that you can take on analog channel signals, math
waveforms (time-domain), and reference waveforms. Amplitude measurements are not available for digital signals. The measurement
annotations are supported for all amplitude measurements.

To open the Amplitude Measurements panel:

1. Tap Add New... Measure button.
2. Tap the Amplitude Measurements panel.

To add a measurement to the Results bar:

1. Select the signal source.
2. Select a measurement.
3. Tap Add. You can also double-tap a measurement to add it immediately to the Results bar.

The Amplitude Measurements panel measurements

Measurement Description

AC RMS The true Root Mean Square voltage, minus any DC component, of the waveform data points that are
above the Mean signal level. You can take this measurement on each cycle in the waveform record or
on the entire waveform record.

Amplitude The difference between the Top value and the Base value. You can take this measurement on each
cycle in the waveform record or on the entire waveform record.

Area The area between the waveform and the Mean value, calculated by integrating the data points. The
area above ground (0 V) is positive, while the area below ground is negative. You can take this
measurement on each cycle in the waveform record or on the entire waveform record.

Base? The most common data point value below the midpoint of the waveform, over the measurement region.
Base is used as the 0% value whenever low reference values are calculated, such as in rise time or fall
time measurements. You can take this measurement on each cycle in the waveform record or on the
entire waveform record.

Maximum The maximum data point value. You can take this measurement on each cycle in the waveform record
or across the entire waveform record.

Mean The arithmetic mean of all data points over the measurement region. You can take this measurement
on each cycle in the waveform record or on the entire waveform record.

Minimum The minimum data point value. You can take this measurement on each cycle in the waveform record
or on the entire waveform record.

Table continued...

2 Changing your Base Top Method in the Reference Levels panel of the Measurement configuration menu may change how this value is calculated.
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Measurement

Description

Negative Overshoot?

The difference between the Minimum and Base values, divided by the Amplitude, and multiplied by
100 to express the measurement as a percentage of amplitude. You can take this measurement on
each cycle in the waveform record or on the entire waveform record.

Peak-To-Peak

The absolute difference between the Maximum and Minimum amplitudes in the measurement region.
You can take this measurement on each cycle in the waveform record or on the entire waveform
record.

Positive Overshoot 2

The difference between the Maximum value and the Top value, divided by the Amplitude, and
multiplied by 100 to express the measurement as a percentage of amplitude. You can take this
measurement on each cycle in the waveform record or on the entire waveform record.

RMS

The true Root Mean Square (The square root of the mean (average) value of the squared function of
the waveform data points.) You can take this measurement on each cycle in the waveform record or on
the entire waveform record.

Top 2

The most common data point value above the midpoint of the waveform over the measurement region.
Base is used as the 100% reference value whenever high reference values are calculated, such as in
rise time or fall ime measurements. You can take this measurement on each cycle in the waveform
record or on the entire waveform record.

See also

Measurement configuration menu overview on page 211

Timing Measurements panel

Use the Timing Measurements panel to add timing-related measurements to the Results bar. Timing measurements can be taken on
time-domain analog, math, and reference waveforms. Timing measurements can also be taken on some digital channel signals. The
measurement annotations are supported for all time measurements.

To open the Timing Measurements panel:

1. Tap Add New... Measure button.
2. Tap the Timing Measurements panel.

To add a measurement to the Results bar:

1. Select the signal source.

2. Select a measurement. If a measurement requires two signal sources, select the sources in the Source 1 and Source 2 fields.
3. Tap Add. You can also double-tap a measurement to add it immediately to the Results bar.

Timing Measurements panel

Measurement

Description

Burst Width3

The duration of a series of adjacent crossings of the Mid reference level. Bursts are separated by a
specified idle time.

The measurement is taken on each burst in a waveform record.

Table continued...

3 This measurement can also be taken on digital signals.
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Measurement Description
Data Rate 3 Data Rate is the reciprocal of Unit Interval.
The measurement is taken on each bit of the waveform record.
Delay The time difference between the mid reference (default 50%) amplitude point of two different

waveforms. You can specify the signal edges to measure in the measurement’s Configuration menu.

The measurement requires two sources.

Duration N-Periods 3

The time required to complete N cycles. A cycle is the time between two adjacent (same direction)
crossings of the mid reference level.

The measurement is taken on each cycle in the waveform record.

Fall Time

The time required for the trailing edge of the first pulse in the measurement region to fall from the high
reference value (default = 90%) to the low reference value (default = 10%).

The measurement is taken on each cycle of the waveform record.

Falling Slew Rate

The rate of change (in volts/second) as an edge transitions from a high reference level to a low
reference level.

The measurement is taken on each cycle of the record in the measurement region.

Frequency °

The frequency of the waveform. Frequency is the reciprocal of Period (Frequency = 1/Period).

High Time

The time the signal remains above the Top reference level.

The measurement is taken on each cycle in the waveform record.

Hold Time 3

The time between the specified Mid reference level crossing on the clock signal to the closest Mid
reference level crossing on the specified data signal.

The measurement is taken on each specified clock edge in the waveform record.

Low Time

The time the signal remains below the Base reference level.

The measurement is taken on each cycle in the waveform record.

Negative Duty Cycle

The ratio of the negative pulse width to the signal period, expressed as a percentage.

The duty cycle is measured on the first cycle in the measurement region.

Negative Pulse Width °

The distance (time) between the mid reference (default 50%) amplitude points of a negative pulse.

The measurement is taken on each cycle in the waveform record or measurement region.

Period 3

The time between two adjacent crossings of the Mid reference level (one cycle) of the waveform.

The measurement is taken on each cycle of the waveform record or measurement region.

Phase 3

The time difference (phase shift) between the specified signal edges of waveform source 1 and
waveform source 2. The measurement is expressed in degrees, where 360° comprise one waveform
cycle. This measurement requires two sources.

The measurement is taken on each cycle of the waveform record.

Positive Duty Cycle 3

The ratio of the positive pulse width to the signal period, expressed as a percentage.

The duty cycle is measured on the first cycle in the measurement region.

Table continued...
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Measurement Description

Positive Pulse Width 3 The distance (time) between the mid reference (default 50%) amplitude points of a positive pulse.
The measurement is made on the first pulse in the measurement region.

Rise Time The time required for the leading edge of the first pulse in the measurement region to rise from the low
reference value (default = 10%) to the high reference value (default = 90%).
The measurement is taken on each cycle of the waveform record.

Rising Slew Rate The rate of change (in volts/second) as an edge transitions from a low reference level to a high
reference level.
The measurement is taken on each cycle of the record in the measurement region.

Setup Time 3 The time between the specified Mid reference level crossing on the data signal to the closest Mid
reference level crossing on the specified clock signal.
The measurement is made on each specified clock edge in the waveform record.

Skew 3 The time between the specified Mid reference level crossing on one source to the closest Mid

reference level crossing on the second source signal.

The measurement is made on each cycle in the waveform record.

Time Outside Level

The time the specified signal remains above the Top reference level and/or below the Base reference
level.

The measurement is made on each occurrence in the waveform record.

Time to Min Time to Min is the amount of time from the trigger point to the minimum data point. This measurement
can be made across the entire record or on each cycle in the record.

Time to Max Time to Max is the amount of time from the trigger point to the maximum data point. This measurement
can be made across the entire record or on each cycle in the record.

Unit Interval 3 The time difference between two successive bits.

The measurement is taken on each bit of the waveform record.

TDR Time Domain Reflectometry (TDR) is the arithmetic mean of all the data points in the impedance
waveform which is computed from the voltage waveform over the measurement region. The
measurement also determines the capacitance and inductance over the same measurement region.
If the signal type is set to Differential, the measurement requires two sources.

See also

Measurement configuration menu overview on page 211

Spectrum Measurements panel

The Spectrum Measurements panel lists available measurements that you can take on analog channel signals with Spectrum View

enabled.

Spectrum measurements are initially configured from the badge menu for each channel. To open the Spectrum Measurements panel:

1. Double-tap the channel badge.
2. Tap the Spectrum View panel.
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3. Set Display to On. The instrument opens the Spectrum View menu.

CHANNEL 1

4, Select the Frequency Domain Traces to show in the Spectrum View (Normal, Max Hold, Min Hold, and/or Average).
5. Tap Add New... Measure.

6. Set the signal Source for the selected analog channel as Ch_X_SV_Average, Ch_X_SV_Max_Hold, Ch_X_SV_Min_Hold, or
Ch_X_SV_Normal.

The Spectrum Measurements panel displays in the Standard tab.
ADD MEASUREMENTS

Jitter | Power | IMDA | DPM | DDR | WBG-DPT

SV_Max_Hold

SV_Min_Hold
SV_MNormal

TIME MEASUREMENTS }

To add a measurement to the Results bar:
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1. Select the signal Source.
2. Select a measurement.

3. Tap Add. You can also double-tap a measurement to add it immediately to the Results bar.

Spectrum Measurements panel

Measurement

Description

Channel Power

Measures the total RF power within the bandwidth defined by the channel width. It is measured as a
unit of dBm, Vrms, dBuW, dBmV, dbuV, dBmA, or dBuA.

The channel power of an RF signal is the total power within the specified channel width. The resulting
channel power is an absolute power measurement. The Channel Width is indicated by the non-shaded
portion of the Spectrum View display.

ACPR Measures the signal power leaking from the main channel into adjacent channels. It is measured as a
unit of Vrms, dBm, dBuW, dBmV, dbuV, dBmA, or dBuA.
ACPR is ratio of total power in adjacent channels to the main channel power. Each adjacent channel
has upper and lower bands decided by channel width and channel spacing. The Channel width for all
the channels is indicated by the non-shaded portion of the Spectrum View Display.

Occupied Bandwidth Measures the occupied bandwidth. It is measured in Hz.
Occupied Bandwidth (OBW) is the bandwidth that contains the specified power within the Analysis
Bandwidth. The Analysis Bandwidth is indicated by the non-shaded portion of the Spectrum View
display.

See also

Spectrum measurements configuration menu overview on page 225

Configure panel (Spectrum measurements configuration menu) on page 226

Pass/Fail Testing panel (Spectrum measurement configuration menu) on page 228.

Jitter Measurements panel

The Jitter Measurements panel lists the standard jitter-related measurements that you can add to the Results bar. These jitter
measurements are part of the Standard measurements that are provided by default.

To open the Jitter Measurements panel:

1. Tap the Add New... Measure button.
2. Tap the Jitter Measurements panel.

To add a measurement to the Results bar:

1. Select the signal source.
2. Select a measurement.

3. Tap Add. You can also double-tap a measurement to add it immediately to the Results bar.

Note: If you have installed Advanced Jitter and Eye Analysis option, the jitter measurements are moved to the Jitter tab of the
Add Measurements menu. See The Jitter tab (Advanced Jitter and Eye Analysis) on page 197.
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Jitter Measurements panel measurements

Measurement Description

Phase Noise The RMS magnitude of all integrated jitter falling within a specified offset range of the fundamental
clock frequency. This measurement is taken on the entire waveform record.

TIE The difference in time between an edge in the source waveform and the corresponding edge in
a recovered reference clock signal. The measurement is made on each waveform edge in the
measurement region.

See also

Measurement configuration menu overview on page 211

The Jitter tab (Advanced Jitter and Eye Analysis)

The Jitter tab lists advanced jitter, eye, amplitude, and timing measurements that you can add to the Results bar. The Jitter tab is only
shown if you have purchased and installed the Advanced Jitter and Eye Analysis option.

To open the Jitter measurements tab:

1. Tap Add New... Measure button.
2. Tap the Jitter tab.

To add a measurement to the Results bar:

1. Select the signal source.

2. Select a measurement panel.

3. Select a measurement.

4. Tap Add. You can also double-tap a measurement to add it to the Results bar.

Adding eye diagram plots for a jitter measurement

To display an eye diagram plot for a jitter measurement, double-tap the jitter measurement badge for which you want to show an eye
diagram. If available, tap the Eye Diagram plot button.

Jitter Measurements panel

Measurement Description

DCD Duty cycle distortion. The peak-to-peak amplitude for the component of the deterministic jitter
correlated with the signal polarity.

The measurement is taken on the entire record.

DDJ Data dependent jitter. The peak-to-peak amplitude for the component of the deterministic jitter
correlated with the date pattern in the waveform.

The measurement is taken on the entire record.

DJ Deterministic jitter. The peak-to-peak amplitude of all timing errors that exhibit deterministic behavior.

The measurement is taken across the entire record.

Table continued...
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Measurement Description

DJ-30 Dual-Dirac deterministic jitter. The deterministic jitter on a simplifying assumption that the histogram of
all deterministic jitter can be modeled as a pair of equal-magnitude Dirac functions.
The measurement is taken on the entire record.

F/2 The peak-to-peak amplitude of the periodic jitter occurring at a rate of Fb (date rate) divided by two.
The measurement is taken on the entire record.

F/4 The peak-to-peak amplitude of the periodic jitter occurring at a rate of Fb (date rate) divided by four.
The measurement is taken across the entire record.

FI8 The peak-to-peak amplitude of the periodic jitter occurring at a rate of Fb (date rate) divided by eight.
The measurement is taken on the entire record.

J2 The total jitter at a bit error rate of 2.5e-3 (TJ@2.5e-3).
The measurement is taken on the entire record.

J9 The total jitter at a bit error rate of 2.5¢-3 (TJ@2.5e-3).
The measurement is taken on the entire record.

CC-Jitter Cycle to Cycle Jitter measures the clock period change between any two adjacent cycles. The
measurement is taken on the entire record.

Jitter Summary Adds multiple jitter measurements to the measurement badge, and displays Bathtub, TIE Spectrum
trend plot, TIE Histogram, Eye Diagram plots on the screen.

NPJ Nonperiodic jitter. The portion of the BUJ (Bounded uncorrelated jitter) that is random. BUJ excludes
DDJ, DCD, and RJ.
The measurement is taken on the entire record.

Phase Noise The RMS magnitude of all integrated jitter falling within a specified offset range of the fundamental
clock frequency.
The measurement is taken on the entire record.

PJ Periodic jitter. The peak-to-peak amplitude of the uncorrelated sinusoidal components of the
deterministic jitter.
The measurement is taken on the entire record.

RJ Random jitter. The RMS magnitude of all random timing errors following a Gaussian distribution.
The measurement is taken on the entire record.

RJ-3% Dual-Dirac random jitter. The random jitter on a simplifying assumption that the histogram of all
deterministic jitter can be modeled as a pair of equal-magnitude Dirac functions.
The measurement is taken on the entire record.

SRJ Sub-rate jitter. The composite jitter due to periodic components at %2, 1/4, and 1/8 of the data rate.

The measurement is taken on the entire record.

Table continued...
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Measurement Description

TIE Time Interval Error. The difference in time between an edge in the source waveform and the
corresponding edge in a recovered reference clock signal.

The measurement is taken on each waveform edge.

TJ@BER Total error at a specified bit error rate. The predicated peak-to-peak amplitude of jitter that will only be
exceeded with a probability equal to the bit error rate.

The measurement is taken on the entire record.

Eye Measurements panel

Measurement Description

Eye Height The minimum vertical eye opening at the center of the recovered unit interval.

The measurement is taken on the entire waveform record.

Eye High The amplitude of a high (one) bit measured at a specified location within the recovered unit interval.

The measurement is taken on each high bit in the waveform record.

Eye Low The amplitude of a low (zero) bit measured at a specified location within the recovered unit interval.

The measurement is taken on each low bit in the waveform record.

Eye Width The minimum horizontal eye opening at the center of the recovered unit interval.

The measurement is taken on the entire waveform record.

EyeHeight@BER The predicted vertical eye opening that will be violated with a probability equal to the bit error rate.

The measurement is taken on the entire waveform record.

EyeWidth@BER The predicted horizontal eye opening that will be violated with a probability equal to the bit error rate.

The measurement is taken on the entire waveform record.

Q-Factor The ratio of the vertical eye opening to RMS vertical noise measured at a specified location in the
recovered unit interval.

The measurement is taken on the entire waveform record.

Amplitude Measurements panel

Measurement Description

AC Common Mode (Pk-Pk) The peak-to-peak of the common mode voltage of the two specified sources.

The measurement is taken on the entire record.

Bit Amplitude The difference between the amplitudes of the 1 and 0 bits surrounding a transition. The amplitude is
measured over a specified part of at the center of the recovered time interval.

The measurement is taken on each transition bit of the entire record (Mean) or on the entire record
(Mode).

Table continued...
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Measurement Description
Bit High The amplitude of a 1 bit, measured over a specified percent of the center of the recovered time
interval.
The measurement is taken on each high bit of the entire record (Mean) or on the entire record (Mode).
Bit Low The amplitude of a 0 bit, measured over a specified percent of the center of the recovered time

interval.

The measurement is taken on each low bit of the entire record (Mean) or on the entire record (Mode).

DC Common Mode

The arithmetic mean of the common mode voltage of two sources.

The measurement is taken on the entire record.

Differential Crossover

The voltage level of a differential signal pair at the crossover point(s).

The measurement is taken at each crossover point in the record.

T/nT Ratio

The ratio of a nontransition bit voltage (second and subsequent bit voltage after a transition) to its
nearest preceding transition bit voltage (first bit voltage after the transition). Bit voltage is measured at
the interpolated midpoint of the recovered unit interval.

The measurement is taken on each nontransition bit in the record.

Timing Measurements panel

Measurement Description

SSC Freq Dev The spread spectrum clock frequency deviation. This measurement enables a time trend plot of the
spread spectrum clock modulation profile.
The measurement is taken on each cycle of the entire record.

SSC Modulation Rate The modulation frequency of a spread spectrum clock.
The measurement is taken on each cycle of the entire record.

See also

Measurement configuration menu overview on page 211

The Power tab

The Power tab lists the optional power-related measurements that you can add to the Results bar. Power measurements include input
analysis, amplitude analysis, timing analysis, switching analysis, and output analysis.

To open the Power measurements tab:
1. Tap the Add New... Measure button.

2. Tap the Power tab.

To add a measurement to the Results bar:

1. Select the signal sources. If the measurement requires two signal sources, select the sources in the Source 1 and Source 2 fields.

2. Tap a measurement panel:

Input Analysis Measurements panel on page 201
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Amplitude Analysis Measurements panel on page 201

Timing Analysis Measurements panel on page 201

Switching Analysis Measurements panel on page 202

Magnetic Analysis Measurements panel on page 202

Output Analysis Measurements panel on page 203

Frequency Response Analysis (FRA) Measurements panel on page 203

3. Select the measurement.

4. Tap Add. You can also double-tap a measurement to add it to the Results bar.

Input Analysis Measurements panel

Measurement

Description

Power Quality

Measures the Frequency, RMS values of the voltage and current, Crest Factors of the voltage and
current, Real Power, Reactive Power, Apparent Power, Power Factor, and Phase Angle of the signal.

Harmonics

Plots the signal amplitudes at the fundamental line frequency and its harmonics. Measures the RMS
amplitude and Total Harmonic Distortion of the signal. Plots the Harmonics Bar Graph.

Input Capacitance

Measures the DUT input capacitance when powered on.

Inrush Current

Measures the positive and negative peak input current during DUT power-on.

Note: You should take the Input Capacitance and Inrush Current measurements independently. Input Capacitance and Inrush
Current measurements use Power Preset to optimize the settings and trigger to measure the DUT power on signal, which may
result in inaccurate measurements for other measurement types.

Amplitude Analysis Measurements panel

Measurement

Description

Cycle Amplitude

The difference between the Top value and the Base value. Measurement can be made across the
entire record or on each cycle in the record.

Cycle Top The most common data point value above the midpoint of the waveform over the measurement region.
This measurement is made on each cycle in the record.
Cycle Base The most common data value below the midpoint of the waveform. This measurement is made on

each cycle in the record.

Cycle Peak-to-Peak

The difference between the Maximum and Minimum values in the measurement region. This
measurement is made on each cycle in the record.

Cycle Maximum

The maximum data point. This measurement is made on each cycle in the record.

Cycle Minimum

The minimum data point. This measurement is made on each cycle in the record.

Timing Analysis Measurements panel

Measurement

Description

Period

The time between two adjacent crossings of the Mid reference level (one cycle) of the waveform.

This measurement is taken on each cycle of the waveform record or measurement region.

Table continued...
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Measurement Description
Frequency Frequency is the reciprocal of Period (Frequency = 1/Period). This measurement is made on each
cycle in the record.
Positive Duty Cycle The ratio of the positive-pulse width to the signal period.
This measurement is taken on each cycle of the waveform record or measurement region.
Negative Duty Cycle The ratio of the negative-pulse width to the signal period.
This measurement is taken on each cycle of the waveform record or measurement region.
Positive Pulse Width The time the signal remains above the Mid-reference level.
This measurement is taken on each cycle of the waveform record or measurement region.
Negative Pulse Width The time the signal remains below the Mid-reference level.
This measurement is taken on each cycle of the waveform record or measurement region.

Switching Analysis Measurements panel

Measurement

Description

Switching Loss

The mean instantaneous power and energy in the turn-on, turn-off, and conduction regions of a
switching device. Provides the SWL trajectory plot.

dv/dt The rate of change (slew rate) of the voltage, as it rises from the Base reference level (Rg) to the Top
reference level (Ry), and as it falls from the Top reference level (Rt) to the Base reference level (Rg).

di/dt The rate of change (slew rate) of the current, as it rises from the Base reference level (Rg) to the Top
reference level (Ry), and as it falls from the Top reference level (Rt) to the Base reference level (Rg).

SOA An X-Y plot of switching device voltage and current. The SOA mask testing provides pass/fail testing to
component specifications.

Rpson) The resistance (the slope of the V-I curve) when the switching device is conducting.

Magnetic Analysis Measurements panel

Measurement Description
Inductance The integral of the voltage divided by the current of a magnetic component during circuit operation.
Magnetic Property The B-H curve for a magnetic component during circuit operation.

Magnetic Loss

The average value of the product of the voltage and current through the inductor. This represents
the total loss of the magnetic device and consists of resistive and eddy current losses during circuit
operation.

Ivs. [V

The integral of voltage against current.
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Output Analysis Measurements panel

Measurement Description
Line Ripple The RMS and peak-to-peak values of the line frequency portion of the AC signal.
A Note: RMS is measured at the configured ripple frequency.
Switching Ripple The RMS and peak-to-peak values of the input signal.
A Note: RMS is measured at the configured ripple frequency.
Efficiency The ratio of output power to input power for a power conversion circuit.
Turn On Time Measures the time from when the input voltage is applied to the DUT to the time when the output

voltage reaches a steady level.

Turn Off Time

Measures the time from when the input voltage is removed from the DUT to the time when the output
voltage reaches a zero level.

Note: You should take the Turn On Time and Turn Off Time measurements independently. Turn On Time and Turn Off Time
A measurements use the Power Preset function to optimize the settings and trigger to measure the DUT power-on signal, which
may result in inaccurate measurements for other measurement types.

c Note: If you save a session file that includes power measurements, make sure to recall (load) the session file into an instrument
with the same number of channels that was used to create the session file.

Frequency Response Analysis (FRA) Measurements panel

Measurement

Description

Control Loop Response (Bode)

Plots the gain as 20 log (V,u/Vin) and phase difference between Vi, and V; at each frequency within
the swept band. The resulting plot is commonly referred to as a Bode Plot.

Power Supply Rejection Ratio

Measures both the modulated input and output AC voltage levels and plots the rejection ratio as 20 log
(Vin/Vout) at each frequency within the specified band.

Impedance

Computes and plots the channel ratio (V,/Vy) at each frequency within the swept band.
The impedance curve displays maximum annotations of 3 peaks, if they are available only.

Note: It is recommended to use a splitter with the built-in AFG source for Impedance
measurements. If you use an external AFG, use a single channel with a splitter.

Note: By default on selecting Preset, Spectral Averaging for the configured channel is set to Average mode with number 2. The
Acquisition mode will be in Sample mode with RUN. For FRA measurements, on Preset in Auto RBW, Spectrum View is set to
Average frace of two samples. The Acquisition mode is set to sample in RUN/STOP.

Note: After Preset, you can un-check Spectrum View Average and retain Normal trace. After selecting the Scope RUN function,
the Acquisition mode will be set to Single Sequence. In Single SEQ, there may be a minor flicker on the plot update.

See also

Power measurement configuration menu overview on page 241
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The IMDA tab

The IMDA tab lists the IMDA-related measurements that you can add to the Results bar. IMDA measurements include electrical analysis,
switching analysis, and output analysis.

To open the IMDA Measurements tab:
1. Tap the Add New... Measure button.

2. Tap the IMDA tab.

A Note: IMDA tab is available only for 5 and 6 Series Oscilloscopes. The 3-Phase tab is available for 4 Series Oscilloscopes.

To add a measurement to the Results bar:

1. Tap a measurement panel:
2. Select the measurement.

Electrical Analysis Measurements panel on page 204

Mechanical Analysis Measurements panel on page 204
3. Tap Add. You can also double-tap a measurement to add it to the Results bar.

Electrical Analysis Measurements panel

Measurement

Description

Power Quality

Measures the operating Frequency, RMS values of the voltage and current, Crest Factors of the
voltage and current, Real Power, Reactive Power, Apparent Power, Power Factor, and Phase Angle of
the AC signal. Plots the Phasor diagram and Acq Trend.

Harmonics Measures the signal amplitudes at the fundamental line frequency and its harmonics. Measures the
RMS amplitude and Total Harmonic Distortion of the signal. Plots the Harmonics Bar Graph and Acq
Trend.

Ripple The RMS and peak-to-peak values of the 3-Phase signal.

Efficiency Measures the ratio of output power to input power per phase for a AC/DC input and AC/DC Drive
output. Measures the total efficiency of the system. Plots the Acq Trend.

DQO Transforms three-phase AC (Voltage or Current) time domain waveforms into DC signals and are

graphically represented as vectors on a phasor plot.

A Note: Supported only when 3V3| wiring is selected.

Mechanical Analysis Measurements panel

Measurement

Description

Speed, Acceleration

Measures the speed and acceleration.
Plots the Acq Trend, Time Trend, and Histogram.
Speed defines the number of revolutions per minute of the motor.

Acceleration is defined as the speed difference computed per time at each speed value.

Table continued...
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Measurement

Description

Direction

Defines the direction of rotation of the motor. Set the direction A-B-C or A-C-B for Hall sensors and CW
or CCW for QEI based on the motor configuration.

Plots the Acq Trend and Time Trend.

Angle

Measures the phase angle. Configure QEI or Hall sensor to compute the angle measurement.
For QEI, set the number of Pulses per Rotation (PPR).

For Hall Sensor, set the number of Pole pairs.

Plots the Time Trend.

Torque

Measures the torque of the motor. Configure Sensor (analog) or Current method to measure the
torque.

Plots the Acq Trend, Time Trend, and Histogram.

If you want to measure torque over a long range, ensure that the vertical scale is properly set. If the
vertical scale or horizontal scale needs to be updated, Acq Trend plot gets reset.

Mechanical Power

Measures the mechanical power of the motor drive system. It is determined by the Speed and Torque.
It is measured in watts.

IMDA supports different sensor types to measure torque, speed, and angular position of the motor.
Mechanical power generated at the output of the motor is computed as a product of motor measured
speed and torque values.

System Efficiency Measures the total efficiency of the motor drive system.
System Efficiency is also known as Electro-Mechanical efficiency. It indicates how much electrical
energy is converted to mechanical energy. It is measured as the ratio of mechanical power to the input
electrical power.

See also

IMDA measurement configuration menu overview on page 266

The DPM tab

The DPM tab lists the optional DPM-related (Digital Power Management) measurements that you can add to the Results bar. DPM
measurements include ripple analysis, transient analysis, power sequence analysis, jitter and eye analysis.

Power rail probes are recommended for DPM measurements. For turn on time and turn off time measurements, optional to use passive
probe at the input voltage and recommended to power rail probes at the output side. The power rail probe is recommended because it
takes care of the DC rail output voltage offset and measurement results will be precise.

To open the DPM Measurements tab:
1. Tap the Add New... Measure button.

2. Tap the DPM tab.

To add a measurement to the Results bar:

1. Tap a measurement panel:

Ripple Analysis Measurements panel on page 206

Transient Analysis Measurements panel on page 206
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Power Sequence Analysis Measurements panel on page 206

Power Integrity - Signal Integrity Analysis Measurement panel on page 207

2. Select the measurement.

3. Select the number of rails in the Power Rails field.
4. Tap Add. You can also double-tap a measurement to add it to the Results bar.

Ripple Analysis Measurements panel

Measurement

Description

Ripple

Measures RMS and peak-to-peak values of the 3-Phase signal on the DC Rail. RMS is measured at
the configured ripple frequency.

Transient Analysis Measurements panel

Measurement Description
Overshoot Overshoot is the difference between Maximum and Top, divided by the Amplitude.

This measurement can be made across the entire record or on each cycle in the record.
Undershoot Undershoot is the difference between Minimum and Base, divided by the Amplitude.

This measurement can be made across the entire record or on each cycle in the record.

Turn on Overshoot

Turn on Overshoot computes the maximum amplitude value of the dc rail output voltage during turn
ON of the DUT. This supports multiple rail outputs. User has to provide input signal level to trigger
properly and measurement happens on output rail. Annotation of max value on the output is shown as
cross hair per rail output.

DC Rail Voltage

DC Rail Voltage is the mean value of each rail output. This can be performed per cycle or for the entire
record. In cycle mode, the user can specify Edge qualifier as the source to find edges. Annotation and
navigation available in cycle mode. One can traverse in navigation mode using Prev and Next buttons.

Power Sequence Analysis Measurements panel

Measurement Description

Turn On Time Measures the time delay difference between the input voltage applied to the system and the time to
develop the steady state output voltage.

Turn Off Time Measures the time delay difference between the input voltage removed from the system and the time

for the output voltage to become zero.

Jitter Analysis Measurements panel

Measurement

Description

TIE

TIE (Time Interval Error) is the difference in time between an edge in the source waveform and

the corresponding edge in a reference clock. The reference clock is usually determined by a clock
recovery process performed on the source waveform. For Explicit-Clock clock recovery, the process
is performed on an explicitly identified source. User can specify the jitter frequency and BW limit for
each rail in the measurement configuration. The measurement supports Spectrum, Eye diagram and
Histogram plots per rail.
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Measurement

Description

RJ

Random Jitter (RJ) is the rms magnitude of all timing errors not exhibiting deterministic behavior.
A single RJ value is determined for each acquisition, by means of RJ-DJ separation analysis. User
can specify the jitter frequency and BW limit for each rail in the measurement configuration. The
measurement supports Eye diagram and Histogram plots per rail.

DJ

Deterministic Jitter (DJ) is the peak-to-peak amplitude for all timing errors that follow deterministic
behavior. A single DJ value is determined for each acquisition, by means of RJ-DJ separation analysis.
User can specify the jitter frequency and BW limit for each rail in the measurement configuration. The
measurement supports Eye diagram and Histogram plots per rail.

PJ

Periodic Jitter (PJ) is the peak-to-peak amplitude for that portion of the deterministic jitter which is
periodic, but for which the period is not correlated with any data pattern in the waveform. A single PJ
value is determined for each acquisition, by means of RJ-DJ separation analysis. User can specify
the jitter frequency and BW limit for each rail in the measurement configuration. The measurement
supports Eye diagram and Histogram plots per rail.

EYEHEIGHT

Eye Height is the minimum vertical eye opening at the mid of the unit interval. This measurement is
made across the entire record. User can specify the jitter frequency for each rail in the measurement
configuration. The measurement supports Eye diagram and Histogram plots per rail.

EYEWIDTH

Eye Width is the minimum horizontal eye opening at the user-specified reference level. This
measurement is made across the entire record. User can specify the jitter frequency and BW limit for
each rail in the measurement configuration. The measurement supports Eye diagram and Histogram
plots per rail.

EYEHIGH

Eye High calculates the voltage at a selected horizontal position across the unit interval, for all High
bits in the waveform. Configure the measurement to include all bits, only transition bits, or only
non-transition bits. A histogram of the Eye High measurement corresponds to a vertical slice through
the upper half of a three-dimensional eye diagram. User can specify the jitter frequency and BW
limit for each rail in the measurement configuration. The measurement supports Eye diagram and
Histogram plots per rail.

EYELOW

Eye Low calculates the voltage at the selected horizontal position across the unit interval, for all

Low bits in the waveform. A histogram of the Eye Low measurement corresponds to a vertical slice
through the lower half of a three-dimensional eye diagram. User can specify the jitter frequency and
BW limit for each rail in the measurement configuration. The measurement supports Eye diagram and
Histogram plots per rail.

Power Integrity - Signal Integrity Analysis Measurement panel

Measurement Description

PSlJ PSIJ measurement correlates the PJ component in High Speed Signals (Victim) with Power Supply
(Aggressor) output waveform using jitter suppression technique. Jitter suppression filters out the
specified frequencies from the victim signal which were induced from power rail signal.
Configure Notch Filter with the required center frequency that needs to be removed. It is recommended
to run PSIJ measurement with constant clock recovery method.

See also

Configure panel (DPM measurement configuration menu) on page 282
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The DDR measurements tab

The DDR tab lists the optional double data rate (DDR) measurements that you can add to the Results bar. DDR measurements include

amplitude and timing analysis.

To open the DDR Measurements tab and add a measurement to the Results bar:
1. Tap the Add New... Measure button.

2. Tap the DDR tab.

To add a measurement to the Results bar:

1. Select the signal source/s.

2. Tap a measurement panel:

Amplitude Analysis measurement panel

Timing Analysis measurement panel
3. Select a measurement. If the measurement requires two signal sources, select the sources in the Source 1 and Source 2 fields.
4. Tap Add. You can also double-tap a measurement to add it to the Results bar.

Amplitude Measurements panel

Measurement Description

AOS The total area of the signal above the specified reference level.

AUS The total area of the signal below the specified reference level.

Vix(ac) The differential input cross-point voltage measured from the actual crossover voltage and its
complement signal to a designated reference voltage. This is measured on a single ended signal.

AOS Per tCK The total area of the signal that crosses the specified reference level calculated over consecutive
periods. It is applicable to clock and address/command waveforms only.

AUS Per tCK The total area of the signal that crosses the specified reference level calculated over consecutive
periods. It is applicable to clock and address/command waveforms only.

AOS Per Ul The total area of the signal that crosses the specified reference level calculated over consecutive unit
intervals. It is applicable to data and data strobe waveforms only.

AUS Per Ul The total area of the signal that crosses the specified reference level calculated over consecutive unit

intervals. It is applicable to data and data strobe waveforms only.

Timing Measurements panel

Measurement Description

tRPRE The width of the Read burst preamble. This is measured from the exit of tristate to the first driving edge
of the differential strobe.

tWPRE The width of the Write burst preamble. It is measured from the exit of tristate to the first driving edge of
the differential strobe.

tPST The width of Read or Write burst' postamble. It is measured from the last falling edge crossing the

mid reference level to the start of an undriven state (as measured by a rising trend per JEDEC
specification).

Table continued...
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Measurement Description

Hold Diff The elapsed time between the designated edge of the single ended waveform and the designated
edge of a differential waveform.
The measurement uses the closest single ended waveform edge to the differential waveform edge that
falls within the range limits.

Setup Diff The elapsed time between the designated edge of a single ended waveform and when the differential
waveform crosses its own voltage reference level.
The measurement uses the closest single ended waveform edge to the differential waveform edge that
falls within the range limits.

tCH(avg) The average high pulse width calculated across a sliding 200 cycle window of consecutive high pulses.

tCK(avg) The average clock period across a sliding 200-cycle window.

tCL(avg) The average low pulse width calculated across a sliding 200 cycle window of consecutive low pulses.

tCH(abs) The high pulse width of the differential clock signal. It is the amount of time the waveform remains
above the mid reference voltage level.

tCL(abs) The low pulse width of the differential clock signal. It is the amount of time the waveform remains
below the mid reference voltage level.

tJIT(duty) The largest elapsed time between tCH and tCH(avg) or tCL and tCL(avg) for a 200-cycle window.

tJIT(per) The largest elapsed time between tCK and tCK(avg) for a 200-cycle sliding window.

tJIT(cc) The absolute difference in clock period between two consecutive clock cycles.

tERR(n) The cumulative error across multiple consecutive cycles from tCK(avg). It measures time difference
between the sum of clock period for a 200-cycle window to n times tCK(avg).

tERR(m-n) The cumulative error across multiple consecutive cycles from tCK(avg). It measures the time difference
between the sum of clock periods for a 200-cycle window to n times tCK(avg).

tDQSCK The strobe output access time from the differential clock. It is measured between the rising edge of the
clock before or after the differential strobe Read preamble time. The edge locations are determined by
the mid-reference voltage levels.

tCMD-CMD The elapsed time between two logic states.

tCKSRE The valid clock cycles required after Self Refresh Entry (SRE) command. Changing the input clock
frequency or the supply voltage is permissible only after tCKSRE time when the SRE command is
registered.

tCKSRX The valid clock cycles required before the Self Refresh Exit (SRX) command. Changing the input clock
frequency or the supply voltage is permissible provided the new clock frequency or supply voltage is
stable for the tCKSRX time prior to SRX command.

See also

DDR measurement configuration menu overview on page 289

The WBG-DPT tab

The WBG-DPT tab lists the optional WBG-DPT-related measurements that you can add to the Results bar. WBG-DPT measurements
include switching parameter analysis, switching timing analysis, and diode recovery analysis. The WBG-DPT measurements are supported

for 4/5/6 Series oscilloscopes.

To open the WBG-DPT Measurement tab:
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1. Tap the Add New... Measure button.

2. Tap the WBG-DPT tab.

To add a measurement to the Results bar:

1. Select the sources in the Source fields as per the measurement requirement. Example: if the measurement requires three signal
sources, select the sources in the Source 1, Source 2, and Source 3 fields.

2. Select the Power Device as MOSFET or IGBT.

3. Tap a measurement panel:

Switching Parameter Analysis measurements panel on page 210

Switching Timing Analysis measurements panel on page 210

Diode Recovery Analysis measurements panel on page 210

Capacitance Analysis measurements panel on page 211

4. Select the measurement.

5. Tap Add. You can also double-tap a measurement to add it to the Results bar.

Switching Parameter Analysis measurements panel

Measurement Description

Eon Measures the energy dissipated in the Power Device during on region using the configured levels.
Eoff Measures the energy dissipated in the Power Device during off region using the configured levels.
Vpeak Measures the peak voltage of the Power Device in the off region.

Ipeak Measures the peak current of the Power Device in the on region.

Switching Timing Analysis measurements panel

Measurement Description

Td(on) Measures the turn on delay time of the Power Device in the on region using the configured levels.

Td(off) Measures the turn off delay time of the Power Device in the off region using the configured levels.

Tr Measures the rise time of the Power Device in the on region using the configured levels.

T; Measures the fall time of the Power Device in the off region using the configured levels.

Ton Measures the turn on time of the Power Device. It is the sum of the turn on delay time and the rise
time.

Toff Measures the turn off time of the Power Device. It is the sum of the turn off delay time and the fall time.

d/dt Measures the rate of change of voltage or current (slew rate) from the configured start level to the stop
level.

Tdt Measures the time delay of the Power Device during simultaneous switching. It is the time interval

between the falling edge of the first gate voltage and the rising edge of the second gate voltage.

Diode Recovery Analysis measurements panel

Measurement Description
Trr Measures the reverse recovery time of the Power Device using the configured levels.
Qrr Measures the reverse recovery charge in the Power Device using the configured levels.
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Measurement Description

Err Measures the reverse recovery energy dissipated in the Power Device using the configured levels.

Irrm Measures the maximum current dissipated in the Power Device in the reverse recovery region.

Diode d/dt Measures the rate of change of voltage or current (slew rate) during the specified start and stop
integration levels. Diode d/dt can be measured during rising or falling edge.

Capacitance Analysis measurements panel

Measurement Description

Qoss The output charge Qoss of Wide Band Gap (WBG) device is the charge that must be supplied to the
parasitic output capacitances of a Power Device during each switching cycle.

See also

WBG-DPT measurement configuration menu overview on page 291

Measurement configuration menu overview

Use this configuration menu to add statistics to a measurement badge readout, plot a measurement, and change measurement settings
including source, scope (global or local), reference levels, gating, clock recovery, bandwidth filters, results limits, and pass/fail testing.

To open a Measurement configuration menu for a measurement, double-tap a Measurement badge in the Results bar. The configuration
menu and panels only show fields and controls relevant to the selected measurement.

The menu opens on the measurement name panel (the name of the measurement), which provides controls to display additional statistics
to the measurement badge, display plots of the measurement, and so on. The content of the measurement name panel depends on the
measurement. The most common Measurement Name fields are listed in the following table.

Measurement configuration menu fields, controls, and panels

Field, control, or panel

Description

Measurement Statistics

(Measurement name panel)

A list of measurement statistics related to the measurement. You can add these statistics to a
measurement badge by selecting the Show Statistics in Badge control.

Show Statistics in Badge

(Measurement name panel)

Adds the listed statistical measurement readouts to the measurement badge readout.

Plots

(Measurement name panel)

Buttons that open Plot views of the measurement. Available plots depend on the measurement. Plot
types include Time Trend, Histogram, Spectrum, and Eye Diagram (for jitter measurements). To add a
plot to the screen, tap the plot button.

See Add Plot configuration menu on page 342.

Configure panel

Sets the source, label text, and other fields that are specific to each measurement type.

See Configure panel (Measurement configuration menu) on page 213.

Reference Levels panel

Sets the reference levels and units used to take measurements, the scope of the reference level
settings (global or local), and the method used to calculate the Top and Base waveform values.

See Reference Levels panel (Measurement configuration menu) on page 216.

Table continued...
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Field, control, or panel

Description

Clock Recovery panel

(jitter measurements)

Sets the clock recovery settings for some jitter measurements.

See Clock Recovery panel (Measurement configuration menu) on page 217.

Gating panel

Sets the measurement region (gate) used to take measurements. Select the scope of the gate setting
(global or local), and the type of gating to use.

See Gating panel (Measurement configuration menu) on page 221.

Filter/Limit Results panel

Sets the scope of the filtering setting (global or local), high and low pass filter settings, the range of
measurement result limits, and the limit measurement population size.

See Filter/Limit Results panel (Measurement Settings menu) on page 223.

Pass/Fail Testing panel

Sets the conditions for pass/fail testing for measurements and sets actions to take when a
measurement fails.

See Pass/Fail Testing panel (Measurement Settings menu) on page 224.

Measurement Name panel (Measurement configuration menu)

The Measurement Name panel (the name of the measurement) provides controls for adding display statistics to the measurement badge
and opening plots of the measurement.

To open the measurement name panel, double-tap a Measurement badge. This is the default panel shown when you open a Measurement

settings menu.

The content of the Measurement Name panel depends on the measurement.

Field or control

Description

Measurement Statistics

A list of measurement statistics. You can add these statistics to a measurement badge by selecting the
Show Statistics in Badge control.

Show Statistics in Badge

Select to add the listed statistical measurement readouts to the measurement badge.

Plots

Adds a Plot view of the measurement value to the screen. Available plots depend on the
measurement. Plot types include Time Trend, Histogram, Spectrum, and Eye Diagram (for jitter
measurements).

Trend adds the trend plot to the Waveform view.

See also

Configure panel (Measurement configuration menu) on page 213

Reference Levels panel (Measurement configuration menu) on page 216

Clock Recovery panel (Measurement configuration menu) on page 217

Gating panel (Measurement configuration menu) on page 221

Filter/Limit Results panel (Measurement Settings menu) on page 223

Pass/Fail Testing panel (Measurement Settings menu) on page 224
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Configure panel (Measurement configuration menu)

Use the Configure panel to set the measurement source(s), add a custom name (label) for the measurement, and other parameters.

To open the Configure panel:

1. Double-tap a Measurement badge to open the Measurement configuration menu.

2. Tap the Configure panel.

Not all items listed are shown for all measurements; The panel only shows fields and controls relevant to the selected measurement.

Field or control

Description

Source Sets the signal source used to take the measurement. Tap the field to show the list of available
sources. If the measurement requires more than one source, multiple Source fields are displayed.

Label Sets the name of the measurement. You can use the default name, or double-tap in the field and
change the label using a connected keyboard or the virtual keyboard.

Signal Type Sets the signal type (Clock, Data, Auto, Single Ended, Differential) of the source signal for some

measurements.

Show Rho Waveform

Sets the display of the reflection coefficient waveform that is computed from the voltage waveform. If
the Signal Type is set to Differential, two Rho waveforms will be added to the waveform view.

This field is available for TDR measurement only.

TDR Preset

Sets the vertical and horizontal settings, trigger, and acquisition settings to ensure optimal TDR
measurement configuration.

TDR Preset should be performed with high quality 50 Q SMA cable.

Note: The Rho waveform from a TDR measurement is not suitable as a voltage source for
the same instance.

Edge, Clock edge

Sets the edge of the signal to use for starting the measurement.

From Edge

Sets the Source 1 waveform edge on which to start the measurement, for two-source measurements.

To Edge

Sets the Source 2 waveform edge on which to stop the measurement, for two-source measurements.

Calculate One Measurement
Per

Sets the amount of waveform data to use to calculate one measurement; one measurement across the
entire waveform record or one measurement for each cycle of the waveform in the record.

Pattern Detection

Auto attempts to detect the type of pattern and set.

Pattern Type Sets whether the source signal data is a Repeating pattern or an Arbitrary pattern type.
Pattern Length Sets the pattern length to use when Pattern Type is Repeating.
Window Length Sets the overall window length to use when Pattern Type is Arbitrary.

Other measurement panels

Measurement Name panel (Measurement configuration menu) on page 212

Reference Levels panel (Measurement configuration menu) on page 216

Clock Recovery panel (Measurement configuration menu) on page 217

Clock Recovery- Advanced Settings configuration menu on page 221

Gating panel (Measurement configuration menu) on page 221

Filter/Limit Results panel (Measurement Settings menu) on page 223
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Pass/Fail Testing panel (Measurement Settings menu) on page 224

TDR Preset

The TDR Preset significantly relies on the specific TDR source used in the measurement system.

This feature sets the vertical settings of voltage sources and trigger source of the oscilloscope to the TDR source channel. TDR preset
calibrates each line of TDR using average acquisition mode. It also sets the optimal sample rate and horizontal scale to accommodate
incident and first reflection of the voltage waveform.

4/5/6 Series MSO

USB Power
DUT | Picotest Differential TDR
E 8 PIN:J2154A
ENNER
[} 1 3
111
]

1303-009
Note:

SMA cables connects oscilloscope and J2154A
= SMA cables connects DUT and J2154A

Figure 15: Connection diagram for TDR single-ended

214



Menus and dialog boxes

4/5/6 Series MSO

USB Power

DUT Picotest Differential TDR
B PIN: J2154A

1303-008

Note:

SMA cables connects oscilloscope and J2154A

= SMA cables connects DUT and J2154A

Figure 16: Connection diagram for TDR differential

Note: The TDR Preset feature supports only the Picotest J2154A as a TDR source and the trigger is always set for negative TDR
originating from the port 3.

Use the following steps to run a TDR Preset on the TDR measurements:

1.

1.

Add the TDR measurement.

2. Double-tap the TDR measurement results badge for the required measurement.
3.
4. Connect port 1 and port 3 of J2154A to the oscilloscope channels using identical SMA cables. Refer Connection diagram for TDR

Configure the TDR measurement voltage sources based on the signal type.

differential.

For Single-Ended TDR, connect high-quality 50 Q SMA cable to the port 4 of J2154A. The SMA cable should be terminated at far ends
with exactly the same termination as the DUT termination. Refer Connection diagram for TDR single-ended.

For Differential TDR, connect high quality identical 50 ohm SMA cables to the port 2 and port 4 of J2154A. The SMA cable should be
terminated at far ends with exactly the same termination as the DUT termination. Refer Connection diagram for TDR differential.

Tap TDR Preset button for the autoset and calibration.

This performs the following settings:

Sets the vertical channel settings for 50 Q termination with DC coupling.

Sets the horizontal settings for optimal sample rate and horizontal scale as per detected reflection.
Performs calibration for each source and apply those calibration for the measurement instance.
Refer the details on TDR Calibration algorithm.
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A Note: In case of failure, the instrument displays a popup error message. See Errors and Warnings.

Note: The TDR Preset is specific to a previously calibrated termination. Please rerun the TDR Preset whenever there is a
significant change in the DUT termination.

Reference Levels panel (Measurement configuration menu)

Use the Reference Levels panel to set the scope of the reference level settings (global or local), the reference levels (High, Mid, and Low),
the units used to take measurements, and the method used to calculate the Top and Base waveform values. You can set the levels to be
the same or different for rising and falling edges.

To open the Reference Levels panel:

1. Double-tap a Measurement badge.
2. Tap the Reference Levels panel.

Reference Levels panel- fields and controls

Not all items listed in the table are shown for all measurements; The panel only shows fields and controls relevant to the selected
measurement.

Field or control Description

Reference Levels Global sets whether the reference levels defined in this measurement apply to all measurements that
are set to global (the default setting).

Local sets the Reference Level parameters to apply to just this measurement.

Source Lists the source signals used for each edge of the measurement.

Set Levels In Sets the method used to set or calculate the High, Mid, and Low reference levels. Select % or Units
and use the Multipurpose Knob to set custom reference values.

Levels Sets the reference levels as specified percentages of the Top and Base waveform measurement.

To set custom reference values, tap Custom, tap a setting field, and use the Multipurpose Knob to set
the different % (relative) or absolute values.

High and Low references are used to calculate rise and fall times. The default High reference is 90%
and Low reference is 10%.

Mid reference is primarily used for measurements between edges such as pulse widths. The default
level is 50%.

Table continued...
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Field or control

Description

Base Top Method

Sets the method to calculate the waveform Base and Top values, which is then used to calculate the
High, Mid, and Low reference levels.

Auto is the default method, and automatically determines the best Base Top method to use. Most
commonly sets the Top Base method to Histogram Mode.

MinMax Uses the minimum and maximum values in the waveform record to determine the base and
top amplitude. Useful on a waveform with low noise and free from excessive overshoot.

Histogram Mean uses histogram analysis to calculate the mean or average value using all values
above and below the waveform midpoint. Top is set to the mean high value, and Base is set to the
mean low value.

Histogram Mode uses histogram analysis to calculate the most common values above and below the
waveform midpoint. Top is set to the common high value, and Base is set to the common low value.

Histogram Eye Center uses histogram analysis to determine the base top amplitude. Creates a
histogram of the amplitudes in the center of each bit (unit interval) while ignoring the waveform during
bit transitions. The histogram should have a peak at the nominal high level and another peak at the
nominal low level.

Note: If you set the Base Top Method to other than Auto, and do not change the Reference
Levels mode to Local, many existing measurements, as well as measurements that you add
to the Results bar, will use the new Base Top Method values for taking measurements. This
may result in measurement values that you are not expecting.

Hysteresis

Sets the threshold margin to the reference level which the signal must cross to be recognized as
changing; the margin is the relative reference level plus or minus half the hysteresis. Use hysteresis to
filter out spurious events. Tap the field and use the Multipurpose Knob to change the value.

Other measurement settings panels

Measurement Name panel (Measurement configuration menu) on page 212

Configure panel (Measurement configuration menu) on page 213

Clock Recovery panel (Measurement configuration menu) on page 217

Clock Recovery- Advanced Settings configuration menu on page 221

Gating panel (Measurement configuration menu) on page 221

Filter/Limit Results panel (Measurement Settings menu) on page 223

Pass/Fail Testing panel (Measurement Settings menu) on page 224

Clock Recovery panel (Measurement configuration menu)

Clock recovery refers to the process of establishing a reference clock, the edges of which can be used as a basis for timing comparisons.
Use the Clock Recovery panel to configure the clock recovery settings for measurements that require a clock signal.

To access the Clock Recovery panel:

1. Double-tap a Measurement badge on the Results bar that uses clock recovery (such as jitter measurements), to open the Meas

configuration menu.

2. Tap the Clock Recovery panel.

4/5/6 Series MSO MSO4X, MSO4XB, MSO5X, MSO5XB, MSO64, MSO6XB, MSO58LP, and LPD64 Help 217



Menus and dialog boxes

Measurement configuration menu, Clock Recovery panel

Field or control

Description

Clock Recovery

Global sets whether the Clock Recovery settings defined in this panel apply to all measurements with
clock recovery settings that are set to global (the default setting).

Local sets the Clock Recovery parameters to apply to just this measurement.

Method

PLL simulates the behavior of the specified hardware Phase Locked Loop clock recovery circuit to
derive the clock signal.

Constant Clock uses linear regression so that the recovered clock minimizes the mean squared sum
of the Time Interval Error (TIE) for that waveform.

Explicit Clock derives the reference clock from a specified channel other than the one upon which the
measurement is defined.

Standard

Sets the standard to use for the PLL model. Information for a selected standard is listed under the
drop-down list.

Available only when Method is PLL.

Mode

Mean chooses both the frequency and the phase to minimize the mean squared error. Available when
Method is Constant Clock.

Median chooses the phase so that the median error between the recovered and measured edges is
zero. Available when Method is Constant Clock.

Fixed uses the specified frequency but chooses the phase so that the median error between the
recovered and measured edges is zero. Available when Method is Constant Clock.

Select Explicit Clock-Edge method if you want to use the edges found in the selected clock source
(possibly multiplied up by an integral number). If the Clock Multiplier is set to 1 (the default), only these
edges will be used. If the Clock Multiplier is set to a number N other than 1, linear interpolation will

be used between each pair of actual edges to create N-1 additional reference edges. The interpolated
edge times, combined with the actual edges, give a total of N reference edge times per actual edge.
Available when Method is Explicit Clock.

Select Explicit Clock-PLL as the clock recovery method if you want to feed the edges from the
selected clock source through a PLL rather than using them directly. The actual edges from the clock
source will be used to drive a software PLL model, and the edge times coming out of the PLL will be
used as the reference edges for the target measurement. If the Clock Multiplier is set to a number N
other than 1, the output of the PLL will have N edges per actual edge. Only available when Method is
Explicit Clock.

Calculate On

First Acq. sets the clock-recovery algorithm to choose a new best-fit clock frequency and phase on
just the first acquisition. Subsequent acquisitions will choose a best fit on clock phase but retain the
clock frequency found in the first acquisition.

Every Acg. the clock-recovery algorithm to choose a new best-fit clock frequency and phase for each
new oscilloscope acquisition.

Clearing the measurement results will reset the clock recovery so that both frequency and phase are
optimized on the subsequent acquisition.

Available when Method is Constant Clock and Mode is Mean or Median.

Table continued...
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Field or control

Description

Clock Frequency

Sets the clock frequency to use in Fixed mode. The clock in the waveform is ignored; the instrument
uses the specified frequency, with the clock phase determined by best fit.

A Note: This method typically results in a closed eye.

Available when Method is Constant Clock and Mode is Fixed.

Loop BW

Sets the PLL loop bandwidth. Displays the Closed Loop bandwidth that has been configured based on
the current standard.

Available when Method is PLL.

Clock Source

Sets the source for the explicit clock.

Available when Method is Explicit Clock.

Clock Edge

Set whether the rising, falling or both edges of the clock source should be considered.

Available when Method is Explicit Clock.

Clock Multiplier

Set the number of edges to be used.

If the Clock Multiplier is set to 1 (the default), only these edges will be used. If the Clock Multiplier is
set to a number N other than 1, linear interpolation will be used between each pair of actual edges to
create N-1 additional reference edges. The interpolated edge times, combined with the actual edges,
give a total of N reference edge times per actual edge.

Available when Method is Explicit Clock.

Clock Offset

Set to Auto or Manual.

Offset

Sets the clock offset amount relative to data.

To compare the reference clock times to the edge times from the data source, some assumptions must
be made about how they align. The default assumption is that each data source edge is associated
with the reference clock edge to which it is nearest in time. This assumption may not be optimum, for
example if the probes for the reference clock and data signal have different cable lengths.

Available when Clock Offset is Manual.

PLL Model

Select the PLL model type. The PLL control area provides control over the phase-locked loop used for
clock recovery. You can choose the loop bandwidth and the loop order, and if a Type Il loop is chosen,
you can specify the damping factor.

To set the loop bandwidth automatically, based on a serial standard, select PLL: Standard BW as the
clock recovery method. From the Standard: b/s list box, select the standard that matches your data
link. For example, choose “PCI-E: 2.5” to test a 2.5 Ghit/second PCI Express link. In this case, the
PLL bandwidth will be set to 1.5 MHz, which is 1/1667 of the baud rate as specified in PCI Express
standard.

You can use the PLL Model list box to choose between Type | and Type Il loop. A Type | loop has

a transfer function that approaches zero frequency with a slope of 1/s and a Type Il loop approaches
zero frequency with a 1/s2 slope (In much of the PLL literature, these terms are used interchangeably
with First-Order and Second-Order loops. For a thorough discussion of loop type versus order, see
Frequency Synthesis by Phase Lock, by William Egan).

Available when Method is Explicit Clock and Mode is Explicit Clock - PLL.

Table continued...
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Field or control Description
JTF BW Displays or sets the Jitter Transfer Function bandwidth that has been configured based on the current
standard.

Available when Method is Explicit Clock and Mode is Explicit Clock - PLL and PLL Model is Type II.

Damping Sets the damping factor for the PLL. It is enabled only for Type Il phase-locked loop.

Available when Method is Explicit Clock and Mode is Explicit Clock - PLL and PLL Model is Type
Il.

Automatic Transition Density | Toggles the automatic transition density compensation to On or Off. By default it is Off.

Compensation When on, the loop feedback time constants are adjusted to make the actual transfer function more

closely match a mathematical filter polynomial. When off, the clock recovery algorithm is configured for
an assumed 50% transition density.

Available when Method is PLL or Explicit clock and Mode is Explicit Clock-PLL.

Advanced Opens the Clock Recovery-Advanced Settings configuration menu to refine the recovered clock signal.
See Clock Recovery- Advanced Settings configuration menu on page 221.

Available when Method is PLL.

About constant clock recovery

In Constant Clock Recovery, the clock is assumed to be of the form A*sin (2 ft +phase), where the frequency (f) and phase are treated as
unknown constants. Once a source waveform has been acquired and the edges extracted, one or both of these constants are determined
using linear regression, so that the recovered clock minimizes the mean squared sum of the Time Interval Error (TIE) for that waveform.

About PLL loop BW versus JTF BW

Phase locked loops are characterized according to their bandwidth (BW), and several different bandwidths are commonly used. The
terminology used for these bandwidths is described here, since it varies somewhat across different industries.

+ Loop BW (or Closed Loop BW) is the frequency at which the closed-loop gain has fallen to -3 dB (half power) relative to unity-gain. The
closed-loop gain function has the character of a low-pass filter.

« JTF BW (ditter Transfer Function BW or Error Function BW) is the frequency below which input jitter to a tracking loop is removed. The
JTF BW has a high-pass filter characteristic.

For Type I loops, the Loop BW and the JTF BW are always equal. For Type Il loops, these two bandwidths are different, and their ratio
depends on the PLL damping factor. You can choose to specify either bandwidth, and the other is displayed for reference.

PLL-based clock recovery

PLL-based clock recovery is implemented using a software model of a hardware PLL circuit, sequentially processing waveform transitions
and adjusting the clock period in a feedback loop. This approach means that the transition density of the input signal has subtle effects

on the effective bandwidth and damping factor of the feedback loop, just as it does with actual hardware PLLs. The influence of transition
density is only relevant for data signals, since clock signals (or data signals with a two bit pattern) have 100% transition density.

Other measurement settings panels

Measurement Name panel (Measurement configuration menu) on page 212
Configure panel (Measurement configuration menu) on page 213
Reference Levels panel (Measurement configuration menu) on page 216

Clock Recovery- Advanced Settings configuration menu on page 221
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Gating panel (Measurement configuration menu) on page 221
Filter/Limit Results panel (Measurement Settings menu) on page 223

Pass/Fail Testing panel (Measurement Settings menu) on page 224

Clock Recovery- Advanced Settings configuration menu
Sets advanced clock recovery settings such as defining a nominal data rate or basing clock recovery on a known data pattern.
To open the Clock Recovery-Advanced Settings configuration menu:

1. Double-tap a measurement that requires clock recovery information (such as jitter measurements).
2. Tap the Clock Recovery panel
3. Tap the Advanced button.

Clock Recovery-Advanced Settings configuration menu, fields and controls

Field or control Description

Advanced Clock Recovery Sets the method used to recover a clock from the measured signal. Available selections are None
Method (default), Nominal Data Rate and Known Data Pattern.

Bit Rate Sets the clock bit rate. The Bit Rate field is only present when Advanced Clock Recovery Method is

set to Nominal Data Rate.

Pattern File Drop-down list with 20 most recent pattern files loaded onto the oscilloscope.

Available when Advanced Clock Recovery = Known Data Pattern.

Browse Opens a standard file navigation window. Use to navigate to and select a pattern file.

See also

Measurement Name panel (Measurement configuration menu) on page 212
Configure panel (Measurement configuration menu) on page 213
Reference Levels panel (Measurement configuration menu) on page 216
Clock Recovery panel (Measurement configuration menu) on page 217
Gating panel (Measurement configuration menu) on page 221

Filter/Limit Results panel (Measurement Settings menu) on page 223

Pass/Fail Testing panel (Measurement Settings menu) on page 224

Gating panel (Measurement configuration menu)
Use Gating to confine a measurement to a certain part of a waveform.
To open the Gating panel;

1. Double-tap a Measurement badge in the Results bar to open the Measurement configuration menu.
2. Tap the Gating panel.
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Gating panel, fields and controls

Not all items listed in the table are shown for all measurements; The panel shows fields and controls relevant to the selected

measurement.

Field or control

Description

Gating

Sets whether this measurement's gating settings are Global or Local.

When Global is selected, changing anything in this panel causes the same change to all other
measurements that also have Global selected.

When Local is selected, settings in this panel only effect this measurement.

Gating Type

Sets the gate type used to take measurements.
None: Measurements are taken across the entire record.

Screen: Measurements are taken on the portion of the waveform shown on the display. When zoom is
on, the ‘display’ on which to measure is the zoom window.

Cursors: Measurements are taken on the portion of the waveform between the cursors.
Logic: Measurements are taken only when the logical state of a specified waveform is true.

Search: Measurements are taken between the start and stop times defined by a specified search.
Search gating is only valid for DDR3 measurements on a 6 Series MSO instrument.

Time: Measurements are taken between the times specified in the Start Gate Time and End Gate
Time fields, relative to the trigger point (0 s).

Source

Sets the signal source to use for Logic or Search gates.
If Gating Type is Logic, the Source field lists all available sources.

If Gating Type is Search, the Source field lists all available searches.

Threshold

Sets the threshold value for the Logic gate source to be considered a logic 1 value. Available when
Source is Logic.

Hysteresis

Sets the Hysteresis value for the Logic gate source. Available when Source is Logic.

Active

Sets the logic state value for the Logic gate source. Available when Source is Logic.

Start Gate Time
End Gate Time

Sets the starting time (Start Gate) and ending time (End Gate) between which to take a measurement.
The starting and ending gate times are relative to the trigger time (0 s). Available when Gating Type is
Time.

Guidelines

+  Only one gated region is allowed per measurement. You can create duplicate measurements and define different gates for each one.
+ Tap on a gating-enabled measurement badge to display the vertical gate bars on the waveform for that measurement.

+ Gating is indicated by two vertical bars; one at the start of the gated region and one at the end.

+ If the measurement has more than one source, gate bars are drawn on both sources.

+ Time gates can be placed anywhere. They can precede acquisition start value and extend beyond the acquisition value.

+ The Time Gating bars are shown in both the overview and zoomed view when zoom is on.

See also

Measurement Name panel (Measurement configuration menu) on page 212

Configure panel (Measurement configuration menu) on page 213
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Reference Levels panel (Measurement configuration menu) on page 216

Clock Recovery panel (Measurement configuration menu) on page 217

Clock Recovery- Advanced Settings configuration menu on page 221

Filter/Limit Results panel (Measurement Settings menu) on page 223

Pass/Fail Testing panel (Measurement Settings menu) on page 224

Filter/Limit Results panel (Measurement Settings menu)

Use these settings to apply a High Pass and/or Low Pass filter to block specified frequency band components when taking measurements.
Use the limit controls to set range of measurement values to measure, and the number of measurements to take (population).

To open the Filter/Limit Results panel:

1. Double-tap a Measurement badge.
2. Tap the Filter/Limit Results panel.

Filter/Limit Results panel fields and controls

Not all items listed in the table may be shown for all measurements; The panel only shows fields and controls relevant to the selected

measurement.

Field or control

Description

Filter Measurement Results

Sets whether this measurement's filter and limits settings are Global or Local.

When set to Global (the default), changing anything in this panel causes the same change to all other
measurement filter and limit settings that also have Global selected.

When set to Local, changing anything in this panel only effects this measurement.

High Pass Filter

Blocks the low frequency band and passes only the high frequency band of the waveform.

Select a Butterworth filter order (No Filter (default), 1st, 2nd, or 3rd) and enter the roll-off frequency in
the field.

FP Freq (F1)

High Pass filter cut-off frequency at which the filter magnitude falls by 3 dB.

Low Pass Filter

Blocks the high frequency band and passes only the low frequency band of the waveform.

Select a Butterworth filter order (No Filter (default), 1st, 2nd, or 3rd) and enter the roll-off frequency in
the field.

LP Freq (F2)

Low Pass filter cut-off frequency at which the filter magnitude falls by 3 dB.

Limit Measurement Results

Limit taking measurements results to those that are within the specified Min Value and Max value
range.

Limit Measurement Population

Limit measurements to the specified number of measurements.

Other measurement settings panels

Measurement Name panel (Measurement configuration menu) on page 212

Configure panel (Measurement configuration menu) on page 213

Reference Levels panel (Measurement configuration menu) on page 216

Clock Recovery panel (Measurement configuration menu) on page 217
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Clock Recovery- Advanced Settings configuration menu on page 221
Gating panel (Measurement configuration menu) on page 221

Pass/Fail Testing panel (Measurement Settings menu) on page 224

Pass/Fail Testing panel (Measurement Settings menu)
Use these settings to test measurement values against a specified limit and set actions for the instrument to take on failure.
To open the PASS/FAIL TESTING panel:

1. Double-tap a Measurement badge.
2. Tap the Pass/Fail Testing panel.

Pass/Fail Testing panel fields and controls

Not all items listed in the table may be shown for all measurements; The panel only shows fields and controls relevant to the selected
measurement.

Field or control Description

Pass/Fail Test Turns pass/fail testing on or off. Default is off.

Fail When Sets the condition for when the test on the measurement will fail. Default is < Limit.

Limit Sets the measurement limit value. This control is present when Fail When is not set to Inside Range
or Outside Range.

Low Limit Sets the low limit for the measurement value. This control is only present when Fail When is set to

Inside Range or Outside Range.

High Limit Sets the high limit for the measurement value. This control is only present when Fail When is set to
Inside Range or Outside Range.

Actions on Failure Opens a configuration menu to set the actions the instrument takes when the test fails.

See Act On Event configuration menu on page 179.

Badge Navigation Sets the navigation in the results badge.
Tap to toggle to view Failures or All Occurrences.
When Failure is selected the navigation buttons move from failure to failure.

When All Occurrences is selected, the navigation button moves through each occurrence.

Other measurement settings panels

Measurement Name panel (Measurement configuration menu) on page 212
Configure panel (Measurement configuration menu) on page 213
Reference Levels panel (Measurement configuration menu) on page 216
Clock Recovery panel (Measurement configuration menu) on page 217
Clock Recovery- Advanced Settings configuration menu on page 221
Gating panel (Measurement configuration menu) on page 221

Filter/Limit Results panel (Measurement Settings menu) on page 223

224



Menus and dialog boxes

Spectrum measurements configuration menu overview

Use this configuration menu to add statistics to a Spectrum measurement badge readout, plot a measurement, and change measurement
settings including; source and pass/fail testing.

To open the Spectrum measurement configuration menu, double-tap a Spectrum measurement badge in the Results bar. The configuration
menu and panels only show fields and controls relevant to the selected measurement.

The menu opens on the measurement name panel, which provides controls to display additional statistics to the measurement badge,
display plots of the measurement, and so on. The Measurement Name panel only shows fields and controls relevant to the selected
measurement. The most common Spectrum measurement name fields are listed in the following table.

Spectrum measurement configuration menu fields, controls, and panels

Field,control, or panel Description

Measurement Name panel Displays the list of measurement statistics related to the measurement. You can add these to a
measurement badge by selecting the Show Statistics in Badge control. The measurement badge
displays the listed statistical measurement readouts.

Opens Plot views of the measurement. To add a plot to the screen, tap the Plot button. Plot type
includes Histogram only.

See Histogram plot configuration menu on page 534.

Configure panel Sets the source, label text, and other fields that are specific to each measurement type.

See Configure panel (Spectrum measurements configuration menu) on page 226

Pass/Fail Testing panel Sets the conditions for pass/fail testing for measurements and sets actions to take when a
measurement fails.

See Pass/Fail Testing panel (Spectrum measurement configuration menu) on page 228.

Spectrum Measurements Name panel (Measurement configuration menu)

The Spectrum Measurements Name panel provides controls for adding display statistics to the measurement badge and opening plots of
the measurement.

To open the Spectrum Measurements Name panel, double-tap a Spectrum Measurements badge. This is the default panel shown when
you open a Spectrum Measurements settings menu.

The contents of the Measurement Name panel depends on the selected measurement.

Field,control, or panel Description

Measurement Statistics A list of statistics related to the measurement. You can add these to a measurement badge by
selecting the Show Statistics in Badge control.

Show Statistics in Badge Adds the listed statistical measurement readouts to the measurement badge readout.

The show statistics in badge is available for Channel Power and Occupied Bandwidth measurements
only.

Plots Opens Plot views of the measurement. Available plot is Histogram.

To add a plot to the screen, tap the Plot button. See Histogram plot configuration menu on page 534.
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See also
Spectrum measurements configuration menu overview on page 225
Configure panel (Spectrum measurements configuration menu) on page 226

Pass/Fail Testing panel (Spectrum measurement configuration menu) on page 228.

Configure panel (Spectrum measurements configuration menu)
Use the configure panel to set the measurement source, add a custom label for the measurement and other parameters.
To open the Configure panel for a Spectrum measurements:

1. Double-tap a Spectrum measurement badge to open the configuration menu.
2. Tap the Configure panel.

Channel Power measurement: Configure panel
MEAS 1 ©

Ch 1_SV_Normal v Channel Power

Field, control, or panel Description

Source Select the input signal channel from the Source drop-down menu.

Label Sets the name of the measurement. You can use the default name, or double-tap in the
field and change the label using a connected keyboard or the virtual keyboard.

Channel Width Sets the channel width. Default width is 10 MHz.

Enable RRC Filter Enables the RRC filter. Default is unchecked.

Filter Parameter Sets the filter parameter. Available when Enable RRC Filter box is checked. Default value
is 0.22.

Symbol Rate Sets the symbol rate. Available when Enable RRC Filter box is checked. Default rate is
3.84 MHz.
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Occupied Bandwidth measurement: Configure panel

Ch 1.5V _Normal v

Field, control, or panel

Description

Source Select the input signal channel from the Source drop-down menu.

Label Sets the name of the measurement. You can use the default name, or double-tap in the
field and change the label using a connected keyboard or the virtual keyboard.

Analysis Bandwidth Sets the analysis bandwidth. Default bandwidth is 10 MHz.

Method Sets the method as % of Power or dB Down. Default method is % of Power.

% of Power

Sets the percentage of power. Default value is 99.9%.

Available when Method is % of Power.

dB Down

Sets the db down. Default is -26 dB. Available when Method is dB Down.

ACPR measurement: Configure panel

Field, control, or panel

Description

Source

Select the input signal channel from the Source drop-down menu.

Label

Sets the name of the measurement. You can use the default name, or double-tap in the
field and change the label using a connected keyboard or the virtual keyboard.

Table continued...
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Field, control, or panel

Description

Adjacent Channels

Sets the number of adjacent channels. Default adjacent channel is 1.

Channel Width

Sets the channel width. Default channel width is 4 MHz.

Channel Spacing

Sets the channel spacing. It is a difference in frequency between the centers of each
channel. Default channel spacing is 5 MHz.

Pass/Fail Testing panel (Spectrum measurement configuration menu)

Use these settings to test measurement values against a specified limits and set actions for the instrument to take on failure.

See Pass/Fail Testing panel (Measurement Settings menu) on page 224 for the Pass/Fail Testing panel fields and controls.

Passi/fail testing panel is available for Channel Power and Occupied Bandwidth measurements only.

See also

Spectrum Measurements Name panel (Measurement configuration menu) on page 225

Configure panel (Spectrum measurements configuration menu) on page 226

Jitter measurement configuration menu overview

Use this configuration menu to add statistics to a Jitter measurement badge readout, plot a measurement, and change measurement
settings including; source, scope (global or local), reference levels, and gating.

To open the Jitter measurement configuration menu for a measurement, double-tap a Jitter measurement badge in the Results bar. The
configuration menu and panels only show fields and controls relevant to the selected measurement.

The menu opens on the measurement name panel (the name of the measurement), which provides controls to display additional statistics
to the measurement badge, display plots of the measurement, and so on. The measurement name panel only shows fields and controls
relevant to the selected measurement. The most common Jitter measurement name fields are listed in the following table.

Jitter Measurement configuration menu fields, controls, and panels

Field, control, or panel

Description

Measurement Statistics

(Measurement name panel)

A list of measurement statistics related to the measurement. You can add these to a measurement
badge by selecting the Show Statistics in Badge control.

Show Statistics in Badge

(Measurement name panel)

Adds the listed statistical measurement readouts to the measurement badge readout.

Plots (Measurement name
panel)

Opens Plot views of the measurement. Available plots depend on the measurement. Plot types include
Bathtub, TIE Spectrum, Time trend plot, TIE Histogram, Eye Diagram plot.

To add a plot to the screen, tap the Plot button.

See Add Plot configuration menu on page 342.

Configure panel

Sets the source, label text, and other fields that are specific to each measurement type.

See Configure panel (Jitter measurement configuration menu) on page 230.

Table continued...
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Field, control, or panel

Description

Reference Levels panel

Sets the reference levels and units used to take measurements, the scope of the reference level
settings (global or local), and the method used to calculate the Top and Base waveform values.

See Reference Levels panel (Measurement configuration menu) on page 216.

Clock Recovery panel

Sets the clock recovery settings for some jitter measurements.

See Clock Recovery panel (Measurement configuration menu) on page 217.

Gating panel

Sets the measurement region (gate) used to take measurements. Select the scope of the gate setting
(global or local), and the type of gating to use.

See Gating panel (Measurement configuration menu) on page 221.

Filter/Limit Results panel

Sets the scope of the filtering setting (global or local), high and low pass filter settings, the range of
measurement result limits, and the limit measurement population size.

See Filter/Limit Results panel (Measurement Settings menu) on page 223.

Pass/Fail Testing panel

Sets the conditions for pass/fail testing for measurements and sets actions to take when a
measurement fails.

See Pass/Fail Testing panel (Measurement Settings menu) on page 224.

Jitter Measurement Name panel (Measurement configuration menu)

The Jitter Measurement Name panel (the name of the measurement) provides controls for adding display statistics to the measurement
badge and opening plots of the measurement.

To open the jitter measurement name panel, double-tap a Jitter Measurement badge. This is the default panel shown when you open a

Jitter Measurement settings menu.

The contents of the Measurement Name panel depends on the measurement.

Field or control

Description

Measurement Statistics

Shows a list of measurement statistics. You can add these statistics to a measurement badge by
selecting the Show Statistics in Badge control.

Show Statistics in Badge

Adds the listed statistical measurement readouts to the measurement badge.

Plots

Adds a Plot view of the measurement value to the screen. Available plots depend on the
measurement. Plot types include Bathtub, TIE Spectrum trend plot, TIE Histogram, Eye Diagram
plot. Trend adds the trend plot to the Waveform view.

See also

Configure panel (Jitter measurement configuration menu) on page 230

Reference Levels panel (Measurement configuration menu) on page 216

Clock Recovery panel (Measurement configuration menu) on page 217

Gating panel (Measurement configuration menu) on page 221

Filter/Limit Results panel (Measurement Settings menu) on page 223

Pass/Fail Testing panel (Measurement Settings menu) on page 224
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Configure panel (Jitter measurement configuration menu)

Use the configure panel to add a custom name (label) for the measurement and other parameters.

To open the Configure panel for a Jitter measurement:

1. Double-tap a Jitter measurement badge to open the Jitter measurement configuration menu.

2. Tap the Configure panel.

Jitter Measurements panel

Jitter Summary and TU@BER measurements: Configuration panel

Field or control

Description

Source 1 Select the input signal channel from the Source 1 fields.

Label Sets the name of the measurement. You can use the default name, or double-tap in the field and
change the label using a connected keyboard or the virtual keyboard.

Signal Type Set the signal type as Clock, Data, or Auto.

Clock Edge Set the edge of the clock signal. Available clock edges are rising, falling, and both.

Available when Signal Type is Clock or Auto.

Pattern Detection

Set the pattern detection method as Auto or Manual.

Auto method causes the data pattern to be detected automatically on the first acquisition following
a configuration change. Based on this detection, the Pattern Type and associated controls are then
configured optimally for the given record length.

Manual method allows (and requires) that the Pattern Type and associated controls be set manually.

Pattern Type

Set the pattern type as Repeating or Arbitrary. If the data signal is repeating pattern of N bits, then
Repeating pattern type should be selected.

If the data signal is non-repeating pattern or unknown then Arbitrary pattern type should be selected.

Available when Pattern Detection is Auto.

Pattern Length

Enter the pattern length. Default length is 2 Ul. When Pattern Detection is Auto, this field shows

the detected pattern length. When Pattern Detection is Manual, this control must be set to match

the actual pattern length. If the manually-set pattern length is inconsistent with the detected pattern
length, process stops but a warning will be logged. Double-tap in the field to change the value using a
connected keyboard or the virtual keyboard.

Available when Pattern Type is Repeating.

Window Length

Enter the window length. Default length is 10 Ul. Determines the number of unit intervals over which
pattern correlation effects are analyzed. The window should be set to a large enough value that the
impulse response of the serial data transmitter and channel have settled. Double-tap in the field to
change the value using a connected keyboard or the virtual keyboard.

Available when Pattern Type is Arbitrary.

Target BER

Sets the Bit Error Rate exponent, thereby setting the statistical level at which total jitter and eye
opening are reported. Default value is 12. The minimum value is 2 and maximum value is 18.
Double-tap in the field to change the value using a connected keyboard or the virtual keyboard.
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TIE measurement: Configuration panel

Field or control

Description

Source 1 Select the input signal channel from the Source 1 fields.

Label Sets the name of the measurement. You can use the default name, or double-tap in the field and
change the label using a connected keyboard or the virtual keyboard.

Signal Type Set the signal type as Clock, Data, or Auto.

Clock Edge Set the edge of the clock signal. Available clock edges are rising, falling, and both.

Available when Signal Type is Clock or Auto.

Phase Noise measurement: Configure panel

Field or control

Description

Source 1 Select the input signal channel from the Source 1 fields.
Source 2 Select the input signal channel from the Source 2 fields.
Label Sets the name of the measurement. You can use the default name, or double-tap in the field and

change the label using a connected keyboard or the virtual keyboard.

Upper Noise Integration Limit

Sets the upper noise intergration limit.

Lower Noise Integration Limit

Sets the lower noise intergration limit.

Smoothing Filter

Toggles the smoothing filter On or Off to smoothen the phase noise plot. The default is On.

RJ 65, DJ 69, PJ, RJ, DJ, SRJ, J2, J9, NPJ, F/2, F/4, and F/8 measurements: Configuration panel

Field or control

Description

Source 1 Select the input signal channel from the Source 1 fields.

Label Sets the name of the measurement. You can use the default name, or double-tap in the field and
change the label using a connected keyboard or the virtual keyboard.

Signal Type Set the signal type as Clock, Data, or Auto.

Clock Edge Set the edge of the clock signal. Available clock edges are rising, falling, and both.

Available when Signal Type is Clock or Auto.

Pattern Detection

Set the pattern detection method as Auto or Manual.

Auto method causes the data pattern to be detected automatically on the first acquisition following
a configuration change. Based on this detection, the Pattern Type and associated controls are then
configured optimally for the given record length.

Manual method allows (and requires) that the Pattern Type and associated controls be set manually.

Pattern Type

Set the pattern type as Repeating or Arbitrary. If the data signal is repeating pattern of N bits, then
Repeating pattern type should be selected.

If the data signal is non-repeating pattern or unknown then Arbitrary pattern type should be selected.

Available when Pattern Detection is Auto.

Table continued...
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Field or control

Description

Pattern Length

Enter the pattern length. Default length is 2 Ul. When Pattern Detection is Auto, this field shows

the detected pattern length. When Pattern Detection is Manual, this control must be set to match

the actual pattern length. If the manually-set pattern length is inconsistent with the detected pattern
length, process stops but a warning will be logged. Double-tap in the field to change the value using a
connected keyboard or the virtual keyboard.

Available when Pattern Type is Repeating.

Window Length

Enter the window length. Default length is 10 Ul. Determines the number of unit intervals over which
pattern correlation effects are analyzed. The window should be set to a large enough value that the
impulse response of the serial data transmitter and channel have settled. Double-tap in the field to
change the value using a connected keyboard or the virtual keyboard.

Available when Pattern Type is Arbitrary.

DDJ measurement: Configuration panel

Field or control

Description

Source 1

Select the input signal channel from the Source 1 fields.

Label

Sets the name of the measurement. You can use the default name, or double-tap in the field and
change the label using a connected keyboard or the virtual keyboard.

Pattern Detection

Set the pattern detection method as Auto or Manual.

Auto method causes the data pattern to be detected automatically on the first acquisition following
a configuration change. Based on this detection, the Pattern Type and associated controls are then
configured optimally for the given record length.

Manual method allows (and requires) that the Pattern Type and associated controls be set manually.

Pattern Type

Set the pattern type as Repeating or Arbitrary. If the data signal is repeating pattern of N bits, then
Repeating pattern type should be selected.

If the data signal is non-repeating pattern or unknown then Arbitrary pattern type should be selected.

Available when Pattern Detection is Auto.

Pattern Length

Enter the pattern length. Default length is 2 Ul. When Pattern Detection is Auto, this field shows

the detected pattern length. When Pattern Detection is Manual, this control must be set to match

the actual pattern length. If the manually-set pattern length is inconsistent with the detected pattern
length, process stops but a warning will be logged. Double-tap in the field to change the value using a
connected keyboard or the virtual keyboard.

Available when Pattern Type is Repeating.

Window Length

Enter the window length. Default length is 10 Ul. Determines the number of unit intervals over which
pattern correlation effects are analyzed. The window should be set to a large enough value that the
impulse response of the serial data transmitter and channel have settled. Double-tap in the field to
change the value using a connected keyboard or the virtual keyboard.

Available when Pattern Type is Arbitrary.
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DCD measurement: Configuration panel

Field or control

Description

Source 1 Select the input signal channel from the Source 1 fields.

Label Sets the name of the measurement. You can use the default name, or double-tap in the field and
change the label using a connected keyboard or the virtual keyboard.

Signal Type Set the signal type as Clock, Data, or Auto.

Pattern Detection

Set the pattern detection method as Auto or Manual.

Auto method causes the data pattern to be detected automatically on the first acquisition following
a configuration change. Based on this detection, the Pattern Type and associated controls are then
configured optimally for the given record length.

Manual method allows (and requires) that the Pattern Type and associated controls be set manually.

Pattern Type

Set the pattern type as Repeating or Arbitrary. If the data signal is repeating pattern of N bits, then
Repeating pattern type should be selected.

If the data signal is non-repeating pattern or unknown then Arbitrary pattern type should be selected.

Available when Pattern Detection is Auto.

Pattern Length

Enter the pattern length. Default length is 2 Ul. When Pattern Detection is Auto, this field shows

the detected pattern length. When Pattern Detection is Manual, this control must be set to match

the actual pattern length. If the manually-set pattern length is inconsistent with the detected pattern
length, process stops but a warning will be logged. Double-tap in the field to change the value using a
connected keyboard or the virtual keyboard.

Available when Pattern Type is Repeating.

Window Length

Enter the window length. Default length is 10 Ul. Determines the number of unit intervals over which
pattern correlation effects are analyzed. The window should be set to a large enough value that the
impulse response of the serial data transmitter and channel have settled. Double-tap in the field to
change the value using a connected keyboard or the virtual keyboard.

Available when Pattern Type is Arbitrary.

CC-Jitter measurement: Configuration panel

Field or control

Description

Source 1 Select the input signal channel from the Source 1 fields.

Label Sets the name of the measurement. You can use the default name, or double-tap in the field and
change the label using a connected keyboard or the virtual keyboard.

Edge Set the edge of the signal as First, Rising, or Falling.

N= Specifies number of cycles or unit interval in each N-period group. Double-tap in the field to change the

value using a connected keyboard or the virtual keyboard.

Eye Measurements panel
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Eye Height measurement: Configuration panel

Field or control

Description

Source 1 Select the input signal channel from the Source 1 fields.

Source 2 Select the input signal channel from the Source 2 fields.

Label Sets the name of the measurement. You can use the default name, or double-tap in the field and
change the label using a connected keyboard or the virtual keyboard.

Bit Type Sets the waveform bit types as Trans, Non-Trans, or All.
Trans bit type does eye analysis only on transition bits. A transition bit is a bit that is changing from low
to high or high to low.
Non-trans bit type does eye analysis only on non-transition bits. A non-transition bit is a bit that is not
changing state.
All bit type does eye analysis using both transition and non-transition bits.

Analysis Method Set the analysis method as Parametric or Histogram (Non-parametric) for the measurement.

Set Levels In Sets the levels as % or Absolute. It defines the exact time in percentage terms or absolute values.

Measure at % of the Unit
Interval

Set the horizontal position where the measurement is taken as a percentage of the unit interval.
Double-tap in the field to change the value using a connected keyboard or the virtual keyboard.

Available when Set Levels In is %.

Measure at 'X' seconds

Sets the horizontal position where the measurement is taken in terms of seconds.

Available when Set Levels In is Absolute.

Width

Sets the window around the set level to search for the maximum eye width.

Available when Analysis Method is Histogram.

Eye Interpolation

Select the interpolation for eye rendering.

When checked, Eye Interpolation performs the interpolation between samples and gives a finer
rendering appearance.

When unchecked, it renders all samples of the valid Uls (Unit Intervals) without performing any
interpolation.

Available when Analysis Method is Histogram.

Eye Rendering

Set the eye rendering as Fast or Complete.

Fast considers only a subset of the record length for the analysis, which defines the boundaries of the
eye.

Complete considers entire record length for the analysis.

Available when Analysis Method is Histogram and Eye Interpolation box is checked.

Uls

Sets the number of unit intevals considered for the analysis.

Available when Analysis Method is Histogram, Eye Interpolation box is checked, and Eye
Rendering is Fast.
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Eye Width measurement: Configuration panel

Field or control

Description

Source 1 Select the input signal channel from the Source 1 fields.

Source 2 Select the input signal channel from the Source 2 fields.

Label Sets the name of the measurement. You can use the default name, or double-tap in the field and
change the label using a connected keyboard or the virtual keyboard.

Analysis Method Set the analysis method as Parametric or Histogram (Non-parametric) for the measurement.

Set Levels In Sets the levels as % or Absolute. It defines the exact time/voltage point in percentage terms or

absolute values.

Available when Analysis Method is Histogram.

Measure at % of the Unit
Amplitude

Sets the horizontal position where the measurement is taken, as a percentage of the unit amplitude.

Available when Analysis Method is Histogram and Set Levels In is %.

Measure at 'X' voltage

Sets the vertical position where the measurement is taken in terms of volts.

Available when Analysis Method is Histogram and Set Levels In is Absolute.

Width

Sets the window around the set level to search for the maximum eye width.

Available when Analysis Method is Histogram.

Eye Interpolation

Select the interpolation for eye rendering.

When checked, Eye Interpolation performs the interpolation between samples and gives a finer
rendering appearance.

When unchecked, it renders all samples of the valid Uls (Unit Intervals) without performing any
interpolation.

Available when Analysis Method is Histogram.

Eye Rendering

Set the eye rendering as Fast or Complete.

Fast considers only a subset of the record length for the analysis, which defines the boundaries of the

eye.
Complete considers entire record length for the analysis.

Available when Analysis Method is Histogram and Eye Interpolation box is checked.

Uls

Sets the number of unit intevals considered for the analysis.

Available when Analysis Method is Histogram, Eye Interpolation box is checked, and Eye
Rendering is Fast.

Height@BER measurement: Configuration panel

Field or control

Description

Source 1

Select the input signal channel from the Source 1 fields.

Label

Sets the name of the measurement. You can use the default name, or double-tap in the field and
change the label using a connected keyboard or the virtual keyboard.

Table continued...
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Field or control

Description

Bit Type

Sets the waveform bit types as Trans, Non-Trans, or All.

Trans bit type does eye analysis only on transition bits. A transition bit is a bit that is changing from low
to high or high to low.

Non-trans bit type does eye analysis only on non-transition bits. A non-transition bit is a bit that is not
changing state.

All bit type does eye analysis using both transition and non-transition bits.

Measurement Range Start,
Finish

Sets the measurement range. The default value is 50%. Double-tap in the field to change the value
using a connected keyboard or the virtual keyboard.

Number of Bins

Set the number of bins. Defines the resolution by the number of bins into which Span is divided: 25,
50, 100, 250, 500, 2000, or Maximum. Double-tap in the field to change the value using a connected
keyboard or the virtual keyboard.

Target BER

Sets the Bit Error Rate exponent, thereby setting the statistical level at which total jitter and eye
opening are reported. Default value is 12. The minimum value is 2 and maximum value is 18.
Double-tap in the field to change the value using a connected keyboard or the virtual keyboard.

Width@BER measurement: Configuration panel

Field or control

Description

Source 1 Select the input signal channel from the Source 1 fields.

Label Sets the name of the measurement. You can use the default name, or double-tap in the field and
change the label using a connected keyboard or the virtual keyboard.

Signal Type Set the signal type as Clock, Data, or Auto.

Clock Edge Set the edge of the clock signal. Available clock edges are rising, falling, and both.

Available when Signal Type is Clock or Auto.

Pattern Detection

Set the pattern detection method as Auto or Manual.

Auto method causes the data pattern to be detected automatically on the first acquisition following
a configuration change. Based on this detection, the Pattern Type and associated controls are then
configured optimally for the given record length.

Manual method allows (and requires) that the Pattern Type and associated controls be set manually.

Pattern Type Set the pattern type as Repeating or Arbitrary. If the data signal is repeating pattern of N bits, then
Repeating pattern type should be selected.
If the data signal is non-repeating pattern or unknown then Arbitrary pattern type should be selected.
Available when Pattern Detection is Auto.

Pattern Length Enter the pattern length. Default length is 2 Ul. When Pattern Detection is Auto, this field shows

the detected pattern length. When Pattern Detection is Manual, this control must be set to match

the actual pattern length. If the manually-set pattern length is inconsistent with the detected pattern
length, process stops but a warning will be logged. Double-tap in the field to change the value using a
connected keyboard or the virtual keyboard.

Available when Pattern Type is Repeating.

Table continued...
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Field or control

Description

Window Length

Enter the window length. Default length is 10 Ul. Determines the number of unit intervals over which
pattern correlation effects are analyzed. The window should be set to a large enough value that the
impulse response of the serial data transmitter and channel have settled. Double-tap in the field to
change the value using a connected keyboard or the virtual keyboard.

Available when Pattern Type is Arbitrary.

Target BER

Sets the Bit Error Rate exponent, thereby setting the statistical level at which total jitter and eye
opening are reported. Default value is 12. The minimum value is 2 and maximum value is 18.
Double-tap in the field to change the value using a connected keyboard or the virtual keyboard.

Eye High, Eye Low, and Q-Factor measurements: Configuration panel

Field or control Description

Source 1 Select the input signal channel from the Source 1 fields.

Label Sets the name of the measurement. You can use the default name, or double-tap in the field and
change the label using a connected keyboard or the virtual keyboard.

Bit Type Sets the waveform bit types as Trans, Non-Trans, or All.

Trans bit type does eye analysis only on transition bits. A transition bit is a bit that is changing from low
to high or high to low.

Non-trans bit type does eye analysis only on non-transition bits. A non-transition bit is a bit that is not
changing state.

All bit type does eye analysis using both transition and non-transition bits.

Measure at % of the Unit
Interval

The default value is 50%.

Amplitude Measurements panel

Bit Low, Bit High, and Bit Amplitude measurements: Configuration panel

Field or control

Description

Source 1 Select the input signal channel from the Source 1 fields.

Label Sets the name of the measurement. You can use the default name, or double-tap in the field and
change the label using a connected keyboard or the virtual keyboard.

Bit Type Sets the waveform bit types as Trans, Non-Trans, or All.

Trans bit type does analysis only on transition bits. A transition bit is a bit that is changing from low to
high or high to low.

Non-trans bit type does analysis only on non-transition bits. A non-transition bit is a bit that is not
changing state.

All bit type does analysis using both transition and non-transition bits.

Measure the Center % of Bit

Set the center % of bit. The default value is 1%.

Method

Set the method as Mean or Mode.

4/5/6 Series MSO MSO4X, MSO4XB, MSO5X, MSO5XB, MSO64, MSO6XB, MSO58LP, and LPD64 Help 237



Menus and dialog boxes

DC Common Mode measurements: Configuration panel

Field or control

Description

Source 1 Select the input signal channel from the Source 1 fields.
Source 2 Select the input signal channel from the Source 2 fields.
Label Sets the name of the measurement. You can use the default name, or double-tap in the field and

change the label using a connected keyboard or the virtual keyboard.

AC Common Mode (PK-PK) measurements: Configuration panel

Field or control Description

Source 1 Select the input signal channel from the Source 1 fields.

Source 2 Select the input signal channel from the Source 2 fields.
Source 2 field enables when Measurement Type is Double.

Label Sets the name of the measurement. You can use the default name, or double-tap in the field and
change the label using a connected keyboard or the virtual keyboard.

Measurement Type Set the measurement type as Single or Double.

>30 kHz High Pass Filter

Enables or disables the high pass filter.

Differential Crossover measurements: Configuration panel

Field or control

Description

Source 1 Select the input signal channel from the Source 1 fields.

Source 2 Select the input signal channel from the Source 2 fields.

Label Sets the name of the measurement. You can use the default name, or double-tap in the field and
change the label using a connected keyboard or the virtual keyboard.

Main Edge Set the edge type.

T/nT measurements: Configuration panel

Field or control

Description

Source 1

Select the input signal channel from the Source 1 fields.

Label

Sets the name of the measurement. You can use the default name, or double-tap in the field and
change the label using a connected keyboard or the virtual keyboard.

Time measurement panel

SSC Freq Dev measurement:

Configure panel

Field or control

Description

Source 1

Select the input signal channel from the Source 1 fields.

Label

Sets the name of the measurement. You can use the default name, or double-tap in the field and
change the label using a connected keyboard or the virtual keyboard.

Table continued...
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Field or control Description
Bitrate Detection Set the bitrate to Auto or Manual. Default is Auto.

Auto bitrate detection enables the automatic detection of the data rate on the first acquisition following
a configuration change.

In Manual configuration, allows you to specify the approximate data rate in bits per second (b/s).

Detected Bitrate Auto bitrate is 2.5 Gb/s. The readout displayed when Bitrate Detection is Auto.

Enter the bitrate value manually using keyboard or double-tap and enter the value using virtual keypad.
Available when Bitrate Detection is Manual.

SSC Modultion Rate measurement: Configure panel

Field or control Description

Source 1 Select the input signal channel from the Source 1 fields.

Label Sets the name of the measurement. You can use the default name, or double-tap in the field and
change the label using a connected keyboard or the virtual keyboard.

Reference Levels panel (Jitter measurement configuration menu)

Use the Reference Levels panel to set the scope of the reference level settings (global or local), the measurement reference levels (High,
Mid, and Low), the units used to take measurements, and the method used to calculate the Top and Base waveform values. Hysteresis
settings are critical for PWM edge extraction.

See Reference Levels panel (Measurement configuration menu) on page 216 for the Reference panel fields and controls.

Other measurement settings panels

Jitter measurement configuration menu overview on page 228

Jitter Measurement Name panel (Measurement configuration menu) on page 229
Configure panel (Jitter measurement configuration menu) on page 230

Clock Recovery panel (Jitter measurement configuration menu) on page 239
Filter/Limit Results panel (Jitter measurement configuration menu) on page 240
Gating panel (Jitter measurement configuration menu) on page 240

Pass/Fail Testing panel (Jitter measurement configuration menu) on page 240

Clock Recovery panel (Jitter measurement configuration menu)

Clock recovery refers to the process of establishing a reference clock, the edges of which can be used as a basis for timing comparisons.
Use the Clock Recovery panel to configure the clock recovery settings for measurements that require a clock signal.

See Clock Recovery panel (Measurement configuration menu) on page 217 for the Clock Recovery panel fields and controls.

Other measurement settings panels
Jitter measurement configuration menu overview on page 228

Jitter Measurement Name panel (Measurement configuration menu) on page 229
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Configure panel (Jitter measurement configuration menu) on page 230
Reference Levels panel (Jitter measurement configuration menu) on page 239
Gating panel (Jitter measurement configuration menu) on page 240

Filter/Limit Results panel (Jitter measurement configuration menu) on page 240

Pass/Fail Testing panel (Jitter measurement configuration menu) on page 240

Gating panel (Jitter measurement configuration menu)
Use Gating to confine a measurement to a certain part of a waveform.

See Gating panel (Measurement configuration menu) on page 221 for the Gating panel fields and controls.

Other measurement settings panels

Jitter measurement configuration menu overview on page 228

Jitter Measurement Name panel (Measurement configuration menu) on page 229
Configure panel (Jitter measurement configuration menu) on page 230
Reference Levels panel (Jitter measurement configuration menu) on page 239
Clock Recovery panel (Jitter measurement configuration menu) on page 239
Filter/Limit Results panel (Jitter measurement configuration menu) on page 240

Pass/Fail Testing panel (Jitter measurement configuration menu) on page 240

Filter/Limit Results panel (Jitter measurement configuration menu)

Use these settings to apply a High Pass and/or Low Pass filter to block specified frequency band components when taking measurements.
Use the limit controls to set range of measurement values to measure, and the number of measurements to take (population).

See Filter/Limit Results panel (Measurement Settings menu) on page 223 for the Filter/Limit Results panel fields and controls.

Other measurement settings panels

Jitter measurement configuration menu overview on page 228

Jitter Measurement Name panel (Measurement configuration menu) on page 229
Configure panel (Jitter measurement configuration menu) on page 230
Reference Levels panel (Jitter measurement configuration menu) on page 239
Clock Recovery panel (Jitter measurement configuration menu) on page 239
Gating panel (Jitter measurement configuration menu) on page 240

Pass/Fail Testing panel (Jitter measurement configuration menu) on page 240

Pass/Fail Testing panel (Jitter measurement configuration menu)
Use these settings to test measurement values against a specified limit and set actions for the instrument to take on failure.

See Pass/Fail Testing panel (Measurement Settings menu) on page 224 for the Pass/Fail Testing panel fields and controls.
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Other measurement settings panels

Jitter measurement configuration menu overview on page 228

Jitter Measurement Name panel (Measurement configuration menu) on page 229

Configure panel (Jitter measurement configuration menu) on page 230

Clock Recovery panel (Jitter measurement configuration menu) on page 239

Filter/Limit Results panel (Jitter measurement configuration menu) on page 240

Gating panel (Jitter measurement configuration menu) on page 240

Pass/Fail Testing panel (Jitter measurement configuration menu) on page 240

Power measurement configuration menu overview

Use this configuration menu to add statistics to a Power measurement badge readout, plot a measurement, and change measurement
settings including source, scope (global or local), reference levels, and gating.

To open the Power measurement configuration menu for a measurement, double-tap a Power measurement badge in the Results bar. The
configuration menu and panels only show fields and controls relevant to the selected measurement.

The menu opens on the measurement name panel (the name of the measurement), which provides controls to display additional statistics
to the measurement badge, display plots of the measurement, and so on. The measurement name panel only shows fields and controls
relevant to the selected measurement. The most common Power measurement Name fields are listed in the following table.

Power Measurement configuration menu fields, controls, and panels

Field, control, or panel

Description

Measurement Statistics

(Measurement name panel)

A list of measurement statistics related to the measurement. You can add these to a measurement
badge by selecting the Show Statistics in Badge control.

Show Statistics in Badge

(Measurement name panel)

Adds the listed statistical measurement readouts to the measurement badge readout.

Plots (Measurement name
panel)

Buttons that open Plot views of the measurement. Available plots depend on the measurement. Plot
types include Time Trend, Histogram, Harmonic bar graph, SOA, Switching Loss Trajectory, B-H curve,
I vs. [V, Inductance, Power Supply Rejection Ratio, Control Loop Response, and Instantaneous Math.

To add a plot to the screen, tap the plot button.

See Add Plot configuration menu on page 342.

Configure panel

Sets the source, label text, and other fields that are specific to each measurement type.

See Configure panel (Power measurement configuration menu) on page 242.

Reference Levels panel

Sets the reference levels and units used to take measurements, the scope of the reference level
settings (global or local), and the method used to calculate the Top and Base waveform values.

See Reference Levels panel (Measurement configuration menu) on page 216.

Gating panel

Sets the measurement region (gate) used to take measurements. Select the scope of the gate setting
(global or local), and the type of gating to use.

See Gating panel (Measurement configuration menu) on page 221.
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Power Measurement Name panel (Measurement configuration menu)

The Power Measurement Name panel (the name of the measurement) provides controls for adding display statistics to the measurement
badge and opening plots of the measurement.

To open the power measurement name panel, double-tap a Power Measurement badge. This is the default panel shown when you open a
Power Measurement settings menu.

The contents of the Measurement Name panel depends on the measurement.

Note: The Power Measurement Name panel and the Configure panel are merged together for Input Capacitance, Inrush Current,
Turn On Time, Turn Off Time, Control Loop Response, Power Supply Rejection Ratio (PSRR), and Impedance measurements.

Field or control Description

Power Autoset Sets the oscilloscope acqui